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4 Scene and model basics
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Creating a picture model
Creating a text model
Generating a snapshot
Generating an animation
Importing a model
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Previewing an animation
Printing a frame of an animation
Printing a scene or snapshot
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Selecting models
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Adding a texture to a model's surface
Adding shadows to a scene

Applying a digital video file as a surface
Changing a snapshot's color depth or size
Generating a 32-bit snapshot

Generating complex or large snapshot
Making a color surface appear transparent
Making a model a sub-part of another model
Making a solid material surface transparent
Making a surface reflect a bitmap

Making a surface reflective

Making all models in a scene reflect a bitmap
Modifying a backdrop

Modifying a light

Modifying a model's surface

Modifying a simple model's shape

Modifying an imported model
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Warping a model
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Staggering when models enter a scene
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Embedding a new scene
Embedding or linking an existing scene
Playing a linked or embedded animation
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Examples

The bitmaps and .AVI files described below were created in Asymetrix 3D F/X. For details about how an example
was created, click its image.

Eight ball snapshot This snapshot was created using a sphere
model with a bitmap surface and reflection map applied, then
generated using a realistic generating style.

Patterned ring snapshot This snapshot was created using a ring
model with a tiled bitmap surface and a plane model with a
reflective surface, then generated using a ray traced generating
style.

Switching text animation This animation was created using two
text models. We applied animation paths to the text models to
make them appear to replace each other onscreen, then
generated the animation using a realistic generating style.

Water molecule animation This animation was created using
text, sphere, and cylinder models. We positioned the models,
then made them all sub-parts of one of the spheres. We applied
an animation path to the parent sphere, then generated the
animation using a realistic generating style.

Helicopter with moving background animation This animation
was created using an imported model from the Catalog, and a

plane model as a background. We applied animation paths to the
plane, the helicopter's rotors, and the entire helicopter, then
generated the animation using a realistic generating style.

Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts
Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

b File menu

B Edit menu

k View menu

k Tools menu

E Models menu
4 Scene menu

b Window menu

b Help menu




Reference Information
Click a topic or menu name below for more information.
Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

‘ File menu

Edit menu

View menu

Tools menu

Models menu

Scene menu

Window menu
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Help menu




Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

File menu

Edit menu
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Duplicate
lect All

Reset Position
Reset Orientation
Reset Size

View menu

Tools menu

Models menu

Scene menu

Window menu
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Reference Information
Click a topic or menu name below for more information.
Screen map and shortcuts
Map of screen elements
Keyboard and mouse shortcuts
Menu command reference
To view an alphabetic list of commands, see Alphabeti mmand reference.

‘ File menu
‘ Edit menu
‘ View menu

Boxes

Wireframes

Solid Models

Backdrop

On Camera Area
Scene Contents
Catalog

Position Palette
Animation Palette
Toolbar

Status Bar

Main Status Bar

Tools menu

_____ Models menu

Scene menu

Window menu

SEBBS

Help menu




Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

File menu

Edit menu

View menu

Tools menu

Convert Snapshot
Arrange Catalog Entries

Bitmap Editor
Palette Editor

Wave File Editor
Photo CD Converter.
Options
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Models menu

Scene menu

Window menu

Help menu




Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

File menu

Edit menu

View menu

Tools menu

Models menu
Create Text Model
Create Picture Model
Create Simple Model
Import Model
Modify 3D
Modify Model
Modify Surface & Color
Modify Animation
Modify Warp

Scene menu

Window menu

Help menu




Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

File menu

Edit menu

View menu

Tools menu

Models menu

Scene menu
Snapshot & Animation Settings
Camera Perspective

Modify Backdrop

Modify Lights

Modify Soundtrack

Preview Snapshot

Preview Animation

Preview All Frames

Generate Snapshot
Generate Animation

Window menu

Help menu




Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

File menu

Edit menu

View menu

Tools menu

Models menu

Scene menu

Window menu

Cascade

Tile Horizontally

Tile Vertically

Arrange Main Windows

Arrange Icons
1 <Window Name>

Help menu




Reference Information

Click a topic or menu name below for more information.

Screen map and shortcuts

Map of screen elements
Keyboard and mouse shortcuts

Menu command reference
To view an alphabetic list of commands, see Alphabetic command reference.

File menu

Edit menu

View menu

Tools menu

Models menu

Scene menu

Window menu

Help menu

Contents

Search For Help On
Startup Assistant
Examples

Technical Support
System Info

About Asymetrix 3D F/X



Alphabetic command reference

Click a letter to display commands.
To view commands by menu name, see Menu command reference.
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About Asymetrix 3D F/X

Animated Surface (dialog box)
Animation Palette

Arrange Catalog Entries

Arrange Icons

Arrange Main Windows

Asymetrix 3D F/X Startup (dialog box

B

Backdrop Gradient (dialog box)
Backdrop



Bitmap Editor
Boxes

C

Camera Perspective
Cascade

Choose File To Print (dialog box)

Color Wheel (dialog box)
Convert Snapshot

Copy

Create Ambient Light
Create Directional Light
Create Picture Model
Create Simple Model
Create Text Model

Cut

D-F
Duplicate
Examples
Exit

Exit & Return

G-H
Generate Animation
Generate Snapshot

l-L
Import Graphic (dialog box)

Import Model
Imported Model Surface (dialog box)

Main Status Bar

Modify 3D

Modify Animation

Modify Backdrop

Modify Cube (dialog box)

Modify Cylinder (dialog box)
Modify Imported Model (dialog box)
Modify Letter Model (dialog box)
Modify Lights

Modify Name (dialog box)

Modify Picture Model (dialog box)
Modify Ring (dialog box)

Modify Soundtrack

Modify Sphere (dialog box)
Modify Sub-part

Modify Surface & Color

Modify Text Model (dialog box)
Modify Warp
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New Catalog
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On Camera Area

Open
Options

P

Palette Editor

Paste

Photo CD Converter
Picture Options (dialog box)
Position Palette

Preview All Frames
Preview Animation

Preview Snapshot

Print

Print Setup (dialog box)

Q-R
Reset Orientation

Reset Position
Reset Size

S

Save As

Save

Scene

Scene Contents
Scene Specialist

Search For Help On
Select All

Send

Snapshot & Animation Settings
Solid Models

Spelling (dialog box

Startup Assistant
Status Bar

T

Technical Support
Tile Horizontally
Tile Vertically
Toolbar

Trace Options (dialog box)
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Video Compression (dialog box)
W-2Z

Wave File Editor
Wireframes



Asymetrix 3D F/X Startup (dialog box)

Tools menu / Options / File tab

Use to create a new scene, open an existing scene, or open the Scene Specialist to create a new scene.

Option Description
New Scene Creates a new scene.
Open Scene Opens an existing scene.

Scene Specialist Runs the Scene Specialist, a short program to help you build a new scene.

CHED



Step by step

Building a scene

Command

Options

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



New

File menu

See also._.

Keyboard: Ctrl+N

Toolbar:

Creates a new scene.

If another scene is currently open, Asymetrix 3D F/X asks whether to save your changes, then closes it before
creating a new scene.

CHED



Step by step

Building a scene

Command

Options

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Open or Import

<&

You can use the Open, Import Graphic, Import Model, Choose File To Print, and Modify Soundtrack dialog boxes
in similar ways to select and access a particular type of file. For details, click a command or dialog box name
below.

Choose File To Print (dialog box)
Import Graphic (dialog box)
Import Model

Modify Soundtrack

Open

* * 4+



Step by step

About imported models

Adding a soundtrack to an animation
Creating a picture model

Importing a model

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Open

File menu or Browse button

Keyboard: Ctrl+O
d
Toolbar:

Use to open an existing scene, Catalog, snapshot, or animation.

If another scene is currently active, Asymetrix 3D F/X asks whether to save your changes, then closes the existing
scene before opening a new scene. If another Catalog, Snapshot, or Animation window is currently open,
Asymetrix 3D F/X leaves it open, and opens a second Catalog, Snapshot, or Animation window.

Option Description

File Name Lists all files in the current default directory with the default file extension for the selected file
format. A file selected from this list replaces the contents of the File Name box.

List Files Of Type Indicates the default file extension. The drop-down list includes all other available file types.

Directories Displays the default path. Change the directory by selecting a new path from the Directories
box, which lists all directories available on the current drive. To change the drive, make a
selection in the Drives box.

Drives Lists the available drives. Selecting a new drive changes the contents of the Directories box.

Network Available if your system is connected to a network and you are running Windows for
Workgroups. Opens the Network dialog box from which you can choose additional drives and
directories.




Commands

Import Graphic (dialog box)
Import Model

Modify Soundtrack

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Scene Specialist

File menu

Runs the Scene Specialist, a short program to help you build a new scene or edit an existing scene. Using the
Scene Specialist, you can create scenes that contain text, graphics, or both. You can run the Scene Specialist in
one of two ways:

*

Each time you enter Asymetrix 3D F/X, click Scene Specialist in the Asymetrix 3D F/X Startup dialog box.
From the File menu, choose Scene Specialist.
You can run the Scene Specialist to create a scene from which you can generate any of the following types of
snapshots or animations:

*

Snapshot of a graphic

Snapshot of text

Snapshot of graphic and text

Snapshot of black-and-white graphic

Animation of a spinning graphic

Animation of spinning text

Animation of text flying in and out of the scene

SEBEEEES

Animation of text and graphic rotating
You can also run the Scene Specialist to help you with scenes you've already created. If your scene contains a
graphic or text, the Scene Specialist will open an appropriate screen so that you can modify it.



Step by step

Building a scene

Creating and modifying a Catalog
Commands

New

Options



Close

File menu

"

Keyboard: Ctrl+W

Closes the active window (Snapshot, Animation, or Catalog). If an open snapshot or Catalog has not yet been
saved, Asymetrix 3D F/X asks whether to save the file before closing.



Command

Open

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Save

File menu

Keyboard: Ctrl+S

Toolbar:

Saves the active window (Scene Preview, Snapshot, Catalog or Animation window) under the current name. If an
open scene, snapshot, or Catalog has not been named and saved, Asymetrix 3D F/X opens the Save As dialog
box.

Tip Saving a file deselects any selected objects in a scene.



Command
Save As

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"
Chapter 3, "Creating snapshot and animation files"



Save As

File menu

Saves a new scene, snapshot, or Catalog under a specific file name. An existing scene, snapshot, or Catalog or

animation file can be saved under the current or a new file name.

Option

Description

File Name

Save File As Type

Directories

Drives
Network

Specifies the file name under which a scene, snapshot, Catalog, or animation file will be
saved. By default, Asymetrix 3D F/X adds the file extension .SCN to scene names, .BMP to
snapshot names, .CAT to Catalog names, and .AVI to animation files.

If the scene, snapshot, Catalog or animation file has been named and saved, the existing file
name appears in the File Name box. Change the file name by entering a new name in the
box.

Indicates .SCN, .BMP, .CAT or .AVI is the default file extension. The drop-down list includes
all other available file types.

Displays the default path. Change the directory by selecting a new path from the Directories
box, which lists all directories available on the current drive. To change the drive, make a
selection in the Drives box.

Lists the available drives. Selecting a new drive changes the contents of the Directories box.
Available if your system is connected to a network and you are running Windows for
Workgroups. Opens the Network dialog box from which you can choose additional drives and
directories.




Command
Save

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"
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New Catalog

File menu

"

Creates a new Catalog. If an existing Catalog is currently open, Asymetrix 3D F/X leaves it open, and creates a
new Catalog.



Step by step

Building a scene

Creating and modifying a Catalog
Commands

New

Options

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Print

File menu

Keyboard: Ctrl+P

Prints the contents of the active Snapshot, Animation, or Scene Preview window.

Option

Description

Printer
Print Contents Of Active Window
Print From File

Number Of Copies
Margins

Printer (button)

Displays the current printer or output device and the connected port.
Prints the active window.
Specifies a file to print.

File. Specifies a file to print. Enter the name of a file. Clicking Browse opens
the Choose File To Print dialog box, in which you can choose a file to print.

Specifies the number of copies to print.

Specifies margins used when printing. Disabled if printing from a file.

Print Actual Size. Prints the image at actual size.

Scale To Fit Printer Margins. Prints the image as large as the printer allows,
while maintaining the image's proportions.

Scale To Fit Custom Margins. Prints using margins you specify.

Opens the Print Setup dialog box.




Step by step

Printing a frame of an animation

Printing a scene or snapshot

Asymetrix 3D F/X User Manual

Chapter 3, "Creating snapshot and animation files"



Choose File To Print (dialog box)

File menu | Print / Browse

Use to select a scene or snapshot to print from a file.

Option

Description

File Name
List Files Of Type

Directories

Drives
Network

Lists all files in the current default directory with the default file extension for the selected file
format. A file selected from this list replaces the contents of the File Name box.
Indicates the default file extension. The drop-down list includes all other available file types.

Displays the default path. Change the directory by selecting a new path from the Directories
box, which lists all directories available on the current drive. To change the drive, make a
selection in the Drives box.

Lists the available drives. Selecting a new drive changes the contents of the Directories box.

Available if your system is connected to a network and you are running Windows for
Workgroups. Opens the Network dialog box from which you can choose additional drives and
directories.




Step by step

Printing a frame of an animation

Printing a scene or snapshot

Command

Print

Asymetrix 3D F/X User Manual

Chapter 3, "Creating snapshot and animation files"



Print Setup (dialog box)

File menu | Print / Printer

Displays the available printers and their assigned ports.

Option Description

Printer Determines the printer used.
Default Printer. Lists the default printer and its assigned port.
Specific Printer. Lists available printers and their assigned ports.

Orientation Sets paper orientation to portrait (taller than wide) or landscape (wider than tall).

Paper Specifies paper size and tray.

Options Opens the Options dialog box in which you can set additional printer options.

Network Available if your system is connected to a network and you are running Windows for
Workgroups. Opens the Network dialog box from which you can choose additional drives and
directories.

Tip If the printer you want is not displayed, or if the assigned port is incorrect, change the printer information
through the Windows Control Panel. For details, refer to the Microsoft Windows User's Guide.



Step by step

Printing a frame of an animation

Printing a scene or snapshot

Command

Print

Asymetrix 3D F/X User Manual

Chapter 3, "Creating snapshot and animation files"



Send

File menu

Sends the current file (if saved) using a MAPI (Messaging Application Programming Interface) compliant
application, such as Microsoft Mail. Asymetrix 3D F/X prompts you to save the file you want to send.



1 <Filename> (most recently used files)

File menu

"

Opens a recently used file. Asymetrix 3D F/X lists the four most recently used files.



Command
Open



Exit

File menu

Keyboard: Alt+F4

Ends the current session and exits Asymetrix 3D F/X. If you have not saved your work, Asymetrix 3D F/X asks
whether to save your changes. If more than one instance of Asymetrix 3D F/X is running, Exit closes only the
active instance.



Command

Close

Asymetrix 3D F/X User Manual
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Exit & Return

File menu

"

Ends the current session of Asymetrix 3D F/X and returns to the OLE container application. If you have not saved
your work, Asymetrix 3D F/X asks whether to save your changes.



Command
Exit

Asymetrix 3D F/X User Manual
Chapter 2, "Linking or embedding scenes"



Edit menu



Undo/Redo

Edit__rjr_lenu

Keyboard: Ctrl+Z or Alt+Backspace

Toolbar:

Undoes or redoes the effect of your last action in the current instance of Asymetrix 3D F/X, if that action can be
undone or redone.



Commands
Clear
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Cut

Edit__rjr_lenu

Keyboard: Ctrl+X or Shift+Del

Toolbar:

Removes the selection and places it on the Windows Clipboard, replacing the previous Clipboard contents. If
nothing is selected, the command is dimmed on the menu.






Copy

Edit__rjr_lenu

Keyboard: Ctrl+C or Ctrl+Insert

Ep
Toolbar:

Places a copy of the selection on the Windows Clipboard, replacing the previous Clipboard contents. If nothing is
selected, the command is dimmed on the menu.






Paste

Edit__rjr_lenu

Keyboard: Ctrl+V or Shift+ins

Toolbar:

Pastes the contents of the Windows Clipboard into the current scene. If the Clipboard is empty or its contents
cannot be pasted, the Paste command is dimmed on the menu.




Duplicate
Undo/Redo



Clear

Edit__rjr_lenu

Keyboard: Del

Removes the current selection without placing it on the Windows Clipboard. If nothing is selected, the command is
dimmed on the menu.

To reverse this action, choose Undo from the Edit menu before you do anything else.



Commands
Copy

Cut
Duplicate
Paste
Undo/Redo




Duplicate

Edit__rjr_lenu

"

Keyboard: Ctrl+D

Makes an exact duplicate of the selected model without using the Windows Clipboard.




Commands
Clear
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Select All

Edit__rjr_lenu

"

Keyboard: Ctrl+A

Selects all models in the current scene.

To cancel the selection, click anywhere away from the selection.



Step by step
Selecting models



Reset Position

Edit__r_\_1enu

"

Resets a model's position to the center of the scene.



Step by step

Arranging a model in a scene

Resetting a model's location, rotation, or scale
Commands

Reset Orientation

Reset Size

Asymetrix 3D F/X User Manual
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Reset Orientation

Edit__r_\_1enu

"

Resets a model to a flat orientation.



Step by step

Arranging a model in a scene

Resetting a model's location, rotation, or scale
Commands

Reset Position

Reset Size

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Reset Size

Edit__r_\_1enu

"

Resets a model's size to the size in which it was created.



Step by step

Arranging a model in a scene

Resetting a model's location, rotation, or scale
Commands

Reset Orientation

Reset Position

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



View menu



Boxes

View menu

Toolbar:

Displays models in the Scene Preview window as the shapes of the boxes that bound them. Asymetrix 3D F/X
works fastest in this mode because it does not have to recalculate as much information for each change you make
to models in the scene.




Step by step
About Asymetrix 3D F/X
Commands

Options
Solid Models
Wireframes



Wireframes
Vie\f\_l_menu
Toolbar: B

Displays models in the Scene Preview window as line drawings without color, surface, or shading information.
When moving, rotating, or sizing, this view displays just the bounding box, then redraws the model when it is
dropped. The Wireframes view draws changes to a scene more slowly than the Boxes view, but more quickly than
the Solid Models view.




Step by step

About Asymetrix 3D F/X
Commands

Boxes

Options
Solid Models



Solid Models

View menu

Toolbar:

Displays models in the Scene Preview window as 3D objects with rough surface and shading effects from lights.
The Solid Models view is the slowest of the views to draw changes to a scene.




Step by step

About Asymetrix 3D F/X
Commands

Boxes

Options
Wireframes



On Camera Area submenu

View menu / On Camera Area

"

Enlarges or reduces the working area of the Scene Preview window.



Step by step

About Asymetrix 3D F/X

About camera perspective
Setting the camera perspective
Asymetrix 3D F/X User Manual
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Backdrop

View menu

"

Keyboard: F4

Displays or hides the scene's backdrop in the Scene Preview window.




Step by step

About Asymetrix 3D F/X

Adding a backdrop

Modifying a backdrop
Commands

Backdrop Gradient (dialog box)
Modify Backdrop

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Scene Contents

View menu

Keyboard: F2

Toolbar:

Displays or hides the Scene Contents window, which lists all scene attributes such as backdrop, lights, and
soundtrack; and all models and their attributes such as surfaces, warps, and animation paths.




Step by step

About Asymetrix 3D F/X
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Catalog

View menu

Toolbar:

Displays or hides the Catalog, a window that contains preset scene elements such as models, surfaces, lights,
paths, scenes, and backdrops. You can drag scene elements from the Catalog and drop them into the Scene
Preview or Scene Contents window.




Step by step

About Asymetrix 3D F/X
Asymetrix 3D F/X User Manual
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Position Palette

View menu

Keyboard: F8

Toolbar:

Displays or hides the Position palette, which you can use to rotate, move or scale a model in the Scene Preview
window.

Button/Keyboard Description

Changes cursor to CQ. with which you can rotate a model. Press
Shift to rotate around depth (Z) axis. Press Ctrl to constrain

F9 rotation to a single axis.

If palette is expanded, displays graphical or numerical rotation
controls.

Changes cursor to % with which you can move a model left,
right, up, or down. Press Shift to move model forward and back in

F10 3D space.

If palette is expanded, displays graphical or numerical movement
controls.

oo .
Changes the cursor to = with which you can scale (resize) a
model. Press Shift to scale only width. Press Citrl, then drag the

F11 mouse up or down to scale only height. Press Ctrl, then drag the

mouse left or right to scale only depth.
If palette is expanded, displays graphical or numerical scaling

controls.
Expands the Position palette to display additional controls.
F12
% Toggles expanded Position palette from graphical to numerical
controls.




Graphical controls. Clicking an arrow rotates the

- m . model in the direction indicated.

Rotate:

Fosition Numerical controls. Sets precise values for a
- . . moq__e_l‘s rotation.
Rotate:
X-Axis: Modifies model's rotation
6 W Mwis [= around its X or horizontal axis (rotates model front

to back). A positive value rotates model away from
the camera; a negative value rotates model toward
the camera.

‘ Y-Axis: Modifies model's rotation

around its Y or vertical axis (rotates model side to
side). A positive value rotates model to the left; a
negative value rotates model to the right.

‘ Z-Axis: Modifies model's rotation

around its Z or depth axis (rotates model in a circle).
A positive value rotates model to the left; a negative
value rotates model to the right.

ror Y-S

e

@E—Axia:

e

sition Graphical controls. Clicking an arrow moves the

ﬂ . model in the direction indicated.
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ScalefResize:

g

Position

EERn

ScalefResize:

# Scale ¢ Wyidth

' Scale dk Height
£ Scale @ Depth

Numerical controls. Sets precise values for a
model's position.

‘ X-Axis: Modifies model's position

along its X or horizontal axis. A positive value
moves model to the left; a negative value moves
model to the right.

‘ Y-Axis: Modifies model's position

along its Y or vertical axis. A positive value moves
model down; a negative value moves model up.

‘ Z-Axis: Modifies model's position

along its Z or depth axis. A positive value moves
model back; a negative value moves model
forward.

Graphical controls. Clicking an arrow scales the
model in the direction indicated.

Numerical controls. Sets precise values for a
model's scale (percentage of its initial size) and
S|ze

X Scale: Modifies model's scale
along its X (horizontal) axis. A value over 100
increases the model's size; a value below 100
decreases the model's size.

Width: Modifies model's width.

Y Scale: Modifies model's scale
along its Y (vertical) axis. A value over 100
increases the model's size; a value below 100
decreases the model's size.

Height: Modifies model's height.

Z Scale: Modifies model's scale



Step by step
About Asymetrix 3D F/X
About the Position palette

along its Z (depth) axis. A value over 100 increases
the model's size; a value below 100 decreases the
model's size.

‘ Depth: Modifies model's depth.

Arranging a model in a scene
Resetting a model's location, rotation, or scale
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Animation Palette

View menu

Toolbar:

Displays or hides the Animation palette, which you can use to preview the animation defined by the animation
paths of all models in a scene.

Button Description

Previews the animation paths of all models in the scene at
actual speed, dropping frames if they can't be generated
quickly enough.

Previews the animation paths of all models in the scene, but
does not play frames at actual speed.

Stops or resumes playing a stopped animation from the current
frame.

Returns to first frame of all animation paths.

Backs up one frame.

Advances one frame.

Advances to last frame of all animation paths.

B =eeEeEe



Step by step

Animating a model

Generating an animation

Modifying a model's animation path
Previewing an animation

Printing a frame of an animation
Commands

Modify Animation

Preview Animation

Preview All Frames

Asymetrix 3D F/X User Manual
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Toolbar

View menu

"

Toggles the toolbar on or off the screen.



Screen map
Map of screen elements



Status Bar

View menu

"

Toggles the status bar on or off the active window.



Screen map
Map of screen elements



Main Status Bar

View menu

"

Toggles the status bar on or off the main Asymetrix 3D F/X window.



Screen map
Map of screen elements



Convert Snapshot (Colors tab)

Tools menu

Converts a generated snapshot to a different size or color palette.

Note Click a tab below to see its options.

[ Lolors I Size 1
Option Description
Original Image Lists number of colors available on current system and snapshot's color depth in bits per
pixel.
New Image Sets snapshot to use a new color palette and dithering options:

Colors. Sets snapshot's color depth and palette.

‘ Monochrome (1-bit): Dithers the image to a black-and-white palette.
16 Colors (4-bit): Dithers the image to the standard Windows palette.

256 Colors (8-bit): Dithers the image to the default Asymetrix 3D F/X palette.

Best 256 colors (8-bit): Counts how often each color occurs, then creates a palette of the
236 most common colors in the image and the 20 Windows colors and dithers the image to it.

‘ 65,536 Colors (16-bit): Recreates the image's colors precisely (does not impose a
palette).
‘ 16 million (24-bit): Recreates the image's colors precisely (does not impose a palette).
‘ 16 Grays (8-bit): Dithers the image to a palette of 16 grays.
ol ‘ 236 Grays (8-bit): Dithers the image to a palette of 236 grays. All grays will be recreated
precisely.

256 Grays (8-bit): Dithers the image to a palette of 256 grays. Some grays may not be
recreated precisely.

"

Compel Palette (8-bit): Dithers the image to the standard Asymetrix Compel palette.
File. Sets the snapshot to use a color palette file (.PAL), or the palette of a specific bitmap.
Clicking Browse opens the Open dialog box, in which you can import a palette.

Dithering. Sets how Asymetrix 3D F/X blends the available colors to approximate those
specified in the snapshot.



‘ Ordered: poorest quality; fastest dithering speed.
‘ Diffuse: best quality; slower dithering speed.
‘ Cluster: average quality; medium dithering speed.

‘ None: no dithering. Only available for 16-bit or higher images.




Step by step

Changing a snapshot's color depth or size
Commands

Generate Animation

Generate Snapshot

Options

Snapshot & Animation Settings
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Convert Snapshot (Size tab)

Tools menu

Converts a generated snapshot to a different size or color palette.

Note Click a tab below to see its options.

f Colors i hize I
Option Description
Original Image Lists the snapshot's current width and height in the units you specify.
New Image Sets the snapshot to a new size.

Image Size. Sets the snapshot to a standard size. Or you can set a custom size.

Width, Height, Units. Sets the snapshot's width and height to a specific size in units you
choose.

Scale Proportionally. Maintains the snapshot's width to height ratio as its width or height is
changed.

Scaling Method. Specifies how the snapshot is resized.
‘ Basic: poorest quality; fastest scaling method.
‘ Good: average quality; fast scaling method.

Better: good quality (can be blurry); slow scaling method.

‘ Best: best quality; slowest scaling method.




Arrange Catalog Entries

Tools menu

"

Arranges icons of entries in Catalog.



Step by step

Creating and modifying a Catalog
Command

Catalog



Bitmap Editor

Tools menu

"

Starts the Bitmap Editor application which you can use to edit a bitmap, or change its palette.
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Palette Editor

Tools menu

"

Starts the Palette Editor application which you can use to create custom palettes for your snapshots and
animations.
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Wave File Editor

Tools menu

"

Starts the Wave File Editor application, which you can use to modify a wave file used as a soundtrack.
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Photo CD Converter

Tools menu

"

Starts the Photo CD Converter application, which you can use to convert images you select from a Photo CD to
bitmap (.BMP) format.
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Options (Program tab)

Tools menu

Keyboard: F7
Sets default settings and options for working in Asymetrix 3D F/X.

Note Click a tab below to see its options.

| Program | Models | File I
Option Description
Catalog Options Sets options for the default Catalog that starts with Asymetrix 3D F/X.

Default. Sets which catalog file opens when you start Asymetrix 3D F/X.
Clicking Browse opens the Open dialog box, in which you can select a
Catalog file.

Spacing. Sets default distance between Catalog entries.
When Creating New Catalog Entry.

‘ Prompt User For File Name: opens the Save As dialog
box when you add a catalog entry.

‘ Create File Name: automatically creates names for

new catalog entries.

Zoom Dialogs Makes dialog boxes appear to zoom out as they open.

Display Solid Shows dialog box previews and scenes in OLE container applications as
Models In Previews  solid models.

& OLE

Generate Snapshot ~ When the Generate Snapshot toolbar button is clicked, immediately
Button Uses Last generates a snapshot using the last settings from the Generate

Settings Snapshot dialog box without opening the dialog box.



Options (Models tab)

Tools menu

Keyboard: F7

Sets default settings and options for working in Asymetrix 3D F/X.

Note Click a tab below to see its options.

[ Frogram i
Option

L File ]

Description

Default Colors

Wireframe Display
Colors

Move In Steps Of

Sets default colors used to create models.

Face. Sets color applied to model face. Click color button to set a new
color.

Side. Sets color applied to model sides. Click color button to set a new
color.

Default. Sets color applied to simple models and imported models that do
not have surface information. Click color button to set a new color.

Bevel. Displays color applied to model bevels. Click color button to set a
new color.

Sets default colors used to display models as wireframes.

Line. Sets color used to draw a model in Wireframe mode. Click color
button to set a new color.

Selected. Sets color used for selection lines in Wireframe or Boxes
mode. Click color button to set a new color.

Backfaces Hidden In Wireframe Mode. Hides surfaces of models in
Wireframe mode which would be hidden if the scene were displayed in
Solid Models mode.

Sets increments in which model moves, rotates, or scales when adjusted
using the Position palette, mouse, or arrow keys.




Options (File tab)

Tools menu

Keyboard: F7

Sets default settings and options for working in Asymetrix 3D F/X.

Note Click a tab below to see its options.

T~

Frogram

I

b odels i File l

Option

Description

At Startup

New Scenes

Sets what opens when you start Asymetrix 3D F/X.

Use Startup Dialog. Opens the Startup dialog box, from which you can choose a startup
option.

Use Scene Specialist. Opens the Scene Specialist program that can create snapshots for
you.

Create New Scene. Creates a new scene. New scene contents are determined by the
default options you set in the Snapshot & Animation Settings dialog box.

Display Open Dialog Box. Displays the Open dialog box so you can select a scene to work
with.

Specifies what settings are used to create a new scene.

Use Snapshot & Animation Defaults. Creates new scenes using the default options set in
the Snapshot & Animation Settings dialog box.

Use Scene File As Template. Creates new scenes using an existing scene file's settings
and content as a template.

File. Specifies a scene file to use as a template. Enter the name of a scene file, or click
Browse to display the Open dialog box, in which you can choose a file to to use as a
template.




Commands

Convert Snapshot
Generate Animation

Generate Snapshot

New

Snapshot & Animation Settings
Scene Specialist



Models menu



Create Text Model or Modify Text Model

Models menu

Keyboard: Ctrl+T (Create Text Model command)

Toolbar: (Create Text Model command)

Creates a 3D model from text or modifies an existing 3D text model. You can set the font and style of the text
before creating the text model.

Option Description
Toolbar Click a button below to see its description.

A |5 |[=Y

=|[=][=]|

Font Sets the font of the text model.

Size Sets the font size of the text model.

Enter Text Here Sets the text for the model. Press Shift+Enter to start a new line of text.

Model Name Displays the model name. The model name is automatically set to the text in the field. Double-click
in the box to enter a new name, or click Modify to enter a new name and description for the model.

Spelling Opens the Spelling dialog box.

Character Map  Opens the Character Map dialog box, in which you can select alternative characters to include in
the text model.

Modify 3D Opens the Modify 3D dialog box, in which you can set the bevel and thickness for the model.




Step by step

About text and picture models
Creating a text model
Commands

Modify 3D

Modify Letter Model (dialog box)
Modify Name (dialog box)
Spelling (dialog box
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Cut

Cuts selected text to the Windows Clipboard, replacing the previous Clipboard contents.



Copy

Copies selected text to the Windows Clipboard, replacing the previous Clipboard contents.



Paste
Pastes the contents of the Windows Clipboard into the Enter Text Here area.



Bold

Makes selected text bold.



Italic
Makes selected text italic.



Align left
Aligns all text to left.



Center
Centers all text.



Align right
Aligns all text to right.



Justify

Justifies text.



Subscript

Formats selected text as subscript.



Normal
Sets text's vertical alignment to normal (neither subscript nor superscript).



Superscript
Formats selected text as superscript.



Modify Name (dialog box)

Any scene element dialog box or right-click menu

Allows you to set a new name and description for a scene element.

Option Description

Name Sets a name to display in the Scene Contents window and status bar.

Note To modify the name of a group of elements, such as lights or paths, right-click the group in
the Scene Contents window, then enter a name.

Description  Sets a description to display in the status bar.




Commands
Create Picture Model
Create Text Model

Modify Animation

Modify Backdrop

Modify Cube (dialog box)

Modify Cylinder (dialog box)
Modify Imported Model (dialog box)
Modify Letter Model (dialog box)
Modify Lights

Modify Picture Model (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)
Modify Sub-part (dialog box)
Modify Surface & Color

Modify Text Model (dialog box)
Modify Warp
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Spelling (dialog box)

Models menu / Create Text Model / Spelling

Provides options for correcting the spelling of words used in text models.

Option

Description

Not In Dictionary;
Invalid Character;
Capitalization

Change To

Suggestions
Personal Dictionary
Add

Ignore group

Ignore
Ignore All
Change
Change All

Displays unknown text, unknown use of punctuation, or unknown capitalization
scheme.

Displays suggested new text to replace the unknown text. Double-click to enter
corrections here.

Displays a list of alternative words for the unknown text, if available.
Specifies a dictionary to open. Enter the name of a dictionary.

Adds the unknown text to a custom user dictionary.

Specifies types of words to ignore.

Words In UPPERCASE. Ignores words containing only capital letters.
Words With Numbers. Ignores words containing numbers.

Ignores the unknown text.

Ignores every occurrence of the unknown text.

Changes unknown text to the text specified in the Change To box.

Changes every occurrence of the unknown text to the text specified in the
Change To box.




Command
Create Text Model
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Create Picture Model

Models menu

Keyboard: Ctrl+M

Toolbar: @

Imports graphic files to create 3D picture models. For bitmaps, Asymetrix 3D F/X converts the image to black and
white, then traces around the black to create a 3D picture model. For graphic files defined by polygons and lines
(such as metafiles), Asymetrix 3D F/X uses the information in the source file to create a 3D picture model.

Option Description
Create Model From Imports a graphic file to use in creating a model.
Graphic File

File. Specifies a file to import. Enter the name of a graphic file. Clicking Browse
opens the Import Graphic dialog box, in which you can choose a file to import.

Paste Graphic From Clipboard. Pastes a graphic file from the Windows
Clipboard into the dialog box.
Preview. Previews the graphic file.

Note Metafiles may appear distorted in the preview area, but will be imported
without distortion.

Autotrace. Creates a model by converting a bitmap to black and white, then
tracing around the black.

Trace Options. Opens the Trace Options dialog box, which specifies how a
bitmap is converted to black and white, and how closely it is traced.

Model Name Model Name. Displays the model name. Double-click in the box to enter a new
name, or click Modify to enter a new name and description for the model.
Modify 3D Opens the Modify 3D dialog box, in which you can set the bevel and thickness

for the model.



Step by step

About text and picture models
Creating a picture model
Commands

Import Graphic (dialog box)
Modify 3D

Modify Name (dialog box)
Modify Picture Model (dialog box)
Modify Sub-part (dialog box)
Trace Options (dialog box)
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Import Graphic (dialog box)

Models menu / Create Picture Model / Browse

Used to import a bitmap or metafile.

Option

Description

File Name

List Files Of Type

Directories

Drives

Preview
Preview Selection
Network

Lists all files in the current default directory with the default file extension for the selected
file format (.BMP, .DIB, or WMF). A file selected from the File Name list replaces the
contents of the File Name box.

Indicates that the default file types are the graphic types .BMP, .DIB, and .WMF. The drop-
down list includes all other available file types.

Displays the default path. Change the directory by selecting a new path from the
Directories box, which lists all directories available on the current drive. To change the
drive, make a selection in the Drives box.

Lists the available drives. Selecting a new drive changes the contents of the Directories
box.

Previews the bitmap or metafile.
Enables the Preview area.

Available if your system is connected to a network. Opens the Network dialog box from
which you can choose additional drives and directories.




Step by step

Creating a picture model
Command

Create Picture Model
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Trace Options (dialog box)

Models menu / Create Picture Model / Trace Options

Specifies which shades in a bitmap are converted to white, and how closely it is traced to create a picture model.

Option Description

Tightness Of Fit ~ Sets how closely (in pixels) to trace the curves in a bitmap, once it has been converted to
black and white.

Ignore Shades Lighter Than. Sets the shades that will be considered white when tracing a bitmap.

Things Smaller Than. Sets the size of areas that will be traced (in pixels).



Step by step

Creating a picture model
Command

Create Picture Model
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Create Simple Model submenu

Models menu

Creates geometrically defined models.

Submenu item

Description

Sphere
Ring
Cylinder
Cube

Cone
Plane
Octahedron
Barrel
Gear
Hexnut
Tube
Double Bell

Creates a sphere model.

Creates a ring model.

Creates a cylinder model.

Creates a cube model.

Creates a cone model, based on a cylinder.
Creates a plane model, based on a cube.
Creates an octahedron model, based on a sphere.
Creates a barrel model, based on a sphere.
Creates a gear model, based on a cylinder.
Creates a hexnut model, based on a ring.
Creates a tube model, based on a cylinder.
Creates a double bell model, based on a sphere.




Step by step

About simple models

Adding a preset model
Modifying a simple model's shape
Commands

Modify Cube (dialog box)

Modify Cylinder (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)
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Import Model

Models menu

Keyboard: Ctrl+l

Imports a 3D model file created in another program into a scene. Asymetrix 3D F/X supports models that use the
Autodesk 3D Studio (.3DS) or AutoCAD (.DXF) format.

Option

Description

File Name

List Files Of Type
Directories
Drives

Network

Lists all files in the current default directory with the default file extension for the selected
file format. A file selected from this box replaces the contents of the File Name box.

Indicates that geometry files (extensions .3DS or .DXF) are the default file type.

Displays the default path. Change the directory by selecting a new path from the
Directories box, which lists all directories available on the current drive. To change the
drive, make a selection in the Drives box.

Lists the available drives. Selecting a new drive changes the contents of the Directories
box.

Available if your system is connected to a network. Opens the Network dialog box from
which you can choose additional drives and directories.




Step by step

About imported models

Importing a model

Commands

Imported Model Surface (dialog box)
Modify Imported Model (dialog box)
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Imported Model Surfaces (dialog box)

Models menu / Import Model

Opens when you import a model in .3DS format and Asymetrix 3D F/X cannot locate the surface mapping files
required to display it.

Option Description

Reassign Surface Mappings .3DS Filename (Map Type) -> New Filename list. Lists Autodesk 3D Studio

Browse, and then select a file to assign to it.

surface map file names that cannot be found. Select a surface map name, click



Step by step

About imported models

Importing a model

Commands

Import Model

Modify Imported Model (dialog box)
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Modify 3D

Models menu

Modifies the currently selected text or picture model's 3D options.

Option Description
Bevel Sets type of angle on a model's edges. Adding a bevel causes a model to redraw and generate
more slowly.

None. Removes model's bevel.

Angled. Adds 45-degree bevel to model's edges.

Concave Curve. Adds concave bevel to model's edges.

Convex Curve. Adds convex bevel to model's edges.

Bevel Size. Sets bevel's size as a percentage of the model's depth.
Thickness Sets model's depth in relation to the apparent width of the Scene Preview window.
Preview Preview. Previews 3D options. Click to stop and start rotation.

Update. Applies options set in dialog box to model in preview area.



Step by step

About text and picture models
Creating a picture model
Creating a text model
Commands

Create Text Model

Create Picture Model
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Modify Model

Models menu

"

You can use the Modify Model command to change text, picture, simple, and imported models you've created. For
details about modifying a specific type of model, click a topic below.

Modify Cube (dialog box)

Modify Cylinder (dialog box)
Modify Imported Model (dialog box)
Modify Letter Model (dialog box)
Modify Picture Model (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)

Modify Sub-part (dialog box)

Modify Text Model (dialog box)



Step by step
About imported models
About object linking and embedding (OLE

About simple models
About surfaces

About text and picture models
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Modify Picture Model (dialog box)

Models menu / Modify Model

-y

Modifies the name of the selected picture model.

Option Description

Model Name Displays the model or sub-part's name. Double-click in the box to enter a new name, or click

Modify to enter a new name and description for the model or sub-part.



Step by step

About text and picture models
Creating a picture model
Commands

Create Picture Model
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Modify Sub-part or Modify Letter Model (dialog box)

Models menu / Modify Model

-y

Modifies the name of the selected sub-part of a model or text model.

Option Description

Model Name Displays the name of the sub-part of the model or text model. Double-click in the box to enter a

new name, or click Modify to enter a new name and description for the sub-part.



Step by step

About text and picture models
Creating a picture model
Creating a text model
Commands

Create Picture Model
Create Text Model
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Modify Imported Model (dialog box)

Models menu / Modify Model

-y

Modifies the selected imported model's name and meshes.

Option

Description

Model Name

Mesh Operations

Displays the model name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the model.

Manipulates the triangles that make up the surface of an imported model.

Flip Normals. Reassigns the front and back of each triangle. Use this option when you can't
see an imported model once you've rendered it.

Melt. Makes a surface more faceted, and less smooth.

Weld. Makes a surface less faceted, and more smooth.

Unify Normals. Orients all the triangles in a mesh in the same direction.
Sub Diivide. Divides each triangle in a mesh into three triangles.




Step by step

About imported models

Importing a model

Commands

Import Model

Imported Model Surface (dialog box)
Modify Name (dialog box)
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Modify Cube (dialog box)

Models menu / Modify Model

"

Modifies the selected cube or plane model.

Option Description

Model Name Displays the model name. Double-click in the box to enter a new name, or click Modify to enter
a new name and description for the model.

Preview Previews options set in dialog box.

Update Applies options set in dialog box to model in preview area.

Size X Sets model's width. Range of values: .001 to 5000.

Size Y Sets model's height. Range of values: .001 to 5000.

Size Z Sets model's depth. Range of values: .001 to 5000.

Divisions Sets number of triangles that make up the model. Range of values: 2 to 16.




Step by step

About simple models

Adding a preset model
Modifying a simple model's shape
Commands

Create Simple Model

Modify Cylinder (dialog box)
Modify Name (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)
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{ewl ewl, ewBitmap, cube.dib}
If you do not see a series of example snapshots, you do not have file CUBE.DIB.



Modify Cylinder (dialog box)

Models menu / Modify Model

Modifies the selected cylinder, cone, gear, or tube model.

Option Description

Model Name Displays the model name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the model.

Preview Previews options set in dialog box.

Update Applies options set in dialog box to model in preview area.

Upper Radius Adjusts radius of circle at top of model. Range of values: .001 to 5000.

Lower Radius
Radial Divisions

Height Divisions
Height

Radial Power
End Caps

Petals

Petal Size

Petal Shape

Adjusts radius of circle at bottom of model. Range of values: .001 to 5000.

Adjusts number of wedge shapes that make up model's circular faces. Range of values: 3 to
256.

Adjusts number of rows of triangles that make up model's vertical faces. Range of values: 1
to 32.

Adjusts model's height. Range of values: .001 to 5000.

Contorts model's curves away from or toward its horizontal and vertical axes. A value close to
10 collapses model toward its center to resemble a cross; a value close to 0 expands model's
curves to resemble a square. Range of values: .01 to 10.

Places faces on ends of model.

Molds model into a flower shape with the specified number of petals. Range of values: 1 to
16.

Adjusts size of petals (if petals are specified). Range of values: 0 to 1.

If petal size is greater than 0 and Radial Divisions have not already been set, Asymetrix 3D
F/X automatically changes the Radial Divisions to 16 times the value of Petals when the
Update button is clicked.

Modifies the shape of model's petals. A value close to 0 make petals more squared; a value
close to 10 makes petals more pointed. Range of values: .01 to 10.

If petal size is greater than 0, petal shape is less than .5 or greater than 4, and Radial
Divisions have not already been set, Asymetrix 3D F/X automatically changes the Radial
Divisions to 32 times the value of Petals when the Update button is clicked.




Step by step

About simple models

Adding a preset model
Modifying a simple model's shape
Commands

Create Simple Model

Modify Cube (dialog box)
Modify Name (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)
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Example 1: lllustrates the radius, divisions, power, and end caps parameters.
Example 2:: lllustrates the petal parameters.



{ewl ewl, ewBitmap, cylndr1.dib}
If you do not see a series of example snapshots, you do not have file CYLNDR1.DIB.



{ewl ewl, ewBitmap, cylndr2.dib}
If you do not see a series of example snapshots, you do not have file CYLNDR2.DIB.



Modify Ring (dialog box)

Models menu / Modify Model

Modifies the selected ring or hexnut model.

Option Description

Model Name Displays the model name. Double-click in the box to enter a new name, or click Modify to enter
a new name and description for the model.

Preview Previews options set in dialog box.

Update Applies options set in dialog box to model in preview area.

Power X Contorts model's curves away from or toward its horizontal and vertical axes. A value close to
10 collapses model to make it resemble a cross; a value close to 0 expands model to make it
resemble a square. Range of values: .01 to 10.

PowerY Contorts curves of the circles that comprise the model away from or toward their horizontal and
vertical axes. A value close to 10 collapses each circle to make model seem composed of
crosses; a value close to 0 expands each circle to make model seem composed of squares.
Range of values: .01 to 10.

Thickness Adjusts radius of circles that comprise model. Range of values: .001 to 5000.

Ring Radius Adjusts radius of entire model. Range of values: .001 to 5000.

Major Divisions
Minor Divisions

Adjusts number of circles that make up model. Range of values: 3 to 100.
Adjusts number of lines in circles that make up model. Range of values: 3 to 100.




Step by step

About simple models

Adding a preset model
Modifying a simple model's shape
Commands

Create Simple Model

Modify Cube (dialog box)
Modify Cylinder (dialog box)
Modify Name (dialog box)
Modify Sphere (dialog box)
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{ewl ewl, ewBitmap, ring.dib}
If you do not see a series of example snapshots, you do not have file RING.DIB.



Modify Sphere (dialog box)

Models menu / Modify Model

Modifies the selected sphere, octahedron, barrel, or double bell model.

Option Description

Model Name Displays the model name. Double-click in the box to enter a new name, or click
Modify to enter a new name and description for the model.

Preview Previews options set in dialog box.

Update Applies options set in dialog box to model in preview area.

Fineness Adjusts number of triangles that make up model. Range of values: 1 to 5.

Power X Contorts model's curves away from or toward its horizontal axis. A value close
to 10 elongates the curve (to resemble a top); a value close to 0 squares the
curve. Range of values: 0 to 10.

Power Y Contorts model's curves away from or toward its vertical axis. A value close to
10 elongates the curve; a value close to 0 squares the curve. Range of values:
0to 10.

Power Z Contorts model's curves away from or toward its depth axis. A value close to 10
elongates the curve; a value close to 0 squares the curve. Range of values: 0 to
10.

Radius X Adjusts length of model's horizontal axis. Range of values: .001 to 5000.

Radius Y Adjusts length of model's vertical axis. Range of values: .001 to 5000.

Radius Z Adjusts length of model's depth axis. Range of values: .001 to 5000.

Optimize For Bitmap Surface

Adjusts model's surface to better display bitmap patterns, bump textures, or
reflection maps.




Step by step

About simple models

Adding a preset model
Modifying a simple model's shape
Commands

Create Simple Model

Modify Cube (dialog box)
Modify Cylinder (dialog box)
Modify Name (dialog box)
Modify Ring (dialog box)
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{ewl ewl, ewBitmap, sphere.dib}
If you do not see a series of example snapshots, you do not have file SPHERE.DIB.



Modify Surface & Color (Surface Pattern tab)

Models menu

Modifies the surface of a model.

Note Click a tab below to see its options.

I Highlights | Effects |
Option Description

Surface Name Displays the surface's name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the surface.

Surface Preview Previews surface options.
Surface Pattern ~ Color. Sets pattern to a color. To change color, see the Surface Settings options below.

Bitmap Pattern. Sets pattern to a bitmap. To apply a different bitmap, see the Surface
Settings options below.

Solid Material. Sets pattern to a preset solid material. To change material, see the Surface
Settings options below.

Note If you apply a solid material surface to a model, the surface will not be visible until you
generate a snapshot or animation of the scene.

Surface Settings Color surface pattern options.

‘ Color button: displays Color Wheel dialog box.
‘ Color tiles: set pattern to a color.

Bitmap surface pattern options.

f

‘ Bitmap: contains list of preset pattern files, or indicator that file is imported.

‘ File: displays selected file's name. Double-click to enter a different file name, or click
Browse to select a new file. Bitmap surfaces can be found in the Bitpatrn subdirectory of your Catalog directory.
Note You can also select a digital video (.AVI) file to play as a model's surface.

‘ Tile Bitmap: sets how often a bitmap is repeated on a model's surface.
Note If you tile a bitmap surface, the surface will not appear tiled until you generate a snapshot or
animation of the scene.

Solid Material, Granite surface pattern options.

‘ Scale: sets how often pattern is repeated on a model's surface. A value of 100%
displays the pattern once, a value of 50% displays the pattern four times, and so on.

‘ Stone: sets color of stone, and percentage of stone in relation to other pattern
elements.



Single Sided
Double Sided

Grains: sets color of grain, and percentage of grain in relation to other pattern elements.
Solid Material, Marble surface pattern options.

‘ Scale: sets how often pattern is repeated on a model's surface. A value of 100%
repeats the pattern once, a value of 50% repeats the pattern four times, and so on.

Vein Curliness: sets curliness of vein.
Stone: sets color of stone, and percentage of stone in relation to other pattern elements.
Vein: sets color of vein, and percentage of vein in relation to other pattern elements.

Grainline: sets whether grainline shows on top, sides, or front of model.
Solid Material, Wood surface pattern options.

‘ Scale: sets how often pattern is repeated on a model's surface. A value of 100%
repeats the pattern once, a value of 50% repeats the pattern four times, and so on.

Grain Curliness: sets curliness of grain.
Wood: sets color of wood, and percentage of wood in relation to other pattern elements.
Grain 1: sets color of grain, and percentage of grain in relation to other pattern elements.

Grainline: sets whether grainline shows on top, sides, or front of model.
Sets a surface to appear only on the outer faces of a model.
Sets a surface to appear on both the inner and outer faces of a model.




Step by step

About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Creating a "glass"™ surface

Creating models that appear to be lights
Making a color surface appear transparent
Making a scene and backdrop appear smoky
Making a scene and backdrop appear snowy
Making a solid material surface transparent
Making a surface reflect a bitmap

Making a surface reflective

Making all models in a scene reflect a bitmap
Modifying a model's surface

Submerging a model in "water"

Commands

Color Wheel (dialog box)

Import Graphic (dialog box)
Modify Name (dialog box)
Snapshot & Animation Settings
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Example 1: lllustrates the Surface Pattern tab parameters.
Example 2: lllustrates the Highlights tab parameters.
Example 3: lllustrates the Effects tab parameters.



{ewl ewl, ewBitmap, surf1.dib}
If you do not see a series of example snapshots, you do not have file SURF1.DIB.



Modify Surface & Color (Highlights tab)

Models menu

Modifies the surface of a model .

Note Click a tab below to see its options.

Option

I Effectz l

Description

Surface Name

Surface Preview
Surface Finish

Bump Texture

Displays the surface's name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the surface.

Previews surface options.

Sets how surface changes with light.

Highlight Size. Adjusts the amount of area the highlight covers.
Highlight Intensity. Adjusts highlight brightness.

Unhighlighted Surface. Adjusts shade of unhighlighted surfaces.
Defines a surface's texture.

Texture. Contains list of preset texture files, or indicates that file is imported or that no file is
selected.

File. Displays selected file's name. Double-click to enter a different file name, or click Browse
to select a new file. Bump textures can be found in the Bumps subdirectory of your Catalog
directory.

Tile Texture. Sets how often the texture bitmap is repeated on a model's surface.




{ewl ewl, ewBitmap, surf2.dib}
If you do not see a series of example snapshots, you do not have file SURF2.DIB.



Modify Surface & Color (Effects tab)

Models menu

Modifies the surface of a model .

Note Click a tab below to see its options.

[ Surface Pattern r

Highlights |

Option

Description

Surface Name

Surface Preview
Reflections

Transparency

Displays the name that appears in the Scene Contents window and status bar. Double-click
in the box to enter a new name, or click Modify to enter a new name and description for the
surface.

Previews surface options.
Sets how reflective a surface is, and what it reflects.
Use Reflection Map. Check to make a model's surface appear to reflect a bitmap.

Reflection. Lists preset reflection files, or indicates that file is imported or that no file is
selected.

File. Displays selected file's name. Double-click to enter a different file name, or click Browse
to select a new file. Reflection maps can be found in the Rflctns subdirectory of your Catalog
directory.

Enable Optical Effects When Ray Tracing. Check to make an object reflect both a reflection
map and the scene around it if either Ray Traced or Ray Traced w/Shadows are selected as
generating options.

Intensity. Adjusts how much of the reflection map or scene the model's surface reflects.
Adjusts surface's transparency.




{ewl ewl, ewBitmap, surf3.dib}
If you do not see a series of example snapshots, you do not have file SURF3.DIB.



Color Wheel (dialog box)

<&

Displays colors you can choose for surfaces or backdrops.

Option Description
Color Wheel Sets a color.
Lightness Adjusts lightness of all colors.
Color Displays selected color.
Opacity Displays the transparency of a color, from 0 to 255.
Note Opacity is only available when modifying a color used as a surface.
RGB Values Sets amounts of Red, Green, and Blue in a color, from 0 to 255.
HLS Values  Hue. A value between 0 and 255 that sets a color's quality corresponding to its position in the

spectrum, ranging from red through yellow, green, cyan, blue, and magenta.
Lightness. A value between 0 and 255 that represents the amount of white or black in a color.
Saturation. A value between 0 and 255 that represents the intensity of a color.




Step by step

About color in Asymetrix 3D F/X

About color palette shift

Applying a surface to a model

Making a scene and backdrop appear smoky
Making a scene and backdrop appear snowy
Making a solid material surface transparent
Modifying a model's surface

Command

Modify Surface & Color
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Animated Surface (dialog box)

Models menu / Modify Surface & Color

-y

Opens when you select an .AVI file, rather than a bitmap, to apply as a model's surface. Sets start and end frames
of .AVI file to play. Start and end frames can only be defined once. To reset an animation's start and end frames,
you must reselect it as a bitmap pattern in the Surface Pattern tab of the Modify Surface & Color dialog box.

Option Description

Preview Displays selected .AVI file.

Frames To Use Start/End. Set the starting and ending frame numbers for the .AVI file. Click to set the
currently visible Start and End frame numbers.

Start Time Sets how many seconds after start of animation surface .AVI file begins to play.
Asymetrix 3D F/X displays the start frame until the .AVI file starts playing.

Duration Time in seconds of selected .AVI clip.

Continuous Loop Sets .AVI file to play continuously on surface.

Freeze On Last Frame Sets .AVI file to play once on surface, then hold on last frame.




Step by step

Applying a digital video file as a surface
Command

Modify Surface & Color

Asymetrix 3D F/X User Manual
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Modify Animation (Movement tab)

Models menu

Modifies an animation path for a model.

Note Click a tab below to see its options.

I

Spin r Effects ]_

Option

Description

Animation Path Name(s)

Duration
Start And End Positions

Offscreen Position

Sets an animation path to modify.

Modify. Opens the Modify Name dialog box, in which you can enter a new name and
description for the path.

Seconds. Sets time length in seconds for the selected animation path.

Enter Scene. Creates path for model to enter scene. Click, then set the model's
initial position using the Offscreen Position option described below.

Leave Scene. Creates path for model to leave scene. Click, then set the model's
final position using the Offscreen Position option described below.

Don't Move. Specifies that model remain in place.

Wait Offscreen. Specifies that model wait offscreen in the specified location for the
specified duration.

Custom. Indicates that the current path contains path information not created with
this dialog box. Custom paths can only be edited, not created.

Sets model's initial or final Offscreen position. Click an intersection to set a model's
position.




Step by step

About animation in Asymetrix 3D F/X
Adding a soundtrack to an animation
Animating a model

Animating sub-parts of a model
Generating an animation

Modifying a model's animation path
Modifying a model's animation path sequence
Playing a linked or embedded animation
Previewing an animation

Printing a frame of an animation
Staggering when models enter a scene
Commands

Generate Animation

Modify Name (dialog box)

Modify Soundtrack
Preview All Frames

Preview Animation

Asymetrix 3D F/X User Manual
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Modify Animation (Spin tab)

Models menu

Modifies an animation path for a model.

Note Click a tab below to see its options.

f b ovement i Spin
Option

I Effects ]_

Description

Animation Path Name(s)

No Spin

Spin Entire Model

Spin Sub-parts Only

Spin Both Model And Sub-parts
Number Of Turns

Preview & Define Spin

Sets an animation path to modify.

Modify. Opens the Modify Name dialog box, in which you can enter a new name
and description for the path.

Specifies that model not spin.

Specifies that entire model spins.

Specifies that only sub-parts of model spin.
Specifies that both model and its sub-parts spin.

Specifies how many turns spinning objects perform. Positive numbers cause
the model to rotate in the direction set in the Preview & Define Spin area;
negative numbers cause the model to rotate in the opposite direction.

Note You must specify a number of turns, or no spin will be applied to the
model.

Spin Left/Right (Local Y). Specifies that model rotate from left to right, around
its vertical axis.

Spin Up/Down (Local X). Specifies that model rotate from top to bottom, around
its horizontal axis.

Propeller (Local Z). Specifies that model rotate from left to right, around its
depth axis.

Define Spin. Specifies that model rotate in the direction set by clicking in the
Preview & Define Spin box.




Modify Animation (Effects tab)

Models menu

Modifies an animation path for a model.

Note Click a tab below to see its options.

[ kovement r

Spin i

Option

Description

Animation Path Name(s)

Sub-part Sequence

Offscreen Orientation

Sets an animation path to modify.

Modify. Opens the Modify Name dialog box, in which you can enter a new name and
description for the path.

Apply To Motion. Specifies that stagger options you set (described below) apply to
model's motion.

Apply To Spin. Specifies that stagger options you set (described below) apply to
model's spin.

Stagger Sub-parts First To Last. Specifies that model's sub-parts move or spin in the
order they are listed in the Scene Contents window.

Stagger Sub-parts Last To First. Specifies that model's sub-parts move or spin in
reverse of the order they are listed in the Scene Contents window.

Stagger In A Random Sequence. Specifies that model's sub-parts move or spin in
random order.

Stagger Factor. Specifies how far along its animation path each sub-part will
progress before the next sub-part begins moving or spinning.

Sets how model is oriented as it enters or leaves scene.

Enable. Specifies that as a model moves along an animation path, it tumbles from
the offscreen orientation to the orientation of the model in the Scene Preview
window.




Modify Warp (Front tab)

Models menu

Defines how the selected model will be stretched or twisted.

Note Click a tab below to see its options.

 Eem |

Side I Top

el

Description

Twist (Front/Back)
Bow

Angle

Enable Warp

Disable Warp
Warp Name

Preview
Update
Reset

Sets how bow and angle sliders warp model from the front.

Symmetrically. Adjusts both front edges in the same direction.

Mirrored. Adjusts front edges opposite each other.

Independently. Adjusts front edges independently.

Sets how many degrees away from center the model's front and back twist.
Adjusts the amount model's center is raised above or below its edges.
Adjusts the angle of the model's ends.

Applies warp to model. Sub-parts cannot be moved individually, but only along with the rest of
the model.

Removes warp from model, so that sub-parts can be moved individually.

Displays the warp's name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the warp.

Previews warp options set in dialog box. Click to stop and start rotation.
Applies options set in dialog box to model in preview area.
Removes all warps from model.




Step by step
Modify Name (dialog box)
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{ewl ewl, ewBitmap, warp.dib}
If you do not see a series of example snapshots, you do not have file WARP.DIB.



Modify Warp (Side tab)

Models menu

Defines how the selected model will be stretched or twisted.

Note Click a tab below to see its options.

[ Front r

S | Tw

el

Option Description

Warp Sets how bow and angle sliders warp model from the side.
Symmetrically. Adjusts both side edges in the same direction.
Mirrored. Adjusts side edges opposite each other.
Independently. Adjusts side edges independently.

Twist (Left/Right) Sets how many degrees away from center the model's sides twist.

Bow Adjusts the amount model's center is raised above or below its edges.

Angle Adjusts the angle of the model's ends.

Enable Warp Applies warp to model. Sub-parts cannot be moved individually, but only along with the rest of
the model.

Disable Warp Removes warp from model, so that sub-parts can be moved individually.

Warp Name Displays the warp's name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the warp.

Preview Previews warp options set in dialog box. Click to stop and start rotation.

Update Applies options set in dialog box to model in preview area.

Reset Removes all warps from model.




Modify Warp (Top tab)

Models menu

Defines how the selected model will be stretched or twisted.

Note Click a tab below to see its options.

[ Front r

T

Option Description

Warp Sets how bow and angle sliders warp model from the top.
Symmetrically. Adjusts both top edges in the same direction.
Mirrored. Adjusts top edges opposite each other.
Independently. Adjusts top edges independently.

Twist (Top/Bottom)  Sets how many degrees away from center the model's top and bottom twist.

Bow Adjusts the amount model's center is raised above or below its edges.

Angle Adjusts the angle of the model's ends.

Enable Warp Applies warp to model. Sub-parts cannot be moved individually, but only along with the rest
of the model.

Disable Warp Removes warp from model, so that sub-parts can be moved individually.

Warp Name Displays the warp's name. Double-click in the box to enter a new name, or click Modify to
enter a new name and description for the warp.

Preview Previews warp options set in dialog box. Click to stop and start rotation.

Update Applies options set in dialog box to model in preview area.

Reset Removes all warps from model.




Snapshot & Animation Settings (Size tab)

Scene menu

Keyboard: Shift+F3

Sets how snapshots and animations are generated.
Note The OLE tab is only available when performing in-place editing in a linked or embedded scene.

Note Click a tab below to see its options.

¢ | _Quality | Colors ) Effects | OLE |

Option

Description

Size

Animation Frame Rate

Default

Sets snapshot or animation to an Image Size you choose.

Note To generate snapshots larger than 4092 pixels wide when your color depth is 8
bits per pixel, 2046 pixels when your color depth is 16 bits per pixel, or 1364 pixels
when your color depth is 24 bits per pixel, you must generate to file.

Width, Height, Units. Sets snapshot's width and height to a size in units that you
specify. Also changes automatically when you choose a preset image size.

Scale Proportionally. Maintains snapshot's width to height ratio as its width or height is
changed.

Sets how many frames per second (fps) are generated. Higher frame rates result in
smoother motion, but create larger files. Fifteen fps is the suggested frame rate.
Sets default size, animation frames per second, snapshot style, smoothing, palette,
dithering, fog, and environment map options for new scenes you create to those
specified in this dialog box.




Step by step
About animation in Asymetrix 3D F/X

About color in Asymetrix 3D F/X
About object linking and embedding (OLE

About surfaces

Changing a snapshot's color depth or size
Displaying a snapshot or animation in a container application
Generating a snapshot

Generating an animation

Commands

Convert Snapshot

Generate Animation

Generate Snapshot

Modify Animation

Modify Surface & Color

Options

Asymetrix 3D F/X User Manual
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Snapshot & Animation Settings (Quality tab)

Scene menu

Keyboard: Shift+F3

Sets how snapshots and animations are generated.
Note The OLE tab is only available when performing in-place editing in a linked or embedded scene.

Note Click a tab below to see its options.

Size | Quaité | Colbrs | Effects | OLE |

Option Description
Quality Sets output style and smoothing for the snapshot.
Snapshot Style. Determines amount of detail used to generate

snapshots.

"

Wireframes: draws wireframe models; fastest
generating method.

Note If you choose Wireframes, your snapshot or
animation will generate at the color depth of your video driver.

"

Solid Models: draws solid models using
rough approximations of shading; slower generating method.

Note If you choose Solid Models, your snapshot or
animation will generate at the color depth of your video driver. If
you select the Solid Model generating style, you cannot
generate a snapshot larger than your screen.

Realistic: draws solid models using realistic

HHE ) H
Lo
et
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Realistic w/Shadows: draws solid models,
ng realistic shading and shadows.

c
@

Ray Traced: draws solid models using
realistic shading and reflections; excellent quality.

"

Ray Traced w/Shadows: draws solid models
using realistic shading, reflections, and shadows; excellent

quality.

Smoothing. Sets how smooth high-contrast areas will appear.
Number Of Ray Sets number of ray traced reflections to draw in scene. Only
Traced Reflections  available when the selected Snapshot Style is Ray Traced or

Ray Traced w/Shadows.
Default Sets default size, animation frames per second, snapshot style,

smoothing, palette, dithering, fog, and environment map
options for new scenes you create to those specified in this



dialog box.




Snapshot & Animation Settings (Colors tab)

Scene menu

Keyboard: Shift+F3

Sets how snapshots and animations are generated.
Note The OLE tab is only available when performing in-place editing in a linked or embedded scene.

Note Click a tab below to see its options.

f Size r Cluality ]j Lo r Effectz r LE ]

Option Description

Colors Palette. Sets the scene's color depth and palette.

‘ Monochrome (1-bit): Dithers the image to a black and white palette.

‘ 16 Colors (4-bit): Dithers the image to the standard Windows palette.

‘ 256 Colors (8-bit): Dithers the image to the default Asymetrix 3D F/X palette.

‘ 65,536 Colors (16-bit): Recreates the image's colors precisely (does not impose a
palette).

‘ 16 Million Colors (24-bit): Recreates the image's colors precisely (does not impose a
palette).

‘ 16 Grays (8-bit): Dithers the image to a palette of 16 grays.

‘ 236 Grays (8-bit): Dithers the image to a palette of 236 grays. All grays will be recreated
precisely.

256 Grays (8-bit): Dithers the image to a palette of 256 grays. Some grays may not be
recreated precisely.

"

Compel Palette (8-bit): Dithers the image to the standard Asymetrix Compel palette.

File. Sets the snapshot to use a color palette file (.PAL), or the palette of a specific bitmap.
Clicking Browse opens the Open dialog box, in which you can import a palette.

Dithering. Sets how Asymetrix 3D F/X blends the available colors to approximate those
specified in the snapshot.

‘ Ordered: poorest quality; fastest dithering speed.

Diffuse: best quality; slower dithering speed.



‘ Cluster: average quality; medium dithering speed.

None: no dithering. Only available for 16-bit or higher images.
Default Sets default size, animation frames per second, snapshot style, smoothing, palette, dithering,

box.

fog, and environment map options for new scenes you create to those specified in this dialog



Snapshot & Animation Settings (Effects tab)

Scene menu

Keyboard: Shift+F3

Sets how snapshots and animations are generated.
Note The OLE tab is only available when performing in-place editing in a linked or embedded scene.

Note Click a tab below to see its options.

[ Size | Qualty ] Colars aLE
Option Description
Fog Sets use of fog effects in scene.

Use Fog In Scene. Specifies that objects appear more diffuse the farther back in the
scene they are.

Fog Color. Specifies fog color. A dark color makes objects darker with distance; a light
color makes objects brighter with distance.

Fog Thickness. Specifies how transparent fog appears.

Environment Map Use Environment Map. Specifies that all models in scene will reflect a selected bitmap,
rather than other scene elements.

File. Lists selected environment map file's name. Clicking Browse opens the Import
Graphic dialog box in which you can choose an environment map to use. Environment
maps can be found in the Rflctns subdirectory of your Catalog directory.

Default Sets default size, animation frames per second, snapshot style, smoothing, palette,

specified in this dialog box.

dithering, fog, and environment map options for new scenes you create to those



Snapshot & Animation Settings (OLE tab)

Scene menu

Keyboard: Shift+F3

Sets how snapshots and animations are generated.
Note The OLE tab is only available when performing in-place editing in a linked or embedded scene.

Note Click a tab below to see its options.

f Size r [usality r Colors r Effects \Il

Option Description

Container Presentation Display Which .AVI Frame. Sets the first or last frame of an animation to display in
the OLE container application.
First. Displays first frame of animation.
Last. Displays last frame of animation.

Make Snapshot Background Transparent. Makes the background of an embedded
or linked snapshot transparent. Permanently affects the file.

Note Only snapshots with solid color backgrounds generated using the Realistic,
Realistic w/Shadows, Ray Traced, or Ray Traced w/Shadows generating style can
be made transparent.

Default Sets default size, animation frames per second, snapshot style, smoothing, palette,

specified in this dialog box.

dithering, fog, and environment map options for new scenes you create to those



Camera Perspective submenu

Scene menu / Camera Perspective

Displays the scene at a normal, telephoto, or wide angle perspective.

Submenu item Keyboard Description
Normal F5 Displays the scene at a normal perspective.
Wide Angle Shift+F5 Displays the scene at a wide perspective, or as if through a
wide-angle lens. The model's depth is emphasized.
Telephoto Ctrl+F5 Displays the scene close up, or as if through a telephoto lens.

Models look flatter, and depth is de-emphasized.




Step by step

About camera perspective

About creating 3D graphics with Asymetrix 3D F/X
Setting the camera perspective
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Modify Backdrop

Scene menu

Adds a backdrop to a scene.

Option

Description

Backdrop Name

Style

Displays the backdrop's name. Double-click in the field to enter a new name, or click Modify
to enter a new name and description for the backdrop.

Defines backdrop settings.
Default White. Sets backdrop to white.
Color. Sets backdrop to a color. Clicking the color button opens the Color Wheel dialog box.

Gradient. Sets backdrop to a blend of colors. Clicking the color button opens the Backdrop
Gradient dialog box.

Note A gradient backdrop generates at the color depth of the current video driver.
Picture. Sets backdrop to a bitmap or metafile.

File. Lists selected picture's name. Clicking Browse opens the Import Graphic dialog box
where you can import a graphic or metafile.

Picture Options. Opens the Picture Options dialog box, where you can define how a bitmap
backdrop is displayed in the scene.




Step by step

Adding a backdrop

Modifying a backdrop
Commands

Backdrop Gradient (dialog box)
Color Wheel (dialog box)
Import Graphic (dialog box)
Modify Name (dialog box)
Picture Options (dialog box)
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Backdrop Gradient (dialog box)

Scene menu / Modify Backdrop / Gradient

-y

Defines a gradient to apply to the backdrop of a scene.

Option Description

follows:

4

Gradient Style Applies a gradient style as

Color Options Major Color/Minor Color. Displays gradient's primary or secondary color. Clicking the
color button opens the Color Wheel dialog box.

Blend. Creates a gradient that blends major and minor colors into each other.

Maximum Colors/Minimum Colors. Creates a multicolored gradient by blending the
colors on the Color Wheel between the major and minor colors, taking the longest path
(for Maximum Colors) or shortest path (for Minimum Colors) around the wheel.

Preview & Set Center Previews backdrop gradient. Clicking anywhere in area sets gradient's center. Clicking

and dragging in area sets gradient's direction, if it has one.



Step by step

Adding a backdrop

Modifying a backdrop
Commands

Color Wheel (dialog box)

Modify Backdrop
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Picture Options (dialog box)

Scene menu / Modify Backdrop / Picture Options

Defines how a bitmap backdrop is displayed in the scene, and whether it has a border color.

Option

Description

Size Options

Border Color

Defines how a bitmap backdrop is displayed in the scene, based on the image size settings
you choose in the Snapshot & Animation Settings dialog box.

Center Picture In Scene. Centers the picture in the scene. The color of the area surrounding
the picture is determined by the solid color selected for the backdrop.

Stretch Picture To Snapshot Size. Resizes the bitmap backdrop.

Stretch Picture Proportionally. Resizes the bitmap backdrop, but maintains its height to width
ratio.

Stretch Snapshot To Picture Size. Adjusts the image size to the bitmap's original size.
Defines backdrop border color.
Default White. Sets backdrop border to white.

Color. Sets backdrop border to a color. Clicking the color button opens the Color Wheel
dialog box, where you can select a color to apply.




Step by step

Adding a backdrop

Modifying a backdrop
Commands

Import Graphic (dialog box)
Modify Backdrop
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Modify Lights

Scene menu

Modifies a light defined for the scene.

Option

Description

Light Name(s)

Settings

Preview & Set Light Direction

Lists lights that can be modified.

Modify. Opens the Modify Name dialog box, in which you can modify both the
light's name and description.

Intensity. Sets amount of white and black in the light. Enter a value, or adjust the
slider.

Color. Displays light's color. Clicking the color button opens the Color Wheel
dialog box.

Light Casts Shadows. Enables light to cast shadows in a snapshot or animation, if
either Realistic w/Shadows or Ray Traced w/Shadows is specified in the Snapshot
& Animation Settings dialog box.

Note As Asymetrix 3D F/X generates a scene with shadows, the progress
indicator tracks the calculation of shadows for each light in the scene.

Displays light's direction. Click in preview area to reset direction.

Show All Lights. When clicked, briefly displays the combined effect of all lights in
scene.




Step by step

About creating 3D graphics with Asymetrix 3D F/X
Adding lights

Including only a model's shadow in a scene
Modifying a light

Command

Modify Name (dialog box)
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Modify Soundtrack

Scene menu

Adds a wave audio (.WAV) file you select to accompany an animation.

Option Description

File Name Lists all files in the current default directory with the default file extension for the selected file
format. A file selected from this list replaces the contents of the File Name box.

List Files Of Type Indicates .WAV is the default file extension.

Directories Displays the default path. Change the directory by selecting a new path from the Directories
box, which lists all directories available on the current drive. To change the drive, make a
selection in the Drives box.

Drives Lists the available drives. Selecting a new drive changes the contents of the Directories box.
Network Available if your system is connected to a network. Opens the Network dialog box from which

you can choose additional drives and directories.



Step by step

Adding a soundtrack to an animation
Commands

Generate Animation

Modify Name (dialog box)
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Preview Snapshot

Scene menu

Toolbar:

)

1
Changes cursorto 1. Select an area of the scene in the Scene Preview window with the cursor to preview it.




Step by step

About Asymetrix 3D F/X

Generating a snapshot

Previewing a snapshot

Command

Generate Snapshot
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Preview Animation

Scene menu

Previews the animation paths of all models in the scene at actual speed, dropping frames if they can't be
generated quickly enough to display.




Step by step

About animation in Asymetrix 3D F/X
Generating an animation

Previewing an animation
Commands

Animation Palette

Generate Animation

Preview All Frames
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Preview All Frames

Scene menu

"

Previews all frames of the animation paths of all models in the scene, slowing down if necessary to play each
frame.




Step by step

About animation in Asymetrix 3D F/X
Generating an animation

Previewing an animation
Commands

Animation Palette

Generate Animation

Preview Animation
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Generate Snapshot

Scene menu

Keyboard: F3

Toolbar:

Specifies how to generate a snapshot of the scene or a frame of animation, and where to create the snapshot (in
the Snapshot window or to a file).

Option

Description

Style

Snapshot Image Statistics

Generate Image Of

Destination

Sets generating detail for the snapshot.
Wireframes. Draws wireframe models; fastest generating method.

Note If you choose Wireframes, your snapshot will generate at the color depth of
your video driver.

Solid Models. Draws solid models using rough approximations of shading; slower
generating method.

Note If you choose Solid Models, your snapshot will generate at the color depth of
your video driver. If you select the Solid Model generating style, you cannot
generate a snapshot larger than your screen.

Realistic. Draws solid models using realistic shading.

Realistic w/Shadows. Draws solid models, using realistic shading and shadows.
Ray Traced. Draws solid models using realistic shading and reflections; excellent
quality.

Ray Traced w/Shadows. Draws solid models using realistic shading, reflections, and
shadows; excellent quality.

Displays snapshot's width, height, color depth, dithering, and smoothing options as
defined in the Snapshot & Animation Settings dialog box.

Snapshot Settings. Opens the Snapshot & Animation Settings dialog box.

Defines what is included in the snapshot.

Current Scene. Generates a snapshot of the current scene.

Single Frame Of Animation. Generates a snapshot of a specified frame of all model
animations in the scene.

Specifies where to generate a snapshot.

Display In Window. Generates the snapshot in a Snapshot window. Does not
automatically save the snapshot.

Generate Directly To File. Saves the snapshot directly to a file, generating the
snapshot in a minimized Snapshot window.

Note To generate snapshots larger than 4092 pixels wide when your color depth is 8
bits per pixel, 2046 pixels when your color depth is 16 bits per pixel, or 1364 pixels
when your color depth is 24 bits per pixel, you must generate to file.

File. Lists selected file name to generate snapshot to. Clicking Browse opens the
Save As dialog box where you can select a location in which to save a snapshot.




Step by step

Generating a snapshot

Commands

Generate Animation

Options

Save As

Snapshot & Animation Settings
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Generate Animation

Scene menu

Keyboard: Ctrl+F3

Specifies how to generate an animation (.AVI file) of a scene, and where to save the animation.

Option Description

Style Sets generating detail for the animation.

‘ Wireframes: draws wireframe models; fastest generating method.
Note If you choose Wireframes, your animation will generate at the color depth of your video driver.

Solid Models: draws solid models using rough approximations of shading; slower
generating method.

Note If you choose Solid Models, your animation will generate at the color depth of your video
driver.

Realistic: draws solid models using realistic shading.

Realistic w/Shadows: draws solid models, using realistic shading and shadows.

Ray Traced: draws solid models using realistic shading and reflections; excellent quality.

Ray Traced w/Shadows: draws solid models using realistic shading, reflections, and
shadows; excellent quality.

Animation Statistics Displays animation's width, height, color depth, dithering, smoothing, and frames per
second options as defined in the Snapshot & Animation Settings dialog box, as well as the
total time to complete all the scene's animation paths.

Animation Settings. Opens the Snapshot & Animation Settings dialog box.

Compression Displays video compression system used for animation.
Change. Opens the Video Compression dialog box where you can set how a file is
compressed.

Repeat Frames Defines whether to add copies of the first and last frames to the generated .AVI file, or skip

frames at the beginning, end, or beginning and end of an animation.

First. If you enter a positive number, specifies number of copies of the first frame to add to
beginning of file. If you enter a negative number, specifies the number of frames to skip
from the beginning of the animation before generating.

Last. If you enter a positive number, specifies number of copies of the last frame to add to
end of file. If you enter a negative number, specifies the number of frames to skip from the
end of the animation before generating.

Output File Specifies where to generate animation. Entering a bitmap file name makes Asymetrix 3D
F/X generate an animation as a sequence of bitmaps.
File. Lists selected file name to generate animation to. Clicking Browse opens the Save As
dialog box where you can select a location in which to save the .AVI file.

Max Size. Estimates the file size of the uncompressed animation.







Step by step

About animation in Asymetrix 3D F/X
Generating an animation
Commands

Generate Snapshot

Options

Save As

Snapshot & Animation Settings
Video Compression (dialog box)
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Video Compression (dialog box)

Scene menu / Generate Animation / Change

Specifies which compression method to use in creating an .AVI file of animation paths in a scene.

Option Description

Compressor Lists types of compressors available on your system.

Compression Quality  Adjusts compression quality. May not be available for all drivers.

Key Frame Every Defines how often compressor stores a frame to use as a base point for displaying
intermediate frames.

Data Rate Defines how fast the .AVI file transfers information.

Configure Displays additional configuration options for a specific compressor, if available.




Step by step

About animation in Asymetrix 3D F/X

Generating an animation

Command

Generate Animation
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Windows menu



Arrange Main Windows

Window menu

"

Tiles the Scene Preview window, Scene Contents window, and Catalog, then minimizes any open Snapshot or
Animation windows.



Step by step

About Asymetrix 3D F/X
Commands

Arrange Icons

Cascade

Tile Horizontally
Tile Vertically



Tile Horizontally

Window menu

"

Tiles all open Asymetrix 3D F/X windows horizontally, giving each window an equal amount of screen area.



Step by step

About Asymetrix 3D F/X
Commands

Arrange Icons

Arrange Main Windows
Cascade

Tile Vertically



Tile Vertically

Window menu

"

Tiles all open Asymetrix 3D F/X windows vertically, giving each window an equal amount of screen area.



Step by step

About Asymetrix 3D F/X
Commands

Arrange Icons

Arrange Main Windows
Cascade

Tile Horizontally



Cascade

Window menu

"

Tiles all open Asymetrix 3D F/X windows so that they overlap in a cascading pattern.



Step by step
About Asymetrix 3D F/X
Commands

Arrange Icons

Arrange Main Windows
Tile Horizontally

Tile Vertically



Arrange Icons

Window menu

"

Arranges all minimized Asymetrix 3D F/X window icons along the bottom of the main Asymetrix 3D F/X window.



Step by step

About Asymetrix 3D F/X
Commands

Arrange Main Windows
Cascade

Tile Horizontally

Tile Vertically



1 <Window Name>

Window menu

"

Makes the selected open Asymetrix 3D F/X window active. Open windows can include: Scene Preview, Scene

Contents, Snapshot windows, Animation windows, and Catalogs.



Step by step

About Asymetrix 3D F/X
Commands

Arrange Icons

Arrange Main Windows
Cascade

Tile Horizontally

Tile Vertically



Help menu



Contents

Help menu

"

Opens the online Help Contents screen.



Commands

About Asymetrix 3D F/X
Asymetrix 3D F/X Help Contents
Examples

Search For Help On

Startup Assistant

Technical Support
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Search For Help On

Help menu

"

Opens the online Help Search dialog box.



Commands

About Asymetrix 3D F/X
Contents

Examples

Startup Assistant

Technical Support
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Startup Assistant

Help menu

"

Opens the Asymetrix 3D F/X Startup Assistant, a quick online introduction to Asymetrix 3D F/X.



Commands

About Asymetrix 3D F/X
Contents

Examples

Search For Help On

Technical Support

Asymetrix 3D F/X User Manual
"Welcome"



Examples

Help menu

"

Opens example snapshots and animations created using Asymetrix 3D F/X.



Step by step

Eight ball snapshot example
Helicopter and moving background animation example
Patterned ring snapshot example
Switching text animation example
Water molecule animation example
Commands

About Asymetrix 3D F/X

Contents

Examples Contents

Search For Help On

Startup Assistant

Technical Support
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Technical Support

Help menu

"

Opens the online Help topic on Technical Support for Asymetrix 3D F/X.



Step by step

Calling Technical Support
Technical Support Contents
Using America Online

Using CompuServe

Using Internet

Using the Asymetrix Bulletin Board System (BBS)
Commands

Contents

Examples

Search For Help On

Startup Assistant
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System Info

Help menu

Displays information about your system configuration.

Option

Description

Display Information

System Status

Multimedia Drivers

Provides information about your system's display capability.

Video Driver. Lists your default video driver file, if available.

Driver Name. Lists name of your default video driver, if available.

Driver Version. Lists version of your default video driver, if available.
Display Resolution. Lists current screen resolution.

Display Colors. Lists number of currently available colors.

Logical Pixel Size. Lists how many logical units are defined per pixel.
Processor. Displays type of processor in system.

Mode. Displays whether system is running in enhanced or normal mode.
Math co-processor. Displays whether system includes a co-processor.

Free memory. Displays currently available virtual memory (includes both physical memory
and 386 swap file for Enhanced mode).

User memory. Displays percentage of allocated space free for the Windows USER
function.

GDI memory. Displays percentage of allocated space free for the Windows GDI function
Windows directory. Displays location of Windows directory.

TEMP directory. Displays location of Windows temp directory.

Drives. Lists each drive on the system or network, and space available on each.

Lists all available multimedia drivers installed on the system.
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About Asymetrix 3D F/X

Help menu

"

Displays the version number and Asymetrix 3D F/X copyright information.
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Rlght-click menus



Paths (right-click menu)

<&

Provides access to frequently used commands for modifying an animation path.
Click a button or command name below to see its description.

BEIREIE
Modify Animation
Moc.j_if_;g. Name (dialog box)




Step by step

About animation in Asymetrix 3D F/X

Adding a soundtrack to an animation
Animating a model

Animating sub-parts of a model

Generating an animation

Modifying a model's animation path

Modifying a model's animation path sequence
Playing a linked or embedded animation
Previewing an animation

Printing a frame of an animation

Staggering when models enter a scene
Commands

Copy

u

@)

uplicate

aste
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Backdrop (right-click menu)

<&

Provides access to frequently used commands for modifying a backdrop.
Click a button or command name below to see its description.

BEEEIE

Modify Backdrop
Modify Name (dialog box)




Step by step

About Asymetrix 3D F/X
Adding a backdrop
Modifying a backdrop
Commands

Copy
u

@)

uplicate

aste
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Scene Contents (right-click menu)
Provides access to commands for modifying the Scene Contents window.
Click a button or command name below to see its description.

BEEEIE

Select Font

@




Step by step

About the Scene Contents window
Commands

Copy

Cut

Duplicate

Paste
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Select Font

Scene Contents (right-click menu)

Allows you to select a font for the text in the Scene Contents window.

Option Description

Font Sets the font of the Scene Contents window text from the fonts available on your system.
Font Style Sets the font style.

Size Sets the font size.

Sample Displays an example of the selected font style and size.




Step by step

About the Scene Contents window
Commands

Scene Contents Window (right-click menu)
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Lights (right-click menu)

<&

Provides access to frequently used commands for modifying lights.
Click a button or command name below to see its description.

PEREIE

Modify Lights

Modify Name (dialog box)
Create Ambient Light
Crea’ge Directional Light




Step by step

About creating 3D graphics with Asymetrix 3D F/X
Adding lights

Modifying a light

Commands

Copy
u

@)

uplicate

aste
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Create Ambient Light

Lights (right-click menu)

Yy

Creates a light that brightens every surface of a model in a scene. Lights are always positioned outside the scene.




Step by step

About creating 3D graphics with Asymetrix 3D F/X
Adding lights

Modifying a light

Command

Modify Lights
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Create Directional Light
LigI]_t_s__ (right-click menu)

Yy

Creates a light that brightens the surface of a model based on whether the surface faces toward or away from the
light. Lights are always positioned outside the scene.




Step by step

About creating 3D graphics with Asymetrix 3D F/X
Adding lights

Modifying a light

Command

Modify Lights
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Picture Model (right-click menu)

oy

Provides access to frequently used commands for modifying picture models.
Click a button or command name below to see its description.

& B2 B2
Modify 3D

Modify Name (dialog box)
Modify Surface & Color
Modify Animation



Step by step

About text and picture models
Creating a picture model
Commands

Copy

Cut

Duplicate

Paste
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Scene (right-click menu)

Provides access to frequently used commands for modifying a scene.

Click a button or command name below to see its description.

% [=]al=][2]
Snapshot & Animation Settings
Modify Name (dialog box)
Modify Backdrop

Modify Lights

Modify Soundtrack

Generate Snapshot

Generate Animation

Print

Preview Full Size




Step by step

About Asymetrix 3D F/X
Generating a snapshot
Modifying a backdrop
Printing a scene or snapshot
Commands

Copy

Cut

Duplicate

On Camera Area submenu
Paste
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Catalog Scene (right-click menu)
Provides access to frequently used commands for modifying a scene in a Catalog.
Click a button or command name below to see its description.

BEEEIE

Snapshot & Animation Settings
Modify Name (dialog box)
Modify Backdrop

Modify Lights




Step by step

About Asymetrix 3D F/X
Generating a snapshot
Modifying a backdrop
Printing a scene or snapshot
Commands

Copy

Cut

Duplicate

Generate Snapshot
On Camera Area submenu

Paste
Preview Full Size
Print
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Preview Full Size

Scene (right-click menu)

"

Resizes scene to Image Size set in Snapshot & Animation Settings dialog box.



Step by step

About Asymetrix 3D F/X
Commands

On Camera Area submenu
Scene (right-click menu)
Snapshot & Animation Settings
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Simple Model: Ring (right-click menu)

<&

Provides access to frequently used commands for modifying a simple model based on a ring shape.
Click a button or command name below to see its description.

PREBEREIE
Modify Model

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp




Step by step

About simple models

Adding a preset model

Modifying a simple model's shape
Commands

Copy
u

@)

uplicate

aste
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Simple Model: Cube (right-click menu)

<&

Provides access to frequently used commands for modifying a simple model based on a cube shape.
Click a button or command name below to see its description.

PREBEREIE
Modify Model

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp




Step by step

About simple models

Adding a preset model

Modifying a simple model's shape
Commands

Copy
u

@)

uplicate

aste
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Simple Model: Cylinder (right-click menu)

<&

Provides access to frequently used commands for modifying a simple model based on a cylinder shape.
Click a button or command name below to see its description.

PREBEREIE
Modify Model

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp




Step by step

About simple models

Adding a preset model

Modifying a simple model's shape
Commands

Copy
u

@)

uplicate

aste
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Simple Model: Sphere (right-click menu)

"

Provides access to frequently used commands for modifying a simple model based on a sphere shape.
Click a button or command name below to see its description.

Modify Model

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp

"



Step by step

About simple models

Adding a preset model

Modifying a simple model's shape
Commands

Copy
u

@)

uplicate

aste

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"

{




Model (right-click menu)

&

Provides access to frequently used commands for modifying an imported model.
Click a button or command name below to see its description.

Modify Model

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp

"



Step by step

About imported models
Importing a model

Commands

Copy

Cut

Duplicate

Paste
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Snapshot (right-click menu)

&

Provides access to frequently used commands for modifying a snapshot.
Click a button or command name below to see its description.

Convert Snapshot
Print

"



Step by step

About Asymetrix 3D F/X

About color in Asymetrix 3D F/X

About color palette shift

Changing a snapshot's color depth or size
Generating a snapshot

Commands

g
< 1©

Lut
Duplicate
Paste
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Soundtrack (right-click menu)

@

Provides access to frequently used commands for modifying a scene's soundtrack.

Click a button or command name below to see its description.

Modify Soundtrack



Step by step
About animation in Asymetrix 3D F/X
Adding a soundtrack to an animation
Animating a model
Animating sub-parts of a model
Generating an animation
Modifying a model's animation path
Modifying a model's animation path sequence
Playing a linked or embedded animation
Previewing an animation
Printing a frame of an animation
Staggering when models enter a scene
Commands
Copy

ut
Duplicate
Modify Animation
Paste
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Sub-part (right-click menu)

Provides access to frequently used commands for modifying the sub-parts of a model.

Click a button or command name below to see its description.

Modify 3D

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp

"



Step by step

About imported models

About text and picture models

Making a model a sub-part of another model
Commands

Copy
u

@)

uplicate

aste
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Surface (right-click menu)

"

Provides access to frequently used commands for modifying a surface.

Click a button or command name below to see its description.

Modify Surface & Color
Modify Name (dialog box)



Step by step

About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Creating a "glass"™ surface

Creating models that appear to be lights
Making a color surface appear transparent
Making a scene and backdrop appear smoky
Making a scene and backdrop appear snowy
Making a solid material surface transparent
Making a surface reflect a bitmap

Making a surface reflective

Making all models in a scene reflect a bitmap
Modifying a model's surface

Submerging a model in "water"

Commands

Copy

Cut

Duplicate
Paste
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Text Model (right-click menu)

&

Provides access to frequently used commands for modifying text models.
Click a button or command name below to see its description.

Modify Text Model

Modify Name (dialog box)
Modify 3D

Modify Surface & Color
Modify Animation

Modify Warp

"



Step by step

About text and picture models
Creating a text model
Commands

Copy

Cut

Duplicate

Paste
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Letter Model (right-click menu)

&

Provides access to frequently used commands for modifying sub-parts of text models.
Click a button or command name below to see its description.

Modify 3D

Modify Name (dialog box)
Modify Surface & Color
Modify Animation

Mocjif;g Warp

"



Step by step

About text and picture models
Creating a text model
Commands

Copy

Cut

Duplicate

Paste
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Warp (right-click menu)

&

Provides access to frequently used commands for modifying a warp.
Click a button or command name below to see its description.

Modify Name (dialog box)
Modify Warp

"



Step by step
Warping a model
Commands
Copy

Cut

Duplicate
Paste
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Catalog (right-click menu)

&

Provides access to frequently used commands for modifying a Catalog.
Click a button or command name below to see its description.

Arrange Catalog Entries

"



Step by step
About the Scene Contents window
Adding a backdrop
Adding a preset model
Adding lights
Animating a model
Applying a surface to a model
Commands
Copy
ut
Duplicate
Modify Name (dialog box)
Modify Warp
Paste
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Cut

Removes the selected object and places it on the Windows Clipboard, replacing the previous Clipboard contents.
This command is dimmed on the menu if unavailable.



Copy

Places a copy of the selected object on the Windows Clipboard, replacing the previous Clipboard contents. This
command is dimmed on the menu if unavailable.



Paste

Pastes the contents of the Windows Clipboard into the active window. This command is dimmed on the menu if
unavailable.



Duplicate

Duplicates the selected object without using the Windows Clipboard. This command is dimmed on the menu if
unavailable.



Help

Provides help on this menu's commands.



Point & Click

<&

Keyboard: Shift+F1

Toolbar:

Changes the cursor to a question mark. Click any model with the question mark to open online Help for that
model.




Commands

About Asymetrix 3D F/X
Contents

Examples

Search For Help On

Startup Assistant

Asymetrix 3D F/X User Manual
"Welcome"






N

D (two-dimensional
3D (three-dimensional

>

add depth
animation
Animation palette

animation path
Animation window

ANSI characters
audio/video interleaved ((AVI)

backdrop

bump texture

Cc

camera perspective
Catalog

color depth

color palette
container application

D

dithering

drag and drop
E-F
embedded object

environment map
fog



generate
gradient
highlight

1-K
imported model
in-place editing

L-M
ight

linked object
mesh
metafile
models
move

N-O
hame

object linking and embedding (OLE)
OLE registration database

g

oY)

picture model
Position palette

Q-R
ray tracing

reflection map
refract

rotate

scale

scene

Scene Contents window
Scene Preview window
server application
shading

shadows

simple model

shapshot

Snapshot window
solid models

soundtrack
starter scene
sub-part
surface

swap file
T-V

text model
texture map
tracing
transparency
vector graphic




W-Z

warping
wireframes



2D (two-dimensional)
Having width and height only; a flat surface.



3D (three-dimensional)
Having (or seeming to have) depth, as well as width and height.



add depth

To create a 3D model from a 2D picture or text by adding a third dimension (depth).



animation

Series of frames in which changing bitmaps show motion over time. Animations are saved in audio/video interleaved
(-AVI) format.



Animation palette
Palette containing tools that play animations in the Scene Preview window.



animation path
A motion path (containing motion and direction) that you assign to a model to create an animation.



Animation window
Window in which animations of a scene are generated.



ANSI characters

Set of characters that contains the standard American keyboard characters, non-English letters, and symbols.



audiol/video interleaved (AVI)

Digital video format in which a series of audio and video frames are played in sequence (interleaved) to produce an
animation.



backdrop

Scene background. Can be a color, gradient, or bitmap.



bevel

Ornamental effect applied to the edges of a text or picture model, so that edges meet in a curve or flattened area
rather than at a 90-degree angle.



bitmap

Stored set of bits that defines each pixel in an image. Bitmaps have the file extension .BMP or .DIB.



boxes

View in the Scene Preview window in which the models are drawn as bounding boxes. This view is the fastest to
generate.



bump texture

Bitmap that can be applied to a surface, changing the reflection and shading to give the appearance of a bump or
ripple in the surface.



camera perspective

The representation of a scene as viewed through a camera lens. The perspective can be normal, wide angle, or
telephoto.



Catalog

Window that contains scene elements. Drag elements from the Catalog and drop them into the Scene Preview or
Scene Contents window to add them to a scene.



color depth

Number of bits that defines the color of each pixel in a file; a 2-color bitmap contains 1 bit per pixel; a 16-color bitmap
contains 4 bits per pixel; a 256-color bitmap contains 8 bits per pixel and so on.



color palette
Predefined set of colors stored in a palette file (.PAL).



container application
Application in which you can place objects from a server application. Asymetrix 3D F/X is not a container application.



dithering

Process of blending existing palette colors to approximate additional colors. To display a high-resolution color image
on a system that has fewer colors than the image, Windows dithers the existing palette colors.



drag and drop

Process of clicking an element in the Catalog, dragging it to the Scene Preview or Scene Contents window, and then
releasing the mouse button. You can also drag elements from the Scene Contents window into the Catalog.



embedded object
OLE object created in a server application that is stored as part of a container application file.
Compare linked object.



environment map

Bitmap that can be applied to a scene to create a simulated reflection off all reflective model surfaces. An
environment map is not a true mirror image.



fog

Effect that makes models appear to be behind a progressively thicker white screen the farther back in a scene they
appear. Fog does not affect backdrops.



frame

Still image from an animation file. A series of frames played in succession produces the illusion of movement, similar
to a film or videotape.



generate

To translate a 3D scene into a snapshot or animation (saved in bitmap or audio/video interleaved format,
respectively). Also known as render. Generating draws scenes in a higher resolution and more detail than is visible in
the Scene Preview window.

For a snapshot, generating translates the scene into a bitmap.
For an animation, generating combines models and animation paths.



gradient
Gradual blending of two or more fill colors.



highlight

Bright spot on the surface of a model caused by a light.



imported model

3D model file created in another program, then added to a scene. Asymetrix 3D F/X supports models that use the
Autodesk 3D Studio (.3DS) or AutoCAD (.DXF) format.



in-place editing
Technique that allows you to edit a linked or embedded scene without leaving the container application.



light
Effect that brightens models in a scene. Ambient light brightens every surface of models. Directional lights such as
Default Left Light, brighten based on whether the model surface faces toward or away from the light. Lights are
always positioned outside the scene.



linked object
Reference in a container application to an OLE object created in a server application and stored in a separate file.
Compare embedded object.



mesh
Sub-part of an imported model.



metafile

Image defined as a series of graphic objects (such as lines, squares or rectangles, and circles) instead of pixels (such
as a bitmap).



models
3D objects (clip art, pictures, and text) that create a scene.



move
Process of changing a model's position in 3D space.



name

Word or phrase that identifies a scene or any of its elements (model, surface, backdrop, light, warp, or animation
path) in the Scene Contents or Catalog window, and in the status bar when the element is selected.



object linking and embedding (OLE)

Technique for creating an object in one application (the server application), then incorporating it into a file from
another application (the container application). Asymetrix 3D F/X is a server application.



OLE registration database
List of OLE server applications maintained by Windows.



picture model

Model created from a bitmap (.BMP or .DIB) or vector graphic such as a metafile ((WMF). For bitmaps, Asymetrix 3D
F/X converts the image to black and white, then traces around the black to create a picture model. You can apply the
original bitmap to the face of the model as a surface. For metafiles, Asymetrix 3D F/X uses the information in the
source file to create a picture model.



Position palette
Palette containing tools that rotate, move, and scale models in the Scene Preview window.



ray tracing

Method of simulating light rays passing through a scene. Ray tracing results from a series of complex calculations,
and can be very slow.



reflection map

Bitmap that can be applied to a model to create a simulated reflection off a shiny surface. A reflection map is not a
true mirror image.



refract

To turn or bend light when it passes from one medium into another of different density. For example, light refracts
when it passes from air through glass.



rotate
To turn a model around an axis or center point.



scale
To reduce or increase a model's size.



scene

Elements contained in the Scene Preview or Scene Contents window, including all models (their attributes and
positions), surfaces, animation paths, lights, and the backdrop.



Scene Contents window

Window that lists all scene attributes such as backdrop, light, and soundtrack; and all models and their attributes,
such as surfaces and animation paths. To view details of an element in this window, double-click it.



Scene Preview window
Window in which you arrange, edit, and manipulate models to create a 3D scene.



server application

Application that creates objects that can be linked or embedded in a container application. Asymetrix 3D F/X is a
server application, not a container application.



shading

How colors on a surface vary, based on where light strikes the model's surface (creating a lighter color) and where
light does not strike the model's surface, or where the model's surface is in the shadows (creating a darker color).



shadows
Area in the scene where a light is blocked by models. Directional lights cast shadows; ambient lights do not.



simple model
Geometric model generated by Asymetrix 3D F/X, based on one of four shapes: sphere, ring, cube, or cylinder.



snapshot
Bitmap generated from the scene you create.



Snapshot window
Window in which snapshots of a scene are generated.



solid models

View in the Scene Preview window in which models are drawn as solids. This view displays all characteristics of
models, including their surfaces and shading, and is the slowest to generate.



soundtrack
Wave audio (.WAV) file saved as part of an animation.



starter scene
Scene in which models have already been placed and modified, which can be used as a template.



sub-part

Individual parts of a model, such as the letters of a text model, that can be modified independently of the model itself.



surface
Appearance of a model's exterior, such as gold or marble.



swap file

Space on a hard disk that Windows uses for virtual memory management. Effectively extends the amount of memory
available to a system.



text model
Model created from text.



texture map
Bitmap applied as a surface that simulates a texture or pattern, such as brick or leopard skin.



tracing

Process of creating a 3D picture model from a bitmap. Asymetrix 3D F/X converts the image to black and white, then
traces around the black to create a picture model.



transparency
State in which clear pixels in a bitmap allow objects and colors behind them to show through.



vector graphic

Graphic (such as a metafile, .WMF) stored as a set of instructions describing how to draw the graphic rather than as
a series of pixels (such as a bitmap).



warping
Process of bending or twisting models.



wireframes

View in the Scene Preview window in which models are drawn as wireframes. This view displays some 3D
characteristics of models, and generates quickly.



Map of screen elements

Click an area of the Asymetrix 3D F/X window that you'd like to know more about.
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‘ New

Creates a new scene or Catalog.



‘ Open

Opens an existing scene, Catalog, or snapshot.



‘ Save

Saves the active window (scene, snapshot, or Catalog) to a file.



‘ Cut

Removes the selected object and places it on the Windows Clipboard, replacing the previous Clipboard contents.



‘ Copy

Places a copy of the selected object on the Windows Clipboard, replacing the previous Clipboard contents.



‘ Paste

Pastes the contents of the Windows Clipboard into the active window.



‘ Undo

Reverses the effect of your most recent action.



‘ Position Palette

Displays and hides the Position palette used to rotate, move, and scale models.



‘ Animation Palette

Displays and hides the Animation palette used to preview models' animation paths.



‘ Catalog

Displays and hides the Catalog, a window that contains preset scene elements. You can drag elements from the
Catalog and drop them into the Scene Preview or Scene Contents window to add them to a scene.



‘ Scene Contents window

Displays and hides the Scene Contents window, which lists all scene attributes, and all models and their attributes.



‘ Create Text Model

Opens the Create Text Model dialog box.



‘ Create Picture Model

Opens the Create Picture Model dialog box.



‘ Generate Snapshot

Generates a snapshot of the scene, using the current snapshot and animation settings.



‘ Preview S_r_)_gpshot

Changes the cursor to ‘ with which you can select an area of the screen to preview as a snapshot.



‘ Boxes

Displays the models in the Scene Preview window as their bounding shapes.



‘ Wireframes

Displays the models in the Scene Preview window as wireframes.



‘ Solid Models

Displays the models in the Scene Preview window as solid objects.



‘ Point and Click Help

Changes cursor to “m with which you can click an element of Aysmetrix 3D F/X to get Help on it.



Scene Preview window
Window in which you arrange, edit, and manipulate models to create a 3D scene.



Scene Contents window

Window that lists all scene attributes such as backdrop, lights, and soundtrack; and all models and their attributes
such as surfaces, warps, and animation paths. To view details of an element's attributes, double-click it.



Scene
Represents the entire scene and all its sub-parts. Double-click the icon to collapse or expand the view of the scene's
elements, or double-click the text to open the Snapshot & Animation Settings dialog box.



Backdrop

Represents the scene's backdrop and its name. Double-click to modify the backdrop.



Soundtrack

Represents the soundtrack that will be included with the scene when it is generated as an animation, and the name of
the sound file. Double-click to select a file to use as a soundtrack.



Lights

Represents the group of lights included in the scene. Double-click the icon to view the individual lights in the group, or
double-click the text to modify the lights.



@ Picture

Represents a picture model. Double-click the icon to view the model's elements, or double-click the text to modify the
model.



Catalog

Window that contains scene elements. Drag elements from the Catalog and drop them into the Scene Preview or
Scene Contents window.



Toolbar

Displayed across the top of the Asymetrix 3D F/X main window. Provides fast mouse access to menu commands.

Can be converted into a floating palette by dragging away from the edge of the window. Can be displayed or hidden
by selecting Toolbar from the View menu.



Catalog status bar
Displays the currently selected element's description and name.



Main Window status bar

Provides help on the menu or toolbar command currently under the cursor and displays the time. While generating an
animation, displays the number of the frame being generated and the total number of frames to be generated.



Scene Preview window status bar

Displays the name of the selected model; or, after previewing a snapshot, displays how many lines were generated
for the preview; or, after resizing the Scene Preview window, displays the current size as a percentage of the final
snapshot size. Also displays the currently selected Position palette tool, and the current camera perspective.



Position palette
Palette that contains tools that rotate, move, and scale models in the Scene Preview window.



‘ Rotate

Changes the cursor to ‘ with which you can rotate a model.



‘ Move

Changes the cursor to ‘ with which you can move a model left, right, up, or down.



‘ Scale

Changes the cursor to ‘ with which you can scale (resize) a model.



‘ Expand

Expands the Position palette to display graphical and numerical positioning controls.



Animation palette
Palette containing tools that play animations in the Scene Preview window.



‘ Play

Previews the animation paths of all models in the scene at actual speed, dropping frames if they can't be generated
quickly enough.



‘ Play all

Previews the animation paths of all models in the scene, but does not play frames at actual speed.



‘ Pause

Stops or resumes playing a stopped animation from the current frame.



‘ Rewind

Returns to first frame of all animation paths.



‘ Back one frame

Backs up all animation paths one frame.



‘ Advance one frame

Advances all animation paths one frame.



‘ Advance to end

Advances to last frame of all animation paths.



Menu bar
Contains all Asymetrix 3D F/X commands.
To view the contents of a menu, do one of the following:

‘ Click the menu name with the mouse.

Press Alt+n (the underlined letter in the menu name).



Title bar

The area at the top of the Asymetrix 3D F/X window that indicates which window is currently active and the name of
the project file that is currently open.



Keyboard and mouse shortcuts
General shortcuts

Getting Help
Working with text
Moving a model
Rotating a model
Scaling a model
Working with models
Working with scenes



o

Getting Help
Keyboard and mouse shortcuts

Use the following keyboard and mouse shortcuts to get help.

For this type of Help Do this
List of Help topics Press F1.
? : .
on right-click toolbar.

Help on a specific element Right-click element, then click

Help on an interface element Click ‘ , then click an element; or press Shift+F1, then click an

element.



Working with text
Keyboard and mouse shortcuts
Use the following keyboard and mouse shortcuts to work with text in the Create Text Model dialog box.

To Do this

Select word Double-click in word

Extend text selection  Shift+arrow key

Select a range of text  Click at beginning of text, press Shift, click at end
Move insertion point ~ Press an arrow key

Move right one word  Press Ctrl+Right Arrow

Move left one word Press Ctrl+Left Arrow

Insert a line Ctrl+Enter




Moving a model

Keyboard and mouse shortcuts

You can move a model using the Position palette. To begin, either click the ‘ tool on the Position palette

or press F10 to activate the

‘ cursor.

To Using the keyboard Using the mouse

Move right Select the model, then hold Select the model, then
down the Right Arrow key drag mouse right

Move left Select the model, then hold Select the model, then
down the Left Arrow key drag mouse left

Move up Select the model, then hold Select the model, then
down the Up Arrow key drag mouse up

Move down Select the model, then hold Select the model, then

Move back in
3D space

Move closer
in 3D space

down the Down Arrow key

Select the model, then hold
down Shift+Right Arrow or
Shift+Up Arrow

Select the model, then hold
down Shift+Left Arrow or
Shift+Down Arrow

drag mouse down

Select the model, press
Shift, then drag mouse
right

Select the model, press
Shift, then drag mouse left




Rotating a model

Keyboard and mouse shortcuts

You can rotate a model using the Position palette. To begin, either click the ‘ tool on the Position palette
or press F9 to activate the

‘ cursor.

To

Using the keyboard

Using the mouse

Rotate clockwise
around vertical axis

Rotate
counterclockwise
around vertical axis

Rotate clockwise
around horizontal axis

Rotate
counterclockwise
around horizontal axis

Rotate clockwise
around depth axis

Rotate
counterclockwise
around depth axis

Constrain rotation to
around vertical axis
only

Constrain rotation to
around horizontal
axis only

Select the model, then hold
down the Right Arrow key

Select the model, then hold
down the Left Arrow key

Select the model, then hold
down the Up Arrow key
Select the model, then hold
down the Down Arrow key

Select the model, then hold
down Shift+Right Arrow or
Shift+Up Arrow

Select the model, then hold
down Shift+Left Arrow or
Shift+Down Arrow

Select the model, then
drag mouse right

Select the model, then
drag mouse left

Select the model, then
drag mouse up

Select the model, then
drag mouse down

Select the model,
press Shift, then drag
mouse right

Select the model,
press Shift, then drag
mouse left

Select the model,
press Ctrl, then drag
mouse right or left

Select the model,

press Ctrl, then drag
mouse up or down




Scaling a model

Keyboard and mouse shortcuts

You can scale a model using the Position palette. To begin, either click the ‘ tool on the Position palette
or press F11 to activate the

‘ cursor.

To

Using the keyboard

Using the mouse

Make entire

model smaller

Select the model, then hold
down Shift+Down Arrow key

Select the model, then drag
mouse left

Make entire Select the model, then hold Select the model, then drag
model larger down Shift+Up Arrow key mouse right

Scale width Select the model, then hold Select the model, press
smaller down the Right Arrow key Shift, then drag mouse left
Scale width Select the model, then hold Select the model, press
larger down the Left Arrow key Shift, then drag mouse right
Scale height Select the model, then hold Select the model, press Ctrl,
smaller down the Down Arrow key then drag mouse down
Scale height Select the model, then hold Select the model, press Cirl,
larger down the Up Arrow key then drag mouse up

Scale depth Select the model, then hold Select the model, press Ctrl,
smaller down Shift+Left Arrow then drag mouse left

Scale depth Select the model, then hold Select the model, press Ctrl,
larger down Shift+Right Arrow then drag mouse right




General shortcuts

Keyboard and mouse shortcuts

Use the following keyboard and mouse shortcuts to work in Asymetrix 3D F/X.

To Press
Open a scene, Catalog, or snapshot Ctrl+O
Print a scene, snapshot, or animation frame Ctrl+P
Save a scene, snapshot, or Catalog Ctrl+S
Undo or redo the last action Ctrl+Z
Display the Scene Contents window F2
Display the Position palette F8
Select the rotation tool on the Position palette F9
Select the move tool on the Position palette F10
Select the scale tool on the Position palette F11
Expand the Position palette F12
Toggle between graphical/numerical display Shift+F12
if the Position palette is expanded

Switch the focus from one window to the next Ctrl+F6

Exit Asymetrix 3D F/X Alt+F4



Working with models

Keyboard and mouse shortcuts

Use the following keyboard and mouse shortcuts to work with models.

To

Do this

Create a text model

Create a picture model

Select a single model

Select multiple models

Add to or remove from selection

Select all models in a scene
Modify a model

Expand a model in the Scene
Contents window

Select a sub-part of a model

Press Ctrl+T

Press Ctrl+M

Click the model

Shift+click the models

Shift+click each model you want to add
or remove

Press Ctrl+A

Double-click the model in the Scene
Preview window

Double-click the model in the Scene
Contents window

Click the sub-part in the Scene Contents
window




Working with scenes

Keyboard and mouse shortcuts

Use the following keyboard and mouse shortcuts to work with scenes.

To Press
Display or hide a scene's backdrop F4
Switch to Wide Angle camera perspective Shift+F5
Switch to Telephoto camera perspective Ctrl+F5
Switch to Normal camera perspective F5
Modify options F7
Modify snapshot and animation settings Shift+F3
Generate a snapshot F3
Generate an animation Ctrl+F3




Point & click topics



Scenes
Point & click

A scene is a collection of elements displayed in the Scene Preview or Scene Contents window. A scene includes
all models (their attributes and positions), surfaces, animation paths, lights, and the backdrop.

After you've created a scene, you can generate a snapshot or animation from it to use alone or incorporate into
other programs.

Scene concepts and step-by-step procedures

About Asymetrix 3D F/X

About camera perspective

About creating 3D graphics with Asymetrix 3D F/X
About editing scenes in a container application
About the Scene Contents window

Adding a backdrop

Adding a preset model

Adding lights

Building a scene

Generating a snapshot

Generating an animation

Modifying a backdrop

Modifying a light

Setting the camera perspective

Working in Asymetrix 3D F/X

Scene commands
Boxes
On Camera Area

Options

Print

Snapshot & Animation Settings
Snapshot (right-click menu)
Solid Models

Soundtrack (right-click menu)

Wireframes




Backdrop

Point & click

A backdrop is a scene's background, and can be white, a color, a bitmap, or a gradient. You can hide a scene's
backdrop to make a draft of the scene that generates more quickly, or display a scene's backdrop to see the scene
as it will finally appear.

Backdrop concepts and step-by-step procedures

About Asymetrix 3D F/X

About creating 3D graphics with Asymetrix 3D F/X
About the Scene Contents window

Adding a backdrop

Building a scene

Generating a snapshot

Generating an animation

Modifying a backdrop

Working in Asymetrix 3D F/X

Backdrop commands
Backdrop

Backdrop Gradient (dialog box)
Modify Backdrop



Soundtrack
Point & click

A soundtrack is a wave audio (.WAV) file saved as part of an animation.

Soundtrack concepts and step-by-step procedures
About animation in Asymetrix 3D F/X

Soundtrack command

Modify Soundtrack




Lights

Point & click

Lights are effects that brighten models in a scene. Ambient light brightens every surface of a model. Directional
light (such as Default Left Light) brightens based on whether the model's surface faces toward or away from the
light. Lights are always positioned outside the scene.

Light concepts and step-by-step procedures
About creating 3D graphics with Asymetrix 3D F/X

Light commands

Create Ambient Light
Create Directional Light
Modify Lights




Text model
Point & click

A text model is created from text. Asymetrix 3D F/X creates a text model by adding depth, or a third dimension, to
two-dimensional shapes.

Text model concepts and step-by-step procedures

About text and picture models

Creating a text model

Text model commands

Create Text Model

Modify 3D

Modify Text Model (dialog box)




Letter model
Point & click

A letter model is a sub-part of a text model. Asymetrix 3D F/X creates a text model by adding depth, or a third
dimension, to two-dimensional shapes.

Letter model concepts and step-by-step procedures
About text and picture models

Creating a text model

Letter model commands

Create Text Model

Modify 3D

Modify Lettter Model (dialog box)



Picture model
Point & click

A picture model is a model created from a graphic file such as a bitmap (.BMP or .DIB) or metafile (WMEF). To
create a picture model from a bitmap, Asymetrix 3D F/X converts the image to black and white, then traces around
the black. You can apply the original bitmap to the face of the model as a surface. To create a picture model from a
metafile, Asymetrix 3D F/X uses the information in the source file to create a 3D picture model.

Picture model concepts and step-by-step procedures
About text and picture models

Creating a picture model

Picture model commands

Create Picture Model

Modify 3D

Modify Picture Model (dialog box)



Imported model
Point & click

An imported model is a 3D model file created in another program, then added to a scene. Asymetrix 3D F/X
supports models created in Autodesk 3D Studio (.3DS) or AutoCAD (.DXF) format.

Imported model concepts and step-by-step procedures
About imported models

Importing a model

Imported model commands

Import Model
Imported Model Surface (dialog box




Simple model
Point & click

A simple model is a geometric model created by Asymetrix 3D F/X, based on one of four shapes: sphere, ring,
cube, or cylinder.

Simple model concepts and step-by-step procedures
About simple models

Adding a preset model

Simple model commands

Create Simple Model
Modify Cube

Modify Cylinder

Modify Ring (dialog box)
Modify Sphere (dialog box)



Sub-part

Point & click

A sub-part is an individual part of a model, such as a part of a picture model, that can be modified independently of
the model.

Sub-part concepts and step-by-step procedures
About the Scene Contents window
Making a model a sub-part of another model

Sub-part model commands
Modify Sub-part (dialog box)




Surface
Point & click

A model's surface is a thin layer, placed over the model's geometry. A surface can be a color, bitmap, or material.

Surface concepts and step-by-step procedures
About surfaces

Applying a surface to a model
Adding a texture to a model's surface

Making a surface reflect a bitmap
Making all models in a scene reflect a bitma

Modifying a model's surface
Surface command
Modify Surface & Color




Path

Point & click

An animation path is a motion path (containing motion and direction) that you assign to a model to create an
animation.

Path concepts and step-by-step procedures
About animation in Asymetrix 3D F/X

Adding a soundtrack to an animation
Animating a model

Animating sub-parts of a model

Generating an animation

Modifying a model's animation path

Modifying a model's animation path sequence
Playing a linked or embedded animation
Previewing an animation

Printing a frame of an animation

Staggering when models enter a scene

Path commands
Animation Palette
Generate Animation

Modify Animation
Preview All Frames

Preview Animation




Warp

Point & click

Warping is the process of bending or twisting a model.

Warp step-by-step procedure
Warping a model

Warp command

Modify Warp



Scene Contents window
Point & click

The Scene Contents window lists all scene attributes, such as the backdrop, lights, and soundtrack; and all
models and their attributes, such as surfaces, warps, and animation paths.

Scene Contents window concepts and step-by-step procedures

About Asymetrix 3D F/X
About the Scene Contents window

Selecting models

Scene Contents window command
Scene Contents



Scene Preview window
Point & click

The Scene Preview window is where you arrange, edit, and manipulate models to create a 3D scene.

Scene Preview window concepts and step-by-step procedures
About Asymetrix 3D F/X

About creating 3D graphics with Asymetrix 3D F/X

About the Scene Contents window

Selecting models




Catalog

Point & click

The Catalog is the window that contains preset scene elements. You can drag elements from the Catalog and drop
them into the Scene Preview or Scene Contents window to add them to a scene.

Catalog concepts and step-by-step procedures
About Asymetrix 3D F/X

Selecting models

Catalog commands

Arrange Catalog Entries
Catalog



Snapshot window
Point & click

The Snapshot window is the window in which Asymetrix 3D F/X generates a snapshot.

Snapshot window concepts and step-by-step procedures
About Asymetrix 3D F/X

About camera perspective

About color in Asymetrix 3D F/X

About color palette shift

About creating 3D graphics with Asymetrix 3D F/X

Generating a snapshot

Previewing a snapshot

Printing a scene or snapshot

Snapshot window commands

Convert Snapshot
Generate Snapshot
Preview Snapshot




Animation window
Point & click

The Animation window is the window in which Asymetrix 3D F/X generates an animation.

Animation window concepts and step-by-step procedures
About Asymetrix 3D F/X

About camera perspective

About color in Asymetrix 3D F/X

About color palette shift

About creating 3D graphics with Asymetrix 3D F/X
Generating an animation

Previewing an animation

Printing a frame of an animation

Animation window commands

Generate Animation

Preview All Frames

Preview Animation




Technical Support

Help menu

You can receive Asymetrix Technical Support in a variety of ways. Click a topic below for step-by-step instructions
about Technical Support.

Calling Technical Support

Using America Online

Using CompuServe

Using Internet

Using the Asymetrix Bulletin Board System (BBS)



Calling Technical Support

Step by step

oy

Registered Asymetrix 3D F/X users receive complimentary technical support. If you leave a message or fax before
or after business hours, a technical support representative will respond to your inquiry within two business days
(Monday through Friday).

Use the following Asymetrix technical support telephone numbers as needed for your location.
Australia/Asia Pacific

‘ Infotainment Asia Pacific Pty Ltd.

(61+3) 5255-471 (direct) 9 a.m. to 6 p.m. Eastern Standard Time
(61+3) 5255-482 (fax)

‘ XLTECH Pty Ltd.

~ —

(61+2) 9752-111 (direct) 9 a.m. to 6 p.m. Eastern Standard Time
(61+2) 9752-167 (fax)
Europe (except France, Germany, and United Kingdom); Middle East; Africa;
Russia
+44 923-208-433 9:00 to 17:00 GMT
France

05-90-83-19 (freephone) 9:00 to 17:00 GMT

Germany
01-30-81-27-07 (freephone)  9:00 to 17:00 GMT

United Kingdom
0800-716-957 (freephone) 9:00 to 17:00 GMT

U.S.A. and rest of world
206-637-1600 (direct) 6 a.m. to 6 p.m. Pacific time Monday through Thursday; 6
206-454-0672 (fax) a.m. to 3 p.m. Friday

When you call Technical Support, please be at your computer with your Asymetrix 3D F/X User Manual, and have
the following information:

Your Asymetrix 3D F/X serial number (found on the first installation disk, your license agreement
envelope, or your Asymetrix 3D F/X product box)

The version of Asymetrix 3D F/X you are running

Your system configuration information (you can find this information by choosing System Info from
the Help menu, or by double-clicking the System Info icon in the Asymetrix 3D F/X program group, located in the
Program Manager; or by double-clicking Windows Setup, located in the Program Manager in the Main group)

"

The exact wording of any error message you have encountered



What happened and what you were doing when the problem occurred

How you tried to solve the problem



Step by step

Using America Online

Using CompuServe

Using Internet

Using the Asymetrix Bulletin Board System (BBS)



Using the Asymetrix Bulletin Board System (BBS)

Step by step

-y

You can receive online technical support on the Asymetrix Bulletin Board System (BBS) by leaving a message for
the Asymetrix System Operator. The System Operator checks the BBS daily for new messages and answers them
within two business days (Monday through Friday). To help the System Operator answer your question, gather
information about your system.

The data configuration for the BBS is: no parity, 8 data bits, 1 stop bit.

To gather system configuration information for the System Operator:

1 From the Help menu, choose System Info. If you cannot run Asymetrix 3D F/X, double-click the System Info
icon in the Asymetrix 3D F/X program group, located in the Program Manager.

2 Copy down all the information listed in the System Status box.

To connect to the Asymetrix Bulletin Board System:
1 Call the Asymetrix BBS number:

If you have a 1200 to 14,400 baud modem (v.32bis), call (206) 451-1173.

.8

If you have a 9600 to 14,400 baud modem (v.32bis), call (206) 451-8290.
2 Enter your first and last names at the prompts.

If you are a new BBS user and you see a welcome message, there is probably another user with the same

name. Hang up the phone, redial, and use a different name, such as "Jim" instead of "James," or include your

middle initial.

Enter your password, then retype it to confirm its spelling.

4 If you are a new user, complete the new user questionnaire.
Make sure you have your Asymetrix 3D F/X serial number (found on the first installation disk, your license
agreement envelope, or your Asymetrix 3D F/X product box). You will be asked about your software and
hardware. Where applicable, it is recommended that you accept the defaults.

5 To leave a message for the System Operator, type C for "Comments to the sysop," then leave a message
containing the following information:

w

All the information gathered about your system configuration

The version of DOS you are running

The version of Windows you are running

The version of Asymetrix 3D F/X you are running

The exact wording of any error message you have encountered

What happened and what you were doing when the problem occurred

Ty

How you tried to solve the problem



6 To log off the BBS, type G for "Goodbye," then type Y to confirm.

Tip At any time, you can type "?" to get online command help. If you have any problems or difficulties with the
Asymetrix BBS, leave a message for the BBS System Operator or call the Asymetrix Technical Support line at
(206) 637-1600.



Step by step

Calling Technical Support
Using America Online
Using CompuServe
Using Internet



Using CompuServe
Step__t_)_y step

"

If you are a CompuServe member, you can receive online technical support by leaving a message for the
Asymetrix Forum Moderator. The Forum Moderator checks CompuServe daily for new messages and answers
them within two business days (Monday through Friday). To help the Forum Moderator answer your question,
gather information about your system.

To gather system configuration information for the Forum Moderator:

1 From the Help menu, choose System Info. If you cannot run Asymetrix 3D F/X, double-click the System Info
icon in the Asymetrix 3D F/X program group, located in the Program Manager.

2 Copy down all the information listed in the System Status box.

Refer to your CompuServe documentation for step-by-step instructions for logging onto CompuServe, leaving
messages for the Forum Moderator, and logging off CompuServe.

To connect to CompuServe:

1 Log on to CompuServe.

2 To connect to

"

Windows Third Party Developer A forum, Section 1, type GO ASYMETRIX or GO WINAPA at the
prompt.

Multimedia Vendors forum, Section 15, type GO MULTIVEN at the prompt.

b

IBM Ultimedia Tools A forum, Section 5, type GO ULTIATOOLS at the prompt.
3 In the Asymetrix section (Section 1), leave a message for the Forum Moderator containing the following
information:

All the information gathered about your system configuration

Your Asymetrix 3D F/X serial number (found on the first installation disk, your license agreement
envelope, or your Asymetrix 3D F/X product box)

The version of DOS you are running
The version of Windows you are running
The version of Asymetrix 3D F/X you are running

The exact wording of any error message you have encountered

SOBb B

What happened and what you were doing when the problem occurred



‘ How you tried to solve the problem

4 Log off CompuServe.



Step by step

Calling Technical Support

Using America Online

Using Internet

Using the Asymetrix Bulletin Board System (BBS)



Using America Online
Step__t_)_y step

"

If you are an America Online member, you can receive online technical support by leaving a message for the
Asymetrix Forum Moderator. The Forum Moderator checks America Online daily for new messages and answers
them within two business days (Monday through Friday). To help the Forum Moderator answer your question,
gather information about your system.

Note America Online operates a text telephone (TDD) for deaf or hearing-impaired members.

To gather system configuration information for the Forum Moderator:

1 From the Help menu, choose System Info. If you cannot run Asymetrix 3D F/X, double-click the System Info
icon in the Asymetrix 3D F/X program group, located in the Program Manager.

2 Copy down all the information listed in the System Status box.

Refer to your America Online documentation for step-by-step instructions for logging onto America Online, leaving
messages for the Forum Moderator, and logging off America Online.

To connect to America Online:
1 Log on to America Online.
2 Do one of the following:

From the Go To menu, select Keyword, then type Asymetrix.

58

Go to the Computing and Software area, select Industry Connection, then select Asymetrix.
3 Leave a message for the Forum Moderator containing the following information:

All the information gathered about your system configuration

58

Your Asymetrix 3D F/X serial number (found on the first installation disk, your license agreement
envelope, or your Asymetrix 3D F/X product box)

The version of DOS you are running

The version of Windows you are running

The version of Asymetrix 3D F/X you are running

The exact wording of any error message you have encountered

What happened and what you were doing when the problem occurred

BOBBBE

How you tried to solve the problem
4 Log off America Online.

Tip You can receive the software required to use America Online at no cost, plus five complimentary hours of



online time. For details about America Online, call (800) 827-6364 or (703) 893-6288.



Step by step

Calling Technical Support

Using CompuServe

Using Internet

Using the Asymetrix Bulletin Board System (BBS)



Using Internet
Step__ by step

"

If you have access to Internet mail, you can receive online technical support by leaving a message for the
Asymetrix Forum Moderator. The Forum Moderator checks Internet daily for new messages and answers them
within two business days (Monday through Friday). To help the Forum Moderator answer your question, gather
information about your system.

To gather system configuration information for the Forum Moderator:

1 From the Help menu, choose System Info. If you cannot run Asymetrix 3D F/X, double-click the System Info
icon in the Asymetrix 3D F/X program group, located in the Program Manager.

2 Copy down all the information listed in the System Status box.

Refer to your electronic mail documentation for step-by-step instructions about starting mail and sending
messages on Internet.

To access Internet:

1 Start your electronic mail application.

2 In the box where you enter the receiver's address, type support@asymetrix.com or
techsup@asymetrix.com.

3 Leave a message for the Forum Moderator containing the following information:

All the information gathered about your system configuration

58

Your Asymetrix 3D F/X serial number (found on the first installation disk, your license agreement
envelope, or your Asymetrix 3D F/X product box)

The version of DOS you are running

The version of Windows you are running

The version of Asymetrix 3D F/X you are running

The exact wording of any error message you have encountered

What happened and what you were doing when the problem occurred

BOBBBE

How you tried to solve the problem
4 Send your message.

3



Step by step

Calling Technical Support

Using America Online

Using CompuServe

Using the Asymetrix Bulletin Board System (BBS)



Working in Asymetrix 3D F/X

Step by step

oy

In the Scene Preview window you move 3D objects--called models--around the screen, rotate them to display
different sides, move them forward and backward in 3D space, and scale their size. You can use the Scene
Preview window to build a scene and arrange models in relationship to each other.

Asymetrix 3D F/X provides a comprehensive collection of models (including shapes and text) and 3D tools to
modify a scene. To use models and other scene elements stored in the Catalog, you drag them from the Catalog
and drop them into the Scene Preview or Scene Contents window.

To work in Asymetrix 3D F/X:

Add and create models.

Modify models by applying surfaces or arranging them in the scene.

Modify the scene by adding a backdrop, lights, or shadows.

To create an animation, add animation paths to a model.

From the File menu, choose Save to save the scene, then enter a file name in the Save As dialog box.
Generate a snapshot or animation of the scene.

Use the snapshot or animation:

LN O U AWN

‘ Import the snapshot or animation into another application. Or link or embed the scene.

‘ Print the scene or snapshot.



Step by step

About Asymetrix 3D F/X

About creating 3D graphics with Asymetrix 3D F/X
About the Scene Contents window
Adding a backdrop

Adding a preset model

Adding lights

Animating a model

Applying a surface to a model
Arranging a model in a scene

Creating a picture model

Creating a text model

Embedding or linking an existing scene
Generating a snapshot

Generating an animation

Importing a model

Printing a scene or snapshot
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Building a scene
Step__t_)_y step

"

To build a scene in the Scene Preview window, you can

.

begin with a starter scene and its models from the Catalog, then modify the models to create the
scene you want.

use an existing scene file as a template.

56

create a scene from scratch by dragging models from the Catalog and dropping them into the
Scene Preview or Scene Contents window.
To use a starter scene:

.

Click the Scenes tab in the Catalog, then drag a starter scene from the Catalog and drop it into the
Scene Preview or Scene Contents window.

To use an existing scene file as a template:

1 From the Tools menu, choose Options.

2 In the File tab, for At Startup, select Create New Scene.

3 Under New Scenes, select Use Scene File As Template, then click Browse.

4 Select a scene file to use as a template, click OK, and then click OK again to close the Options dialog box.

When you restart Asymetrix 3D F/X, the scene file opens as a template.

To create a scene from scratch:

Drag a preset model from the Catalog. Or add a simple model using the Models menu.

Create a text model.

Create a picture model from a graphic.

5555

Import a m .
To save a scene:

"

From the File menu, choose Save to save the scene, then enter a file name in the Save As dialog

o

0OX.

3



Step by step

About imported models
About simple models

About text and picture models
About the Scene Contents window
Adding a preset model
Creating a picture model
Creating a text model
Importing a model
Commands

Create Picture Model

Create Simple Model submenu
Create Text Model

Import Model

New

Options

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Adding a preset model

Step by step

"

You can add a preset model to a scene, then modify it to fit your needs.
To add a preset model to a scene:

"

Click the Models tab in the Catalog, then drag a model from the Catalog and drop it into the Scene
Preview or Scene Contents window.

"

From the Models menu, choose Create Simple Model, then select a model to add.
You can modify most models by selecting the model, then choosing Modify Model from the Models menu. For
details about a specific model's options, click the Help button in the Modify Model dialog box.



Step by step

About simple models

About the Scene Contents window
Modifying a simple model's shape
Commands

Catalog

Create Simple Model submenu
Modify Cube (dialog box)

Modify Cylinder (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Creating a text model
Step__ by step

oy

You can create a 3D model from text you format.
To create a model from text:

1 From the Models menu, choose Create Text Model, or click ‘ on the toolbar.

2 Replace the words Enter Text Here with the text you want. You can create additional lines of text by pressing
Shift+Enter.
3 Optional. To add special (ANSI) characters to your model, click Character Map.
4 Select your text, then use the toolbar options to format it.
5 For Font, select a font.
6 Optional. To check the spelling of your text, click Spelling.
7 Optional. To modify the model's 3D options, click Modify 3D.
8 Optional. To change the model's name, under Model Name, type a name, or click the Modify button to open
the Modify Name dialog box.
Note The model name is automatically set to the model's text when it is created.
9 Click OK to close the dialog box.




Step by step

About text and picture models
Adding a preset model

Creating a picture model
Importing a model

Commands

Spelling (dialog box

Create Text Model

Modify 3D

Modify Letter Model (dialog box)
Modify Name (dialog box)
Modify Text Model (dialog box)
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Creating a picture model
Step__ by step

You can create a 3D picture model from any bitmap or graphic file composed of polygons and lines (for example,
vector graphics such as metafiles) you can import or paste into Asymetrix 3D F/X. Asymetrix 3D F/X converts
bitmap images to black and white, then traces the black to create a model.

To create a picture model:

1 From the Models menu, choose Create Picture Model, or click ‘ on the toolbar.

2 To import a picture, click Browse, locate the file, and then click OK. Or to paste a picture from the Clipboard,
click Paste Graphic From Clipboard. Metafiles may appear distorted in the preview area, but will be imported without
distortion.

Note A scene that includes models created from a metafile may appear in the Scene Preview window to
include only a single large rectangular model. You may want to select and delete the large rectangular model so you
can view the other models created from the file.

3 Optional. For a bitmap, click Trace Options to open the Trace Options dialog box, where you can determine
how the bitmap will be converted to black and white, and how much detail will be traced.

4 Optional. To modify the model's 3D options, click Modify 3D.

5 Optional. To give the model a name, under Model Name, type a name, or click the Modify button to open the

Modify Name dialog box.
6 Click OK to close the dialog box.



Step by step

About text and picture models
Adding a preset model
Creating a text model
Importing a model
Commands

Create Picture Model

Import Graphic (dialog box)
Modify 3D

Modify Name (dialog box)

Modify Picture Model (dialog box)
Trace Options (dialog box)
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Applying a surface to a model
Ste!_a__ by step

Y

Each model has a default surface, which is the appearance of its exterior. You can give a model a different
appearance by applying a different surface.

Asymetrix 3D F/X applies the surface by wrapping it around the contours of the model or its sub-part (such as a
character in a word). Each time you apply a new surface, Asymetrix 3D F/X removes the old surface from the
model.

To apply a surface to a model:

1 Click the Surfaces tab in the Catalog.

2 Drag a surface from the Catalog and drop it on the model in the Scene Preview or Scene Contents window.

To apply a surface to a sub-part of a model (such as its bevel), from the View menu, choose Scene Contents to
open the Scene Contents window, then drag a surface and drop it on the model's sub-part.

Note If you apply a wood, granite, marble, or rainbow surface to a model, the surface will not be visible until
you generate a snapshot or animation of the scene.




Step by step

About surfaces

About the Scene Contents window
Modifying a model's surface
Commands

Catalog

Modify Surface & Color
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Warping a model
Step___t_)_y step

&

You can easily change a model's shape by warping it. However, once you've warped a model, if you want to move,
rotate, or scale the model's sub-parts, you must temporarily disable the warp.

To warp a model:

1 Select a model in the Scene Preview or Scene Contents window.

2 From the Models menu, choose Modify Warp.

3 Change the model's bow, angle, or twist, then click OK to close the dialog box.

To move a sub-part of a warped model:
1 Select a warped model in the Scene Preview or Scene Contents window.
2 From the Models menu, choose Modify Warp, click Disable Warp, and then click OK.

3 In the Scene Contents window, expand the model to display its sub-parts, select the sub-part you want to
move, then in the Scene Preview window, move, scale, or rotate the sub-part.

4 To reapply the warp, from the Models menu, choose Modify Warp, click Enable Warp, and then click OK.



Step by step

About the Scene Contents window
Command

Modify Warp

Asymetrix 3D F/X User Manual
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Arranging a model in a scene
Step__ by step

"

The Scene Preview window is like a room in which you can arrange models in relationship to each other in 3D
space. You can scale or change the size of one or more of the models, move them around the scene, and rotate
them to display other sides. You can even position your models to be out of the scene, which means that the
models or part of the models will be out of view in the next snapshot or animation you generate.

To arrange a model in a scene:

To scale a model, click the scale button on the Position palette, then drag the model.

To move a model left, right, up, or down in a scene, click the move button on the Position palette,
then drag the model.

"

To move a model closer or farther in 3D space, click the move button on the Position palette, then
press Shift while dragging the model.

To rotate a model, click the rotate button on the Position palette, then drag the model.



Step by step

About Asymetrix 3D F/X

About camera perspective

About creating 3D graphics with Asymetrix 3D F/X
About the Position palette

About the Scene Contents window

Resetting a model's location, rotation, or scale
Rotating a model

Commands

Position Palette

Reset Orientation

Reset Position

Reset Size
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Resetting a model's location, rotation, or scale
Steg_—_l?y step

"

You can return a model to the center of the scene, a flat orientation, or to its size when created.

To reset a model's location to the center of a scene:

‘ In the Scene Contents or Scene Preview window, select the model, then from the Edit menu,
choose Reset Position.
To bring a model that is out of the scene back into view:

1 From the View menu, choose On Camera Area then choose 75% or a smaller percentage, so you can see the
area outside the scene.

2 Select the model in the Scene Contents window, then move the model back into view using the move button on
the Position palette.

To set a model to a flat orientation:

‘ In the Scene Contents or Scene Preview window, select the model, then from the Edit menu,
choose Reset Orientation.
To reset a model's size:

"

In the Scene Contents or Scene Preview window, select the model, then from the Edit menu,
choose Reset Size.



Step by step

About Asymetrix 3D F/X

About camera perspective

About creating 3D graphics with Asymetrix 3D F/X
About the Position palette

About the Scene Contents window
Arranging a model in a scene
Scaling a model

Setting the camera perspective
Commands

Position Palette

Reset Orientation

Reset Position

Reset Size
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Adding a backdrop

Step by step

You can add a backdrop to your scene to create visual interest. You can use a solid color, a gradient, or a bitmap,
metafile, or other graphic as a backdrop.

Note Models in a scene are always in front of a backdrop; lights, shadows, and fog do not affect a backdrop.
To add a backdrop to a scene:
1 Click the Backdrops tab in the Catalog.
2 Drag a backdrop from the Catalog and drop it in the Scene Preview or Scene Contents window.
Note Show or hide a scene's backdrop by choosing Backdrop from the View menu.



Step by step

About Asymetrix 3D F/X

About the Scene Contents window
Modifying a backdrop

Commands

Backdrop

Catalog
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Adding lights

Step by step

Lights set the scene's mood and style; a scene can take on a different feel when the brightness, direction, and

color of lights are changed. Ambient light brightens every surface. Directional lights (such as White Right Light)
brighten based on whether the model surface faces toward or away from the light. Lights sources always come
from outside the scene.

To add a set of lights to a scene:

1 Click the Lights tab in the Catalog.

2 Drag a light set from the Catalog and drop it in the Scene Preview or Scene Contents window.

It doesn't matter where you drop the lights because they affect the entire scene. Each light has a preset color
and position you can modify.




Step by step

About creating 3D graphics with Asymetrix 3D F/X
About the Scene Contents window

Modifying a light

Commands

Catalog

Modify Lights
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Adding shadows to a scene
Step__ by step
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Shadows add dramatic effect, showing where a scene's light comes from. By default, each light set in the Catalog
provides one light with shadows turned on. You can make additional lights cast shadows in your scene, however,
the scene will take longer to generate.

Note Because a backdrop is not a model, shadows do not affect it. To create the effect of shadows on a backdrop,
use a wall model.

To add shadows to a scene:

1

2
3
4

From the Scene menu, choose Modify Lights.

Under Light Name(s), select a light to cast shadows, check Light Casts Shadows, and then click OK.
From the Scene menu, choose Snapshot & Animation Settings, then click the Quality tab.

For Snapshot Style, select Realistic w/Shadows or Ray Traced w/Shadows, then click OK.

Note Shadows are only visible after you generate a scene.

From the Scene menu, choose Generate Snapshot, then click OK.

As Asymetrix 3D F/X generates a scene with shadows, the progress indicator tracks the calculation of shadows
for each light in the scene.

To adjust the scene lights to create dramatic shadows:

1
2

Add a wall and floor plane to your scene to provide surfaces for the shadows.
Choose Modify Lights from the Scene menu; in the Preview & Set Light Direction box move the light so that the

bright spot is at the top and center of the sphere, then click OK.



Step by step

About creating 3D graphics with Asymetrix 3D F/X
Adding lights

Modifying a light

Commands

Modify Lights

Snapshot & Animation Settings
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Setting the camera perspective
Ste!)__ by step

"

You can change the camera perspective so that models appear to change in size and distance. The models retain
their actual size and place; only the perspective changes.

To make models appear at actual size and distance:

"

From the Scene menu, choose Camera Perspective, then choose Normal.
To make models appear larger and closer:

From the Scene menu, choose Camera Perspective, then choose Wide Angle.
To make models appear smaller and farther away:

From the Scene menu, choose Camera Perspective, then choose Telephoto.



Step by step

About camera perspective
Command

Camera Perspective
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Animating a model
Step__t_)_y step
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To create an animation, you define a motion for all models in the scene that you want to move. To do this, you

select preset animation paths for each model and then modify each animation path so that the model moves in the
way you want.

For added interest, you can apply a soundtrack--a wave audio (.WAV) file--that plays with the animation.
To add an animation path to a model:
1 Click the Paths tab in the Catalog.

2 Drag an animation path from the Catalog and drop it on the model in the Scene Preview or Scene Contents
window.

If you added more than one animation path to a model, in the Scene Contents window, double-click the model's
Paths icon to expand its branch, then drag the animation paths and drop them into the order you want.
3 To preview the animation, from the Scene menu, choose Preview Animation.




Step by step

About animation in Asymetrix 3D F/X
About the Scene Contents window
Animating sub-parts of a model
Building a scene

Generating an animation
Previewing an animation
Commands

Catalog

Generate Animation

Preview All Frames

Preview Animation
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Modifying a model's animation path
Ste!_a__ by step

Py

You can modify an animation path applied to a model so that it moves in the way you want.
To modify an animation path:

1

2
3
4

(3]

Select the model, then from the Models menu, choose Modify Animation.
For Animation Path Name(s), select an animation path to modify.
In the Movement tab, under Duration, set the animation's length.

Under Start And End Positions, select whether the model enters the scene, leaves the scene, doesn't move, or
waits offscreen on the animation path.

Under Offscreen Position, click to set where the model is positioned out of the scene.

Click the Spin tab, then set if and how the model spins. The spin can apply to the model, its sub-parts (such as
each character in a text model), or both.

Click the Effects tab, then set the animation sequence (which part of the model moves first), whether the
sequence applies to the motion or spin, and how the model is oriented offscreen.

Click OK.



Step by step

About animation in Asymetrix 3D F/X
Adding a soundtrack to an animation
Animating a model

Animating sub-parts of a model
Generating an animation
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Modifying a model's animation path sequence
Step__ by step
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When a model has more than one animation path, you can adjust the sequence of the paths so the model moves
the way you want.

To adjust the sequence of animation paths:

1 From the View menu, choose Scene Contents to open the Scene Contents window.

2 In the Scene Contents tree, under the model's Path branch, drag the animation paths into the sequence you
want. (The top path occurs first.)

Note If you apply fly-in and fly-out animation paths in sequence to a model, the model's motion will become a
curve rather than two straight lines.
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Adding a soundtrack to an animation
Step__ by step
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You can easily apply a soundtrack to accompany your animation. Asymetrix 3D F/X saves animations in
audio/video interleaved (.AVI) format so that the animation frames are interleaved with the sound. As a result, the
sound plays with the animation.

Note You can apply only one soundtrack to an entire animation.

To add a soundtrack to an animation:
1 From the Scene menu, choose Modify Soundtrack.
2 Select a wave audio (.WAV) file or an .AVI file that contains sound, then click OK.
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Embedding a new scene
Step__ by step
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You can embed a new, empty Asymetrix 3D F/X scene in a container application, then use Asymetrix 3D F/X to
add models, lights, and other elements to this scene.

Note The container application you are working in may use slightly different menu command names than those
listed below.

To embed a new scene:

1 From the container application's Edit or Insert menu, choose Insert Object.

2 Select Create New, then under Object Type, select Asymetrix 3D F/X Scene.

3 Click OK to start Asymetrix 3D F/X, then build your scene.
4

When you're finished, if Asymetrix 3D F/X is in a separate window, from the File menu, choose Exit & Return. If
it is not in a separate window, click away from the scene in the container document to display the container
application.



Step by step

About editing scenes in a container application

About object linking and embedding (OLE

Displaying a scene or icon in a container application
Displaying a snapshot or animation in a container application
Editing embedded or linked Asymetrix 3D F/X scenes
Embedding or linking an existing scene

Playing a linked or embedded animation

Updating your OLE registration database

Asymetrix 3D F/X User Manual

Chapter 2, "Linking or embedding scenes"



Embedding or linking an existing scene
Step__ by step
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You can embed or link an existing scene file into a container application. To embed or link an existing scene, you
must have already built the scene in Asymetrix 3D F/X and saved it to a file.

Note The container application you are working in may use slightly different menu command names than those
listed below.

To embed or link an existing scene file in a container application:

1 From the container application's Edit or Insert menu, choose Insert Object.

2 Select Create From File. If you want to link the scene, check Link.

3 Locate the scene file, then click OK.
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Editing embedded or linked Asymetrix 3D F/X scenes

Step by step
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You can use Asymetrix 3D F/X to edit a scene you have embedded or linked to an OLE container application. The
updated scene appears in the container application.

Note The container application you are working in may use slightly different menu command names than those
listed below.

To edit a linked or embedded scene:

1
2

3

In the container application, select the scene.

From the container application's Edit menu, choose Asymetrix 3D F/X Scene Object (or Scene Object), then
choose Edit to start Asymetrix 3D F/X.

Edit the scene.

Optional. In Asymetrix 3D F/X, generate a snapshot or animation to display in the container application, instead
of the scene.

Note If you are regenerating an animation, in most cases, save it to the same name as the previous version so
that you do not consume disk space with multiple animations.

When you're finished, if Asymetrix 3D F/X is in a separate window, from the File menu, choose Exit & Return. If
it is not in a separate window, click away from the scene in the container document to display the container

application.
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Displaying a snapshot or animation in a container application
Step by step
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You can determine what part of your linked or embedded scene appears in the container application. You can
display a snapshot or frame of an animation generated from a scene, the scene itself, or the Asymetrix 3D F/X
icon.

Note The container application you are working in may use slightly different menu command names than those
listed below.
To display a snapshot in a container application:
1 In the container application, link or embed a scene.
2 From the Scene menu, choose Generate Snapshot.
If you make any changes to the scene, you must regenerate the snapshot.

To display an animation in a container application:
1 In the container application, link or embed a scene

2 To determine whether the first or last frame of the animation is displayed, from the Scene menu, choose
Snapshot & Animation Settings, click the OLE tab, select First or Last, and then click OK.

3 From the Scene menu, choose Generate Animation.
If you make any changes to the scene, you must regenerate the animation.
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Displaying a scene or icon in a container application
Step__ by step
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You can determine what part of your linked or embedded scene appears in the container application. You can
display a snapshot or frame of an animation generated from a scene, the scene itself, or the Asymetrix 3D F/X
icon.

Note The container application you are working in may use slightly different menu command names than those
listed below.

To display a scene in a container application:

1 In the container application, link or embed a scene.
If you don't generate a snapshot or animation in Asymetrix 3D F/X, the scene appears in the container
application and uses the Scene Preview window settings.

2 To view the scene as solid models, from the Tools menu, choose Options, then check Display Solid Models In
Previews & OLE.

T_c_> display the Asymetrix 3D F/X icon in a container application:

ey

In the container application's Insert Object dialog box, check Display As Icon.
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Playing a linked or embedded animation
Ste!_a__ by step
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You can play a linked or embedded animation using the Asymetrix 3D F/X runtime player (which you can freely
distribute with your files to play your animations), Microsoft Video for Windows, or the Media Player.

Note The container application you are working in may use slightly different menu command names than those
listed below.
To play an animation:

1 Double-click the OLE Registration icon in the Asymetrix 3D F/X Program Manager group to open the Browse
For 3DFXPLAY.DLL dialog box. Locate the 3DFXPLAY.DLL file, then click OK.

Note You only need to do this once for each system on which you want to play Asymetrix 3D F/X animations.
2 In the container application, double-click the embedded or linked scene.
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Updating your OLE registration database

Step by step

oy

If you are trying to embed or link a scene in an OLE container application, and the Insert Object dialog box does
not contain the Asymetrix 3D F/X Scene entry, you may need to update your OLE registration database.

Note The container application you are working in may use slightly different menu command names than those
listed below.

To update your OLE registration database:

1 Start Asymetrix 3D F/X by clicking the icon in the Program Manager, then exit Asymetrix 3D F/X.

2 Double-click the OLE Registration icon in the Asymetrix 3D F/X Program Manager group to open the Browse
For 3DFXPLAY.DLL dialog box. Locate the 3DFXPLAY.DLL file, then click OK.

The Asymetrix 3D F/X Scene entry should now appear in the Insert Object dialog box.
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Previewing a snapshot
Step__t_)_y step

"

Before you generate a snapshot, you may want to preview it, because generating can be quite time-consuming.
You can preview your snapshot in several ways before creating the final version.

To preview only part of the snapshot:

"

From the Scene menu, choose Preview Snapshot to display a crosshair. In the Scene Preview
window, use the crosshair to draw a box around the area you want to preview.
Note Snapshot previews do not include a backdrop.

Tc_> generate a draft of a snapshot:

"

From the Scene menu, choose Generate Snapshot. Under Style, select a faster generating style
(such as Solid Models), then click OK to generate the draft.

"
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Previewing an animation
Step___t_)_y step

"

Before you generate an animation, you may want to preview it, because generating can be quite time-consuming.
You can preview your animation in several ways before creating the final version.

To preview the animation in real time:

"

From the Scene menu, choose Preview Animation.
Asymetrix 3D F/X drops frames from the animation if the current system cannot play all the frames at the
correct rate (measured in frames per second), so the preview may appear jerky or choppy. This preview can help you
determine how long a soundtrack will play during the animation.
Tip To stop previewing an animation, click in the Scene Preview window.

To preview all frames in an animation:

"

From the Scene menu, choose Preview All Frames.
In this preview, a soundtrack you've added will not play back synchronized with the animation, and Asymetrix
3D F/X will display all frames in the animation regardless of your system's speed.

To generate a draft of an animation:
1 From the Scene menu, choose Generate Animation.

2 Under Style, select a faster generating style (Wireframes and Solid Models are fastest, Ray Traced w/Shadows
is slowest), then click OK to generate the draft.



Step by step

About animation in Asymetrix 3D F/X
Animating a model

Generating an animation
Commands

Generate Animation

Preview All Frames

Preview Animation

Snapshot & Animation Settings
Asymetrix 3D F/X User Manual
Chapter 3, "Creating snapshot and animation files"




Generating a snapshot
Step___t_)_y step
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When your scene is the way you want, you can generate a snapshot of it. Before generating, preview the
snapshot, because this process can take a minute or more depending on the scene complexity and generating
style you choose.

To generate and save a snhapshot:

1
2

From the Scene menu, choose Generate Snapshot.
Under Style, select a generating style.

Note If you choose Wireframes or Solid Models, the snapshot will generate at the color depth of your video
driver. If you choose Solid Models, you cannot generate a snapshot larger than your screen.

Under Generate Image Of, select whether to generate the current scene, or create a snapshot from a frame of
animation. Use the Animation palette to go to the frame (its number appears in the Scene Preview window
status bar).

Under Destination, set whether to generate the snapshot onscreen or to a file, and then enter a file name.
Click OK to generate the snapshot.

To stop generating, click Cancel in the status bar or press the Esc key.

To save the snapshot, select the Snapshot window, then from the File menu, choose Save.
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Generating an animation
Step___t_)_y step
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When your scene is the way you want, you can generate an animation of it. Before generating, preview the
animation, because this process can take a minute or more depending on the scene complexity and generating
style you choose.

Note Each frame in an animation is generated separately, which can take time.
To generate and save an animation:

1
2

w

From the Scene menu, choose Generate Animation.
Under Style, select a generating style.

Note If you choose Wireframes or Solid Models, the animation will generate at the color depth of your video
driver.

Under Compression, click Change to set the type and quality of compression used.

Under Output File, enter a file name or click Browse to locate a file to which the animation will be saved. If you
enter a bitmap file name, Asymetrix 3D F/X will generate the animation as a sequence of bitmaps.

Under Repeat Frames, enter a positive number to add copies of the first or last frame to the generated .AVI file,
or enter a negative number to skip generating frames at the beginning or end of the animation.

Click OK to generate the animation.

To stop generating, click Cancel in the status bar or press the Esc key.

Tip You can minimize the Asymetrix 3D F/X main window, then switch to a different application while
generating in the background. The minimized icon tracks the generating progress.

To view the results, click the play button in the Animation window.

If you aren't satisfied with the results, alter the models in the Scene Preview window or change the options in

the Scene & Animation Settings dialog box, then regenerate the scene.



Step by step

About animation in Asymetrix 3D F/X
Animating a model

Previewing an animation
Commands

Generate Animation

Preview All Frames

Preview Animation

Snapshot & Animation Settings
Asymetrix 3D F/X User Manual
Chapter 3, "Creating snapshot and animation files"




Generating complex or large snapshots
Step__ by step

Large shapshots using many colors can require a substantial amount of RAM to generate. If you have trouble
generating a snapshot, try generating to a file first. If the snapshot still won't generate properly, try applying a color

palette that uses fewer colors, and then regenerate the snapshot.

Note To generate snapshots larger than 4092 pixels wide when your color depth is 8 bits per pixel, 2046 pixels
when your color depth is 16 bits per pixel, or 1364 pixels when your color depth is 24 bits per pixel, you must
generate to file.

To generate a snapshot to a file:

1 From the Scene menu, choose Generate Snapshot.

2 Under Destination, select Generate Directly To File, enter a file name, and then click OK.

To generate a snapshot using fewer colors:

1 From the Scene menu, choose Snapshot & Animation Settings, then click the Colors tab.
2 For Palette, select a color palette with fewer colors, and then click OK.

3 From the Scene menu, choose Generate Snapshot, then click OK.
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Printing a scene or snapshot
Step__ by step
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You can print the entire contents of the Scene Preview window or just a snapshot that you've generated.

Depending on options you set, your results from the Snapshot window or Scene Preview window may be very

different. For example, shadows and lights do not appear in the Scene Preview window, but do appear in the

Snapshot window. As a result, if you want to print with shadows and lights, print from the Snapshot window.

To print a scene or snapshot:

1 Select either the Scene Preview or Snapshot window, depending on which you want to print.

2 From the File menu, choose Print.

3 Select to print the active window's contents or a different snapshot file.

4 Under Margins, set whether the image is printed at actual size, scaled to fit within the default printer margins, or
within margins you specify.

5 Click OK to start printing.
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Printing a frame of an animation
Step__ by step
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You can generate a snapshot of a single frame of animation, then print it.

To print a single frame of animation:
1 From the File menu, choose Open, then select the scene containing the animation.

2 From the View menu, choose Animation Palette, and use it to move through the animation until you display the
frame you want. Note the frame number shown in the status bar.

From the Scene menu, choose Generate Snapshot.

Under Generate Image Of, select Single Frame Of Animation, then enter the frame number.
Under Destination, select Display In Window, then click OK to generate the snapshot.

With the Snapshot window active, choose Print from the File menu, then click OK.

. O h W
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Animating sub-parts of a model
Ste!_a__ by step
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You can animate the sub-parts of a model to enter, leave, or spin in a scene.

To animate the sub-parts of a model:

1 Select a model with sub-parts.

2 From the Models menu, choose Modify Animation.

3 In the Movement tab, under Duration, set how long you want the animation to last.
4

Under Start And End Positions, select either Enter Scene or Leave Scene, then click a position in the Offscreen
Position box for the models to enter from or go to when they leave.

In the Effects tab, check Apply To Motion or Apply To Spin, then select a method of staggering sub-parts.
Click OK.

7 From the Scene menu, choose Preview Animation.

o 0
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Staggering when models enter a scene
Step__ by step
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You can animate models to enter a scene one at a time by applying a fly-in path to one model, and a Wait
Offscreen path to another.

To animate models to enter a scene one at a time:

a b ON-=-

© 0o ~NO®

10

1

Create the models.

Select the model you want to enter the scene first, then from the Models menu, choose Maodify Animation.
In the Movement tab, under Animation Path Names, enter a name for the path, such as Fly-In.

Set Duration to the length you want. (It must be the same length as the Wait Offscreen path.)

Under Start And End Positions, select Enter Scene, set the Offscreen Position to where you want the model to
enter the scene, and then click OK.

Select the model you want to enter the scene next, then from the Models menu choose Modify Animation.
In the Movement tab, under Animation Path Names, enter a name for the path, such as Wait Offscreen.
Set Duration to the same length as the Fly-In path.

Under Start And End Positions, select Wait Offscreen, set the Offscreen Position to where you want the model
to enter the scene, and then click OK.

In the Scene Contents window, select the Fly-in path and drop it on the second model, then select the wait path
and drop it on the first model.

The paths should be in the correct order for each model.
From the Scene menu, choose Preview Animation.
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Applying a digital video file as a surface
Ste!_a__ by step
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You can create an exciting animation effect by applying a digital video file (L(AVI) or a generated animation file to a
model's surface. You can also add an animation path to the model so that it rotates as it plays the video on its
surface. However, this effect can take a lot of time and computer resources (RAM) to generate.

Note If the video is important to your message, make sure your audience is able to watch it before you begin
rotating the model. In addition, use a simple model (such as a cube) so that the video can be viewed easily; for
example, a video doesn't play well on the surface of a dinosaur model.

To apply a digital video file as a surface:

1
2
3

(3]

Select the model, then from the Models menu, choose Modify Surface & Color.
In the Surface Pattern tab, select Bitmap Pattern.

Under Surface Settings, click Browse to open the Import Graphic dialog box. From List Files Of Type, select AVI
(*.avi), select a video file from the list box, and then click OK to open the Animated Surface dialog box.

Set the video's start and end frames, and whether the video loops continuously or freezes on the last frame,
then click OK.

Click OK in the Modify Surface & Color dialog box.
From the Scene menu, choose Generate Animation, then click OK.
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Changing a snapshot's color depth or size
Ste!_a__ by step
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After you've generated a snapshot, you may want to modify its color depth or size.

You might want to change a snapshot's color depth, for example, if you want to display the same snapshot on
different color systems, such as 24-bit (16.7 million colors) and 4-bit (16-colors). For the best results, generate the
snapshot at the higher color depth, then convert it to the lower color depth.

Note Try to set your final snapshot size and color palette before you generate it. In general, you can reduce a
snapshot's size or color palette successfully; but enlarging a snapshot or increasing color depth may not produce
attractive results.

To change a snapshot's color depth or size:

1 From the Tools menu, choose Convert Snapshot.

2 In the Colors tab, under New Image For Palette, set a new palette.

If you are converting a snapshot to 256 colors for an Asymetrix Compel presentation, choose Compel Palette
(8-bit). If you are converting a snapshot from 24-bit or 16-bit to 8-bit (256 colors), choose Best 256 Colors (8-
bit).

For Dithering, specify how to dither the snapshot.

4 Click the Size tab; under New Image, set a new size, then click OK.

w
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Importing a model
Step__t_)_y step
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You can import a 3D model file created in another program into your scene. Asymetrix 3D F/X supports models
created in Autodesk 3D Studio (.3DS) or AutoCAD (.DXF) format.

To import a model:

1 From the Models menu, choose Import Model.

2 Enter a file name, or select a file from the list.

3 Click OK to import the model into your scene.

Note Imported model files often have associated surface mapping files. If Asymetrix 3D F/X cannot locate an
imported model's associated surface mapping files, the Imported Model Surface dialog box opens automatically.
You can assign new files to use as surfaces, or search for the original surface mapping files Asymetrix 3D F/X
needs.



Step by step

About imported models

Adding a preset model

Creating a picture model

Creating a text model

Modifying an imported model
Commands

Import Model

Imported Model Surface (dialog box)
Modify Imported Model (dialog box)
Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Selecting models
Step__t_)_y step

In Asymetrix 3D F/X, you can select one model, multiple models, or a model's sub-parts to work with.

To select a model:

‘ Click the model in the Scene Preview or Scene Contents window.
To select all models in a scene:

‘ From the Edit menu, choose Select All.

To select a sub-part of a model:

1 Double-click the model in the Scene Contents window to display its elements. If the model has sub-parts, they
will be listed.

2 Click a sub-part in the Scene Contents window. The sub-part will also be selected in the Scene Preview
window. Using the Position palette, you can move, rotate, scale, warp, or modify the sub-part's surface while it
is selected.

To select multiple models or model sub-parts:

Shift+click or Ctrl+click each model or sub-part in the Scene Preview or Scene Contents window.
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Adding a texture to a model's surface
Step__ by step
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You can add a texture to a model's surface by choosing a bump texture to apply. A bump texture can be added to
any model, no matter what type of surface it currently has.

To add a bump texture to a model's surface:

1
2
3

In the Scene Preview or Scene Contents window, select a model to modify.
From the Models menu, choose Modify Surface & Color, then click the Highlights tab.

Select a preset Bump Texture file from the Texture list, or click Browse to import a bitmap file as a texture.
Bump textures can be found in the Bumps subdirectory of your Catalog directory.

Select a Tile Bitmap value to determine how many times the texture will be repeated over the surface. The
higher the number, the more times the bitmap will be repeated on the surface.

Click OK to close the dialog box, and apply the bump texture to your model.
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Making a model a sub-part of another model
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You can easily create a new model by making one model a sub-part of another in the Scene Contents window.
To make a model a sub-part of another model:

‘ In the Scene Contents window, select the model you want to be a sub-part. Drag the model, then
drop it onto a second model. The first model becomes a sub-part of the second model.
To disassociate sub-parts from a model:

1 In the Scene Contents window, select the model sub-part you want to disassociate, then drag the sub-part and
drop it on the scene icon.

2 Repeat Step 1 for all the model sub-parts you want to disassociate.
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Modifying a model's surface
Step__ by step

Py

You can easily modify a model's surface by applying a color, bitmap, or solid material to it.
To modify a surface:

1
2

4
5

6

From the Models menu, choose Modify Surface & Color.

In the Surface Pattern tab, select Color, Bitmap Pattern, or Solid Material.

Note If you apply a wood, granite, marble, or rainbow surface to a model, the surface will not be visible until
you generate a snapshot or animation of the scene. Also, if you tile a bitmap surface, the surface will not
appear tiled until you generate a snapshot or animation of the scene. Bitmap surfaces can be found in the
Bitpatrn subdirectory of your Catalog directory.

Click the Highlights tab, then set Highlight Size, Intensity, Unhighlighted Surface, or a bump texture for the
surface.

Click the Effects tab.

Under Reflections, choose a preset reflection map; then use the Intensity slider to adjust how reflective the
surface is, or use the Transparency slider to make the surface more or less transparent.

Click OK to close the dialog box.

Note If you add reflections to a model in a scene and want them to appear in a snapshot or animation you
generate from it, you must choose Ray Traced or Ray Traced w/Shadows under Snapshot Style in the Quality tab

of the Snapshot & Animation Settings dialog box.



Step by step

About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Making a color surface appear transparent
Making a solid material surface transparent
Making a surface reflect a bitmap

Making a surface reflective

Making all models in a scene reflect a bitmap
Command

Modify Surface & Color
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Making a surface reflective
Step__ by step

=

You can make a model's surface reflective using the Asymetrix 3D F/X reflection settings.
To make a surface reflective:

1
2
3

From the Scene menu, choose Snapshot & Animation Settings, then click the Quality tab.
For Snapshot Style, select Ray Traced, or Ray Traced w/Shadows, then click OK.

In the Scene Contents window, right-click the surface, then choose Modify Surface & Color from the right-click
menu. (If you don't see the model's surface listed, double-click the model's icon to expand it.)

In the Surface Pattern tab, select Color, then under Surface Settings, select a color to apply.

In the Effects tab, set the Intensity of the object to Mirror, click Enable Optical Effects When Ray Tracing, and
then click OK.

To see the reflective surface, generate a snapshot of the scene.



Step by step

About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Making a color surface appear transparent
Making a solid material surface transparent
Making a surface reflect a bitmap

Making all models in a scene reflect a bitmap
Modifying a model's surface

Commands

Generate Snapshot
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Making a surface reflect a bitmap
Step__ by step

=

You can make a model's surface appear to reflect a bitmap. This is an easy way to create scenes that appear
complex, but which generate quickly.

To make a surface reflect a bitmap:
1 In the Scene Contents window, right-click the surface, then choose Modify Surface & Color from the right-click
menu.

2 In the Effects tab, click Use Reflection Map, then select a preset reflection map, or click Browse to import a file
to use as a reflection. Reflection maps can be found in the Rflctns subdirectory of your Catalog directory.
Note To make an object reflect both a reflection map and the scene around it, check Enable Optical Effects
When Ray Tracing.

Move the Intensity slider close to Mirror, then click OK.

4 To see the reflection map, generate a snapshot of the scene.

w



Step by step
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Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model
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Making all models in a scene reflect a bitmap
Step__ by step

=

You can make all models in a scene appear to reflect a bitmap. This is an easy way to create scenes that appear
complex, but which generate quickly.

To make all models in a scene reflect a bitmap:

1 From the Scene menu, choose Snapshot & Animation Settings.

2 In the Effects tab, check Use Environment Map, enter the name of an environment map or click Browse to
import a file as an environment map, and then click OK. Environment maps can be found in the Rflctns
subdirectory of your Catalog directory.

3 To see the environment map, generate a snapshot of the scene.



Step by step

About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Making a color surface appear transparent
Making a solid material surface transparent
Making a surface reflect a bitmap

Making a surface reflective

Modifying a model's surface
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Making a color surface appear transparent
Step__ by step

=

You can make a color surface appear transparent by changing the surface's transparency.

To make a color surface transparent:

1 In the Scene Contents window, right-click the surface you want to modify.

2 Choose Modify Surface & Color from the right-click menu.

3 Click the Effects tab, then move the transparency slider toward Transparent.
The change you have made will appear in the Surface Preview box.

4 Move the transparency slider until you achieve the effect you want, and then click OK to apply it to the surface
of your model.

5 To see the transparent surface, generate a snapshot of the scene.



Step by step

About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Creating a "glass"™ surface

Making a solid material surface transparent
Making a surface reflect a bitmap

Making a surface reflective

Making all models in a scene reflect a bitmap
Modifying a model's surface

Submerging a model in "water"
Commands
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Making a solid material surface transparent
Step__ by step

=

You can make a solid material surface appear transparent by changing the opacity of one of its grain or vein
colors.

Note You can only change the opacity of colors in Marble, Granite, or Wood solid material surfaces: you cannot
set the opacity of colors in the Rainbow solid material surface.

To make a solid material transparent:

1
2
3

In the Scene Contents window, right-click the surface you want to modify.
Choose Modify Surface & Color from the right-click menu, then click Solid Material.

Under Surface Settings, select a color element (such as stone, vein, or grain color) to adjust, then click its color
button to open the Color Wheel dialog box.

Set the color's Opacity (values between 1 and 15 simulate the transparency of air, values between 100 and 120
simulate the transparency of glass, and values between 130 and 140 simulate the transparency of water); then
click OK.

The change you have made will appear in the Surface Preview box.

Repeat Steps 3 and 4 until you achieve the effect you want, then click OK to apply it to the surface of your
model.

Note You must set the Snapshot Style to Ray Traced or Ray Traced w/Shadows in the Snapshot & Animation
Settings dialog box to see lights reflect and refract correctly in the scene.

To see the transparent surface, generate a snapshot of the scene.
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About surfaces

Adding a texture to a model's surface
Applying a digital video file as a surface
Applying a surface to a model

Making a color surface appear transparent
Making a scene and backdrop appear smoky
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Making a surface reflect a bitmap

Making a surface reflective

Making all models in a scene reflect a bitmap
Modifying a model's surface

Commands
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Creating a "glass" surface
Step__ by step

You can quickly create the appearance that a model is made of glass using a modified surface and the Ray Traced

or Ray Traced w/Shadows generating style.

Note A backdrop will never appear distorted when viewed through a transparent surface. To create the effect of a
distorted backdrop, create a wall model and place it at the rear of your scene.

To create a "glass" surface:

1 Create a model, then from the Models menu, choose Modify Surface & Color.

2 In the Surface Pattern tab, select Color; then under Surface Settings select a color for your model.
3 In the Effects tab, move theTransparency slider almost to Transparent, then click OK.
4

Generate a snapshot of the scene using the Ray Traced or Ray Traced w/Shadows Snapshot Style to see your
results.



Step by step

About creating 3D graphics with Asymetrix 3D F/X
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Adding a wall or floor

Making a color surface appear transparent
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Creating a reflection or environment map of a scene
Step by step

You can quickly create snapshots that appear to have complex ray traced reflections without actually ray tracing
the entire scene. Start by generating one ray traced snapshot of a scene. Then, use the snapshot as a reflection
or environment map for another scene that contains the models you want, and generate the scene using the
Realistic or Realistic w/Shadows Snapshot Style.

To create a reflection or environment map of a scene:

1
2

Create the scene you want to reflect.
From the Scene menu, choose Generate Snapshot.

3 Set the Snapshot Style to Ray Traced or Ray Traced w/Shadows, then click OK. When the snapshot is

generated, save it.

To apply the snapshot as a reflection map:

1
2
3
4
5

Create a new scene that contains the model you want to reflect the snapshot.

Select a model, then from the Models menu, choose Modify Surface & Color.

In the Effects tab, click Use Reflection Map, enter the snapshot's file name in the File box, and then click OK.
From the Scene menu, choose Generate Snapshot.

Set the Snapshot Style to Realistic or Realistic w/Shadows, then click OK.

To apply the snapshot as an environment map:

L R WN

Create a new scene that contains the models you want to reflect the snapshot.

From the Scenes menu, choose Snapshot & Animation Settings.

In the Effects tab, click Use Environment Map, enter the snapshot's file name in the File box, and then click OK.
From the Scene menu, choose Generate Snapshot.

Set the Snapshot Style to Realistic or Realistic w/Shadows, then click OK.



Step by step

About creating 3D graphics with Asymetrix 3D F/X
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Modifying a simple model's shape
Ste!)__ by step

Py

You can quickly modify the shape of a simple model, such as a cube, sphere, or ring.

To modify a simple model's shape:

1 Select a simple model in the Scene Preview or Scene Contents window.

2 From the Models menu, choose Modify Model to open the appropriate dialog box.

3 Modify the model's values, then click Update to see how the model's shape will be changed.
4 When you've achieved the effect you want, click OK to apply the changes to your model.



Step by step
About simple models
Commands

Modify Cube (dialog box)
Modify Cylinder (dialog box)
Modify Ring (dialog box)
Modify Sphere (dialog box)

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Modifying an imported model

Step by step

"

You can modify the surfaces of an imported model's meshes if you are having difficulty displaying it. A model you
import into Asymetrix 3D F/X may have the following problems:

Meshes that don't all face the same direction, so that the model appears to have holes in it.

Reversed meshes, so that a sub-part of the model is not visible when you display it in Solid Models
vievs_/_,_ or generate a snapshot.

Meshes that should be smooth but are faceted, so that a curved surface appears very angular.

Meshes that should be faceted but are smooth, such as corners that meet in curves rather than
angles.

You can also modify the meshes of an imported model to change the way it looks. For example, you can sub-

divide a mesh so that it appears smoother.

To make a model's meshes face the same direction:

1 Select an imported model or one of its meshes in the Scene Contents window.

2 From the Models menu, choose Modify Model to open the Modify Imported Model dialog box.

3 Click Unify Normals, then click OK.

If you can't see the model or mesh in Solid Models view, follow the procedure for reversing a model's meshes
below.

To reverse a model's meshes:

1 Select an imported model or one of its meshes in the Scene Contents window.

2 From the Models menu, choose Modify Model to open the Modify Imported Model dialog box.
3 Click Flip Normals, then click OK.

To smooth a model's meshes:

1 Select an imported model or one of its meshes in the Scene Contents window.

2 From the Models menu, choose Modify Model to open the Modify Imported Model dialog box.
3 Click Weld, then click OK.

To facet a model's meshes:

1 Select an imported model or one of its meshes in the Scene Contents window.

2 From the Models menu, choose Modify Model to open the Modify Imported Model dialog box.
3 Click Melt, then click OK.

To sub-divide a model's meshes:

1 Select an imported model or one of its meshes in the Scene Contents window.

2 From the Models menu, choose Modify Model to open the Modify Imported Model dialog box.
3 Click Sub-divide, then click OK.



Step by step

About imported models

Adding a preset model

Importing a model

Commands

Import Model

Imported Model Surface (dialog box)
Modify Imported Model (dialog box)
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Modifying a backdrop

Step by step

"

You can modify a scene's backdrop to add interest to a scene.

To modify a backdrop:
1 From the Scene menu, choose Modify Backdrop.
2__ Under Style, set the backdrop to Default White, Color, Gradient, or Picture:

For Solid Color, click the button to set the backdrop to a color.

For Gradient, click the button to open the Backdrop Gradient dialog box, then select a Gradient
Style to apply. Under Color Options, set the colors used in the gradient, then click OK.

"

For Picture, click Browse to select a file, click the Picture Options button to set how the bitmap fits
in the backdrop, and then click OK.
3 Click OK to close the Modify Backdrop dialog box and apply your changes.



Step by step
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Adding a backdrop

Adding a wall or floor
Commands
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Modify Backdrop
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Modifying a light

Step by step

Py

You can modify a light's direction, brightness, or color.

To modify a light:

1 From the Scene menu, choose Madify Lights.

2 Under Light Name(s), select a light to modify.

3 Under Settings, set the Intensity (or brightness); click the Color button to select a color for the light.
4

If you selected a directional light (not Ambient), click in the Preview & Set Light Direction box to move the light
to the position you want.

5 To briefly preview the effect of all lights added to the scene, click the Show All Lights button.
6 Click OK to close the dialog box and apply your changes.

Note As Asymetrix 3D F/X generates a scene with shadows, the progress indicator tracks the calculation of
shadows for each light in the scene.




Step by step
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Adding a wall or floor
Step__ by step

Adding a wall or floor to your scene can define the scene's depth and perspective. Because walls and floors are
models, they are affected by lights and shadows. Other models can also be moved behind a wall or under a floor.

To add a wall or floor to a scene:
1 From the Models menu, choose Create Simple Models, then choose Plane.
2 Using the Position palette, rotate, move, and scale the plane until it resembles a wall or floor.




Step by step

About simple models

Adding a preset model
Arranging a model in a scene
Resetting a model's location, rotation, or scale
Commands

Create Simple Model submenu
Modify Cube (dialog box)
Position Palette
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Submerging a model in "water"
Step__ by step

oy

You can quickly create the appearance of a model submerged in water by modifying a plane.

To submerge a model in "water":

1
2
3

(3]

From the Models menu, choose Create Simple Models, then choose Plane.
Using the Position palette, rotate, move, and scale the plane until it resembles a floor.

From the Models menu, choose Modify Model, which for a plane opens the Modify Cube dialog box, enter a
value of 1 for Size Z, and then click OK.

From the Models menu, choose Modify Surface & Color.

In the Surface Pattern tab, select Color, and then click blue.

In the Effects tab, move the Transparency slider slightly more than halfway toward Transparent, and then click
OK to close the Modify Surface & Color dialog box.

Create the model you want to submerge in the water, then in Solid Models view, move the model until it
intersects the plane.

Generate a snapshot of the scene using any snapshot style except Ray Traced or Ray Traced w/Shadows to

see your results.



Step by step
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Arranging a model in a scene
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Resetting a model's location, rotation, or scale
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Making a scene and backdrop appear smoky
Step__ by step

=

You can create the appearance of smoke over a scene and backdrop by placing a plane with a partially
transparent pattern in front of the scene.

Note You can also use the Fog effect in the Snapshot & Animation Settings dialog box to add an appearance of
fog or smoke to a scene; however, Fog does not affect backdrops, so scenes with backdrops may not look
realistic.

To make a scene and backdrop appear smoky:
1 Create a scene that includes the models you want.
2 From the Models menu, choose Create Simple Model, then choose Plane.

3 Using the Position palette, rotate, move, and scale the plane until it resembles a wall in front of all the other
models in your scene.

4 From the Models menu, choose Modify Surface & Color.
In the Surface Pattern tab, select Solid Material, then select Marble from the list.

6 Under Surface Settings, set the Scale slider all the way left, the Vein Curliness slider all the way right, and the
Grainline to Face.

7 Set Stone to 70, then click the Color button to open the Color Wheel dialog box; set the Opacity to 60, then
click OK.

8 Click the vein color button to open the Color Wheel dialog box; move the Lightness slider to the top, set Opacity
to 255, and then click OK.

9 Click OK to close the Modify Surface & Color dialog box.
10 Generate a snapshot of the scene to see your results.

(3]



Step by step
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Adding a preset model

Arranging a model in a scene
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Making a scene and backdrop appear snowy
Step__ by step

=

You can create the appearance of snow over a scene and backdrop by placing a plane with a partially transparent
pattern in front of the scene.

Note This effect works best against a dark backdrop.

To make a scene and backdrop appear snowy:
1 Create a scene that includes the models you want.
2 From the Models menu, choose Create Simple Model, then choose Plane.

3 Using the Position palette, rotate, move, and scale the plane until it resembles a wall in front of all the other
models in your scene.

4 From the Models menu, choose Modify Surface & Color.
In the Surface Pattern tab, select Solid Material, then select Granite from the list.

6 Under Surface Settings, set Stone to 90, then click the color button to open the Color Wheel dialog box; set
Opacity to 2, then click OK.

7 Set Grain 2 to 10 (Grains 1 and 3 will be 0), then click the Grain 2 color button to open the Color Wheel dialog
box; move the Lightness slider to the top, set Opacity to 255, and then click OK.

8 Generate a snapshot of the scene to see your results.

(3]
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Creating models that appear to be lights

Step by step

oy

In addition to using preset lights from the Catalog, you can create models that appear to be directional lights.
Note These models only appear to be lights, and do not add any actual light to a scene.

To create models that appear to be lights:

From the Models menu, choose Create Simple Model, then choose Cone or Cylinder.

Using the Position palette, rotate, move, and scale the model until it appears in the location you want.
From the Models menu, choose Madify Surface & Color.

In the Surface Pattern tab, select Color, then under Surface Settings, click white.

In the Effects tab, move the Transparency slider approximately halfway toward Transparent, then click OK.
Generate a snapshot of the scene to see your results.

. O A~ ON -
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Including only a model's shadow in a scene
Step__ by step

=

You can form a scene in which a model casts a shadow, but the model itself does not appear.

To include only a model's shadow in a scene:

1
2
3
4
5

6

7
8

From the View menu, choose On Camera Area, then choose 66%.
Add a wall model and a floor model to the scene, so the shadow has a surface on which to be cast.
Create the model whose shadow you want to cast.

In Boxes or Wireframes mode, position the model so that it is above the white area in the Scene Preview
window.

In the Scene Contents window, double-click the Lights icon to display the individual lights, then drag a light, and
drop it on the Lights icon to create a copy of it.

Double-click the icon for the light you just created to open the Maodify Lights dialog box, click in the center of the
Preview & Set Direction box to place the light directly above the scene, and then click OK.

From the Scene menu, choose Generate Snapshot.
Under Style, select Realistic w/Shadows or Ray Traced w/Shadows, then click OK.

Note As Asymetrix 3D F/X generates a scene with shadows, the progress indicator tracks the calculation of
shadows for each light in the scene.



Step by step
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Creating and modifying a Catalog
Ste!)__ by step

You can create a new Catalog of scene elements to use, or modify the Asymetrix 3D F/X Catalog.

To create a new Catalog:

‘ From the File menu, choose New Catalog.
To add elements to a new or existing Catalog:

‘ Drag any scene element from the Scene Contents window and drop it in the Catalog you want. The
element will automatically be placed in the appropriate Catalog tab.
You can store any type of scene element in the User tab of a Catalog. For example, you can place all the surfaces,
models, backdrops, and lights you use most frequently in the User tab so you can find them quickly.
To store an element in the User tab of a Catalog:
1 Click the User tab in a Catalog.
2 Drag any scene element from the Scene Contents window and drop it in the User section of the Catalog.

To remove elements from a Catalog:

"

Select any scene element in the Catalog, then press Del. Asymetrix 3D F/X displays a warning that
deleting a Catalog entry cannot be undone. You are given the choice of deleting both the entry and its actual file, or
just the entry.

"



Step by step

About Asymetrix 3D F/X

About the Scene Contents window
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Generating a 32-bit snapshot

Step by step

-y

You can use Asymetrix 3D F/X to generate 32-bit snapshots in .TGA format. Snapshots in .TGA format contain 24
bits of color information, and 8 bits of transparency (alpha-channel) information.

To generate a 32-bit snapshot:

1 From the Scene menu, choose Generate Snapshot.

2 Under Style, select a Realistic or Ray Traced generating style.

3 Under Generate Image Of, select whether to generate the current scene, or create a snapshot from a frame of

animation. Use the Animation palette to go to the frame (its number appears in the Scene Preview window
status bar).

4 Under Destination, click Generate To File, then enter a file name with a .TGA extension.
5 Click OK to generate the snapshot.



Step by step
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Generating complex or large snapshots
Previewing a snapshot
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About Asymetrix 3D F/X
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In Asymetrix 3D F/X, you create and arrange 3D models in the Scene Preview window to build a scene. After
you've created a scene, you can generate a snapshot or animation from it to use alone or incorporate into other
programs.

Asymetrix 3D F/X provides tools for creating scenes, including

the Scene Preview window, which gives you the best idea of what your generated snapshot or
animgtion will look like. You arrange, edit, and manipulate models in the Scene Preview window.

"

the Scene Contents window, which lists all scene attributes such as the backdrop, lights, and
soundtrack; and all models and their attributes such as surfaces, warps, and animation paths. (To view details of an
element's attributes in the Scene Contents window, double-click it.)

"

the Catalog window, which contains predefined scene elements you can drag and drop into the
Scene Preview or Scene Contents window.

the Position palette, which contains tools that rotate, move, and scale models in the Scene Preview

the Animation palette, which contains tools that play animations in the Scene Preview window.
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About animation in Asymetrix 3D F/X

Concepts

You create animation in Asymetrix 3D F/X by applying animation paths to models, then generating an animation.
Animation paths are a set of instructions that tell a model how to move, whether to spin, and if the motion starts or
ends outside the scene. One animation path of a model must completely finish before another can start; however,
multiple models can be animated at the same time. The duration of the animation generated from a scene is
determined by the model in the scene with the longest sequence of animation paths.

Asymetrix 3D F/X generates an animation by generating a snapshot of a scene, adding the data to its .AVI file,
moving all the models in the scene one frame along their paths, and then repeating the process.




Step by step

Adding a soundtrack to an animation
Animating a model

Animating sub-parts of a model
Generating an animation

Modifying a model's animation path
Modifying a model's animation path sequence
Playing a linked or embedded animation
Previewing an animation

Printing a frame of an animation
Staggering when models enter a scene
Commands
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About color in Asymetrix 3D F/X

Concepts

"

You can create images in Asymetrix 3D F/X in these color resolutions:

1-bit (black and white)
4-bit (16 colors)
8-bit (256 colors)

16-bit (65,536 colors)

24-bit (16.7 million colors)

Color resolution is determined by the number of bits that define each pixel. The more bits per pixel, the higher the
resolution. Higher resolution means more colors can be included in the image, making the image more realistic,
but it also requires more memory to store.

If you plan to display a snapshot online, you should generate it using the same number of colors or resolution as
the target system on which you will display it. To set the snapshot's color palette, choose Snapshot & Animation
Settings from the Scene menu, click the Color tab, and then select a color palette that contains the same number
of colors or resolution as the target system.



Step by step

About Asymetrix 3D F/X
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Changing a snapshot's color depth or size
Generating a snapshot
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About color palette shift

Concepts

If you display one snapshot or animation onscreen and then immediately display another, you may notice that the
colors in the first image shift or distort onscreen. The distortion is called palette shift and may occur when you
display images on an 8-bit display device.

An 8-bit display device can show any color from a selection of more than 16 million, but it can show only 256 of
those colors at one time. It stores the 256 colors it's currently using in a color table, called a system or hardware
palette.

When you create a snapshot or animation, Asymetrix 3D F/X creates a color palette containing the snapshot's or
animation's colors. The color palette determines the color of each pixel.

If you display an image on an 8-bit display device, the system palette and the image's color palette have to
reconcile their colors. If the colors are similar, only slight changes are made. If the colors are different, the system
palette discards its current colors and uses the image's color palette.

Displaying a succession of snapshots or animations that use different color palettes causes palette shifts during
the color reconciliation process. The reason is simple: when the system palette replaces the first image's colors
with those of the second image, the first image no longer has the colors it needs to display properly.

To prevent palette shifts, create a common palette of 256 colors (using a program such as the Palette Editor
provided with Asymetrix 3D F/X) and apply it to all of the images you're using, including snapshots and animations.

Note Palette shift only occurs on 8-bit display devices. To avoid it, use a 16-bit or 24-bit display device driver.



Step by step

About Asymetrix 3D F/X

About color in Asymetrix 3D F/X
Changing a snapshot's color depth or size
Generating a snapshot
Commands

Convert Snapshot

Generate Snapshot

Snapshot & Animation Settings
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About object linking and embedding (OLE)

Concepts

"

Object linking and embedding (OLE) enables you to create an object in one application (the server application)
and incorporate it into a file from another (the container application). Asymetrix 3D F/X is a server application.

If you link a scene, the Asymetrix 3D F/X scene information is stored in a different place than if you embed it.
Whether you choose to link or embed your project depends on how you plan to use it. Asymetrix 3D F/X stores

embedded scenes in the container application's file, which maintains a link to Asymetrix 3D F/X.
Embed a scene when you want to use it in only one container application, and also want to be able to

B - i
Y
. —
D .
-

linked scenes in a separate Asymetrix 3D F/X file; the container application stores only a reference
to the linked scene location, the file name, and the server application name (Asymetrix 3D F/X). You can edit the
original scene in Asymetrix 3D F/X and automatically update all links to the scene in the container application.

Link a scene if you want to use it in a number of container applications.

If you plan to distribute a file that contains a linked or embedded animation, make sure you distribute the

container application's file.

generated animation file.

Asymetrix 3D F/X runtime player (3DFXPLAY.DLL), in case the recipient does not have Microsoft
Video for Windows or the Media Player.
Note If you import a generated shapshot or animation into another application, rather than embed or link it, the
snapshot or animation is stored in the application, without a connection to Asymetrix 3D F/X. The only way to
change an imported snapshot or animation is to modify the scene in Asymetrix 3D F/X, regenerate the snapshot or
animation, and then reimport it.



Step by step

About editing scenes in a container application
Displaying a scene or icon in a container application
Displaying a snapshot or animation in a container application
Editing embedded or linked Asymetrix 3D F/X scenes
Embedding a new scene

Embedding or linking an existing scene

Playing a linked or embedded animation

Updating your OLE registration database
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About editing scenes in a container application

Concepts

Asymetrix 3D F/X supports in-place editing, a technique that allows you to edit a scene in the container
application. If the container application also supports in-place editing, when you edit the linked or embedded
scene, the container application's menus and toolbars are replaced by the Asymetrix 3D F/X menus and toolbars.

If the container application does not support in-place editing, Asymetrix 3D F/X appears in its own window.

Note Using in-place editing, you cannot change the on-camera area, have multiple Snapshot windows open, or
hide the Asymetrix 3D F/X toolbar. In addition, the Asymetrix 3D F/X File and Window menus are not available.



Step by step

About object linking and embedding (OLE)
Displaying a scene or icon in a container application
Displaying a snapshot or animation in a container application
Editing embedded or linked Asymetrix 3D F/X scenes
Embedding a new scene

Embedding or linking an existing scene

Playing a linked or embedded animation

Updating your OLE registration database
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About creating 3D graphics with Asymetrix 3D F/X

Concepts

Three-dimensional (3D) graphics produce the illusion of depth. Programs, such as Asymetrix 3D F/X, that produce
3D graphics and animations, contain mathematical formulas for calculating perspective and the interplay of lights
and surfaces that contribute to the illusion.

Asymetrix 3D F/X creates 3D models by adding depth to flat shapes, such as text or outlines of graphics. The
surfaces of the models are composed of polygons, such as triangles and rectangles. After a model has been
created, you can cover its surfaces with colors or bitmaps to make it appear more realistic.

The Asymetrix 3D F/X work space is called a scene. Your "view" of the scene is called the camera perspective.
You can vary the camera perspective to change how the scene appears in the view.

Model's surfaces wouldn't be visible, or appear three-dimensional, without light sources to provide variation in
shading. Asymetrix 3D F/X provides default lighting for all scenes.

The amount of detail in a scene (such as lights, models, and transparent or reflective surfaces) affects how long it
will take to generate a snapshot or animation of it. Asymetrix 3D F/X offers several generating styles, which
determine how much of a scene's detail is included in a snapshot or animation.

Generating style Shows Does not show
Wireframe Model's geometry, Surfaces, shadows, applied or ray_
perspective traced reflections, environment

map, dithering, custom color
palettes, or fog

Solid Models Model's geometry, Shadows, applied or ray traced
perspective, surfaces with reflections, environment map,
rough color dithering, custom color palettes, or
approximations fog

Realistic Model's geometry, Shadows, ray traced reflections

perspective, surfaces,
dithering, custom color
palettes, fog, applied
reflections

Realistic w/Shadows Model's geometry, Ray traced reflections
perspective, surfaces,
dithering, custom color
palettes, fog, applied
reflections, shadows

Ray Traced Model's geometry, Shadows
perspective, surfaces,
dithering, custom color
palettes, fog, applied and
ray traced reflections

Ray Traced Model's geometry,

w/Shadows perspective, surfaces,
dithering, custom color
palettes, fog, applied and
ray traced reflections,
shadows
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About imported models

About simple models
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About camera perspective

Concepts

"

The space in an Asymetrix 3D F/X scene is almost infinite. The camera perspective you choose (your observation
point in the scene) determines how much of the space you see. The space is defined by X (width), Y (height), and
Z (depth) axes that meet in an origin. The width and height of the scene at the origin are always approximately
1000 units. You can view a scene using one of three camera perspectives:

Normal, which places the camera approximately 500 units in front of the origin, and includes 56
degrees of the scene.

"

Wide Angle, which places the camera approximately 250 units in front of the origin, and includes 90
degrees of the scene.

"

Telephoto, which places the camera approximately 1000 units in front of the origin, and includes 28
degrees of the scene.
You can move models anywhere within the scene space. However, Asymetrix 3D F/X cannot draw models if they
are placed closer than 385 units from the camera or farther than 100,000 units from the camera.



Step by step

About Asymetrix 3D F/X

About creating 3D graphics with Asymetrix 3D F/X
About the Position palette

Command

Camera Perspective
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About simple models

Concepts

A simple model is the geometry that results from an equation for a cube, ring, cylinder, or sphere. Asymetrix 3D
F/X calculates each equation using default values, then approximates the model's shape using a series of
triangles. Each time you modify a simple model using a dialog box, you are changing the values Asymetrix 3D F/X
uses to draw the model.

The more triangles that compose a simple model (controlled by fineness for spheres, and divisions for cubes,
cylinders, and rings), the smoother and more flexible the model becomes. Unfortunately, the more triangles, the
more memory (RAM) and time the calculations require. Experiment with the number of triangles to find a value that
gives you a good balance between detail and time to generate.



Step by step

About imported models
About text and picture models
Commands

Create Simple Model submenu
Modify Cube (dialog box)
Modify Cylinder (dialog box)
Modify Ring (dialog box)

Modify Sphere (dialog box)
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About text and picture models

Concepts

Asymetrix 3D F/X creates text and picture models by adding depth to two-dimensional shapes.

Asymetrix 3D F/X creates a text model by drawing an outline of the characters you enter, making a copy of the
outined characters to serve as the back face of the model, and then applying a side surface to connect the front
and back faces.

Asymetrix 3D F/X creates a picture model by first extracting shapes from a graphic file. For a bitmap, Asymetrix 3D
F/X converts the image to black and white, then traces around the black to create two-dimensional shapes. For a
graphic file drawn with polygons and lines (such as a metafile), Asymetrix 3D F/X uses the shape information in
the source file. A file containing multiple shapes results in a model with sub-parts. Asymetrix 3D F/X makes a copy
of the shapes in the file to serve as the back face of the model or its sub-parts, then applies a side surface to
connect the front and back faces.

Asymetrix 3D F/X can also add beveled edges to text and picture models.




Step by step

About imported models

About simple models
Creating a picture model
Creating a text model
Importing a model

Commands

Create Text Model

Create Picture Model

Modify 3D

Modify Letter Model (dialog box)
Modify Picture Model (dialog box)
Modify Text Model (dialog box)
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About imported models

Concepts

Imported models are 3D clip art models created in other programs, such as Autodesk 3D Studio (.3DS format) and
AutoCAD (.DXF format). Imported models have 3D geometry, and may include surface information. You can apply
new surfaces, move, scale, rotate, and warp imported models in Asymetrix 3D F/X. Imported models are
composed of sub-parts called meshes.




Step by step

About simple models

About text and picture models
Commands

Import Model

Imported Model Surface (dialog box)
Modify Imported Model (dialog box)
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About surfaces

Concepts

A model's surface is a thin layer, placed over the model's geometry. A surface can be a color, bitmap, or material.
You can also layer additional effects on a surface to change its appearance. Surface layers can include

a bump texture, which is a bitmap that defines a gray pattern. A bump texture can be placed over a
surface to make it appear textured.

"

a reflection map, which is a bitmap that defines a simulated reflection. A reflection map can be
placed over a model's reflective surface to make the surface appear to reflect the image in the reflection map, rather
than the scene.

"

an environment map, which is a bitmap that defines a simulated reflection. An environment map is
a reflection map that is applied to an entire scene. All models with reflective surfaces in the scene appear to reflect
the image in the environment map.

"



Step by step

Applying a surface to a model
Adding a texture to a model's surface
Making a surface reflect a bitmap
Making all models in a scene reflect a bitmap
Modifying a model's surface
Commands

Modify Surface & Color

Snapshot & Animation Settings
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About the Scene Contents window

Concepts

"

The Scene Contents window lists all scene attributes such as the backdrop, lights, and soundtrack; and all models
and their attributes such as surfaces, warps, and animation paths.

Double-clicking each icon in the Scene Contents window will display its elements. Double-clicking an icon's text
displays the element's Modify dialog box, if available.

You can also use the Scene Contents window to duplicate or copy some scene elements. You can

duplicate any model by dragging and dropping its icon onto the Scene icon.
duplicate any individual light by dragging and dropping its icon onto the Lights icon.

duplicate any path of a model by dragging and dropping its icon onto the model's Paths icon.

copy any surface, path, or warp from one model to another by dragging and dropping the surface,
path, or warp icon onto the second model's icon.
Note You can change the Scene Contents window font to any font installed on your system. Right-click the Scene
Contents window away from all scene elements, choose Select Font, select a font to use, and then click OK.

Represents

Double-click

Icon

The entire scene
and all its sub-parts

The scene's
backdrop

The soundtrack
that will be
included with the
scene when it is
generated as an
animation

The group of lights
included in the

The icon to collapse or expand the view of
the scene's elements, or double-click the

text to open the Snapshot & Animation
Settings dialog box.

To display the Modify Backdrop dialog box.

To select a file to use as a soundtrack in
the Modify Soundtrack dialog box.

The icon to view the individual lights in the
group, or double-click the text to modify the

scene lights.
A single light The text to modify the light.
A text model The icon to view the model's elements, or

A picture model

A simple model
based on a sphere

A simple model

double-click the text to display the Create
Text Model dialog box.

The icon to view the model's elements, or
double-click the text to display the Create
Picture Model dialog box.

The icon to view the model's elements, or
double-click the text to display the Modify
Sphere dialog box.

The icon to view the model's elements, or




based on a cube

A simple model
based on a cylinder

A simple model
based on aring

An imported model

The sub-parts of an
imported model

A sub-part of an
imported model

A surface of a
model

A sub-partof a
model

A model's group of
animation paths

A single animation
path

A model's warp

double-click the text to display the Modify
Cube dialog box.

The icon to view the model's elements, or
double-click the text to display the Modify
Cylinder dialog box.

The icon to view the model's elements, or
double-click the text to display the Modify
Ring dialog box.

The icon to view the model's elements, or
double-click the text to display the Modify
Imported Model dialog box.

The icon to view the model's elements.

The icon to view the model's elements, or
double-click the text to display the Modify
Imported Model dialog box.

The text to display the Modify Surface &
Color dialog box.

The icon to view the model's elements, or
double-click the text to modify the model.
The icon to view the individual paths in the
group, or double-click the text to display
the Modify Animation dialog box.

The text to display the Modify Animation
dialog box.

The text to display the Modify Warp dialog
box.
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Step by step

About Asymetrix 3D F/X

Creating and modifying a Catalog

Making a model a sub-part of another model
Selecting models

Command

Scene Contents
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About the Position palette
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The Asymetrix 3D F/X Position palette allows you to rotate, move or scale models in the Scene Preview window.
You can use the Position palette in one of three ways:

Click a tool on the Position palette to change the cursor, then use the mouse to rotate, move, or
scale a model.

Click the expand button

on the Position palette to display additional graphical control buttons, then click the buttons to rotate,
move, or scale a model.

Click the expand button

on the Position palette to display additional graphical control buttons; click the graphical/numerical toggle

to switch to numerical controls; and then enter numbers to precisely rotate, move, or scale a model.
Note If you choose to use the Position palette's numerical controls to rotate a model, you may notice that entering
a value greater than 90 degrees for rotation about the Y-axis rotates the model to the position you indicated, but
Asymetrix 3D F/X changes the X, Y, and Z values you see.

Due to mathematical constraints in the way Asymetrix 3D F/X calculates a model's orientation, rotation about the
Y-axis is never expressed as a rotation greater than 90 degrees, or less than -90 degrees. When you enter a value
greater than 90 for rotation about the Y-axis, Asymetrix 3D F/X expresses the orientation in terms of rotation about
the X and Z axes.

For example, when you rotate a model 180 degrees about its Y-axis, its orientation can also be expressed as
rotating 180 degrees about the X-axis, 0 degrees about the Y-axis, and 180 degrees about the Z-axis.



Step by step

About Asymetrix 3D F/X

About creating 3D graphics with Asymetrix 3D F/X
Commands

Camera Perspective

Position Palette
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Eight ball snapshot

7

Scene: EIGHT BALL
Generating setting:  Realistic w/Shadows

We started by creating a plane for the billiard table, then added a picture model for the table's rail. Finally, we
added a sphere model with a bitmap surface and reflection map for the billiard ball.

For related procedures, click See Also above.

Scene element details
B__ackdrop

"

Color: brown (Red 51, Green 34, Blue 19)

Shape: Size X = 300; Size Y = 300; Size Z=5

Surface: Color, Def. Green2; Highlight Size, 100% Small; Highlight Intensity, 100% Dull

Orientation: X Axis =40; Y Axis =0; ZAxis =0

Position: X Axis = 0; Y Axis = —-74; ZAxis =0

TITTE

Scale: X Scale = 153; Y Scale = 99; Z Scale = 99
P_i_cture model

"

Surface: Wood; Wood Color, dark brown (Red 125, Green 93, Blue 31); Grain Color, light brown
Red 25, Green 16, Blue 0); Highlight Size, 80% Large; Highlight Intensity, 80% Shiny

—

Orientation: X Axis = 30; Y Axis = 0; ZAxis =0

Position: X Axis = 0; Y Axis =—62; ZAxis =0

T

Scale: X Scale = 52; Y Scale = 35; Z Scale = 11
Sphere

"

Shape: Fineness = 5



Surface: Bitmap Pattern, 8.BMP; Highlight Size, 90% Small; Highlight Intensity, 95% Shiny;
Reflection Map: WDW.BMP

Orientation: X Axis = —10; Y Axis = 10; Z Axis = 90
Position: X Axis = 0; Y Axis = —66; Z Axis = —-28

Scale: X Scale = 128; Y Scale = 128; Z Scale = 128

Bo8 b



Step by step

Adding a preset model

Applying a surface to a model
Arranging a model in a scene
Building a scene

Creating a picture model
Generating a snapshot

Making a surface reflect a bitmap
Modifying a model's surface
Modifying a simple model's shape
Commands

Create Picture Model

Create Simple Model submenu
Generate Snapshot

Modify Cube (dialog box)

Modify Sphere (dialog box)
Modify Surface & Color

Position Palette
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{ewl ewl, ewBitmap, 8ball.bmp}
If you do not see an example snapshot, you do not have file 8BALL.BMP.



Patterned ring snapshot

Scene: PATTERN
Generating settings: Ray Traced
Number of ray traced reflections: 2
We started by creating a plane for the reflective floor, then added a ring model with a tiled bitmap pattern surface,
and tiled bump texture.
For related procedures, click See Also above.

Scene element details
Backdrop

"

Gradient: circular, center in upper left corner, Major Color: dark blue (Red 0, Green 0, Blue 51),
Minor Color: white
Lights

Left light: upper left corner

Right light: front right corner, close to model; Color, blue (Red 13, Green 22, Blue 51)

Shape: Size X = 300; Size Y = 300; Size Z=5

Surface: Color, Black; Highlight Size, 95% Large, Highlight Intensity, 99% Shiny, Unhighlighted
ace, 0% Light; Enable Optical Effects When Ray Tracing = On, Intensity, 100% Mirror
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Orientation: X Axis = 40; Y Axis =0; ZAxis =0

Position: X Axis = 0; Y Axis =—-168; ZAxis =0

Scale: X Scale = 157; Y Scale = 100; Z Scale = 73
Ring

Shape: Major Divisions, 24; Minor Divisions, 23

Surface: Bitmap pattern: CLRPAT.BMP, Tiled 3 times; Highlight Intensity, 100% Shiny,
Unhighlighted Surface, 97% Light, Bump Texture: BWPAT.BMP, Tiled 3 times



Orientation: X Axis = —40; Y Axis = 0; ZAxis =0

Position: X Axis = —1; Y Axis = 69; ZAxis =0

Scale: X Scale = 128; Y Scale = 128; Z Scale = 128



Step by step

Adding a preset model

Adding a texture to a model's surface
Applying a surface to a model
Arranging a model in a scene
Building a scene
Generating a snapshot

Making a surface reflective
Modifying a model's surface
Modifying a simple model's shape
Commands

Create Simple Model submenu
Generate Snapshot

Modify Ring (dialog box)

Modify Surface & Color

Position Palette

Snapshot & Animation Settings
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{ewl ewl, ewBitmap, ring.bmp}
If you do not see an example snapshot, you do not have file RING.BMP.



Helicopter with moving background animation

Scene: HELICOPTER
Generating setting:  Realistic w/Shadows

We started by creating a plane with a marble surface to use for the sky and clouds, then added a helicopter model
from the Catalog. Finally, we applied animation paths to both models to simulate movement.

For related procedures, click See Also above.

Scene element details
B__ackdrop

"

Default white
Plane

Shape: Size X = 500; Size Y =500; Size Z=5

Surface: Solid Material; Marble, Stone Color, white, Vein Color, light blue (Red 24, Green 202, Blue
29); Scale 25% to right; Vein Curliness fully to right; fully Transparent

N

Orientation: X Axis = 0; Y Axis =0; ZAxis =0

Position: X Axis = 266; Y Axis = —-263; Z Axis = 300

Scale: X Scale = 173; Y Scale = 145; Z Scale = 100

Path: 45 seconds, Leave Scene to center upper left; Spin Entire Model, 0.3 turns, Propeller
Irpported model (whole)

Model: MD 500H
Surface: Default surfaces
Orientation: X Axis = 1; Y Axis =0; ZAxis =0

Position: X Axis = 4; Y Axis = -51; ZAxis =0

Scale: X Scale = 883; Y Scale = 883; Z Scale = 883



Path 1: 4 second Enter Scene from lower center; Offscreen Orientation enabled, rotated 90
degrees toward back

Path 2: 0.1 second Don't Move
Path 3: 4 second Don't Move; Spin Entire Model, —0.5 turns; Spin Left/Right
Path 4: 0.1 second Don't Move

Path 5: 0.5 second Don't Move; Spin Entire Model, —0.03 turns; Propeller

SOBb B

Path 6: 6 second Leave Scene to upper left back
Imported model (parts)

Mesh: rhub

Path: 15 second Don't Move; Spin Entire Model, 15 turns, Spin Up/Down

Path: 15.02 second Don't Move; Spin Entire Model, 15 turns, Spin Left/Right

$58



Step by step

Adding a preset model

Animating a model

Applying a surface to a model
Arranging a model in a scene
Building a scene

Creating a text model

Generating an animation

Modifying a model's animation path
Modifying a model's animation path sequence
Modifying a simple model's shape
Commands

Create Simple Model submenu
Generate Animation

Modify Animation

Modify Cube (dialog box)

Modify Surface & Color
Position Palette



Switching text animation

7

Scene: SWITCHING TEXT
Generating setting:  Realistic w/Shadows

We created two text models, then added animation paths that made one model appear to replace the other
onscreen.

For related procedures, click See Also above.

Scene element details
B__ackdrop

"

Gradient: Gradient blue (from Catalog)
Text Model 1

Text: Why Limit Your (Font = Arial, Size = 34); Imagination (Font = Arial, Size = 37)

58

Face and Back Surfaces: Color, dark blue (Red 25, Green 0, Blue 127); Highlight Size, 85% Large,
Highlight Intensity, 85% Shiny

Side Surfaces: Color, black

Orientation: X Axis = 0; Y Axis =0; ZAxis =0
Position: X Axis = 0; Y Axis = 0; Z Axis = 15

Scale: X Scale = 200; Y Scale = 200; Z Scale = 200
Path 1: 1 second, Wait Offscreen

Path 2: 2 second, Enter Scene

Path 3: 2 second, Don't Move

Path 4: 2 second, Don't Move, Spin Entire Model, 0.25 turns, Spin Up/Down

Ty

Path 5: 0.1 second, Don't Move



Path 6: 0.2 second, Wait Offscreen lower right corner
Text Model 2

Text: Asymetrix (Font: Arial, Size 34); 3D F/X (Font: Arial, Size 64)

58

Face Surfaces: Color, dark blue (Red 25, Green 0, Blue 127); Highlight Size, 85% Large, Highlight
Intensity, 85% Shiny

Side and Back Surfaces: Color, black

Orientation: X Axis = 90; Y Axis = 0; ZAxis =0

Position: X Axis = 0; Y Axis = 0; Z Axis = 17

Scale: X Scale = 200; Y Scale = 200; Z Scale = 200

Path 1: 7 second, Wait Offscreen

Path 2: 0.1 second Enter Scene from top left back

Path 3: 2 second Don't Move, Spin Entire Model, 0.25 turns, Spin Up/Down

Path 4: 2 second, Don't Move

Ty

Path 5: 3 second Leave Scene; Spin Sub-parts Only, custom spin, 0.3 turns; Stagger In Random
Sequence applied to motion and spin, Stagger Factor 10%

"



Step by step

About animation in Asymetrix 3D F/X
Animating a model

Arranging a model in a scene

Building a scene

Creating a text model

Generating an animation

Modifying a model's animation path
Modifying a model's animation path sequence
Staggering when models enter a scene
Commands

Create Text Model

Position Palette

Modify Animation

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"



Water molecule animation

Scene WATER MODEL
Generating setting:  Realistic

We used three spheres and two cylinder simple models to create a water molecule, and a text model to label the
molecule. Then we made all the models sub-parts of a parent sphere. Finally, we added animation paths to the
parent model.

For related procedures, click See Also above.

Scene element details
Backdrop

"

Gradient: Summer rain gradient (from Catalog)
P_arent sphere

Shape: Fineness = 5

Surface: Color, Def. Green2

Orientation: X Axis = 0; Y Axis =0; ZAxis =0
Position: X Axis = 5; Y Axis = 96; Z Axis =0

Scale: X Scale = 79; Y Scale = 79; Z Scale = 79

Path: 3 second Enter Scene from top center, Spin Entire Model 1 time, custom spin
S_phere 1 (sub-part of parent sphere)

Shape: Fineness = 5
Surface: Color, Def. Blue3
Orientation: X Axis = 0; Y Axis =0; ZAxis =0

Position: X Axis = 157; Y Axis =—98; ZAxis =0

Scale: X Scale = 100; Y Scale = 100; Z Scale = 100
Sphere 2 (sub-part of parent sphere)



Shape: Fineness =5

Surface: Color, Def. Blue3

Orientation: X Axis = 0; Y Axis =0; ZAxis =0

Position: X Axis = -175; Y Axis =—97; ZAxis =0

Scale: X Scale = 100; Y Scale = 100; Z Scale = 100
Cylinder 1 (sub-part of parent sphere)

Shape: Upper Radius = 10; Lower Radius = 10; Height = 300

Surface: Color, Def. Red3; Highlight Size, 85% Large, Highlight Intensity, 85% Shiny

Orientation: X Axis = 0; Y Axis = 0; Z Axis =45

Position: X Axis = 84; Y Axis =-8; ZAxis =0

SOB6 B

Scale: X Scale = 126; Y Scale = 126; Z Scale = 126
Cylinder 2 (sub-part of parent sphere)

Shape: Upper Radius = 10; Lower Radius = 10; Height = 300

Surface: Color, Def. Red3; Highlight Size, 90% Large, Highlight Intensity, 80% Shiny

Orientation: X Axis = 0; Y Axis = 0; Z Axis = —45

Position: X Axis = —89; Y Axis =-8; ZAxis =0

SOB6 B

Scale: X Scale = 126; Y Scale = 126; Z Scale = 126
Text (sub-part of parent sphere)

Text: H20

b

Faces and Backs Surface: Color, Def. Blue4; Highlight Size, 90% Large, Highlight Intensity, 90%
Shiny

b

Sides Surface: Color, Def. Red3; Highlight Size, 90% Large, Highlight Intensity, 90% Shiny



Orientation: X Axis = 0; Y Axis =0; ZAxis =0

Position: X Axis = —=10; Y Axis = -116; ZAxis =5

Scale: X Scale = 227; Y Scale = 227; Z Scale = 227



Step by step

About animation in Asymetrix 3D F/X
Adding a preset model

Animating a model

Arranging a model in a scene
Creating a text model

Generating an animation

Making a model a sub-part of another model
Modifying a model's animation path
Modifying a model's surface
Modifying a simple model's shape
Commands

Create Simple Model submenu
Create Text Model

Modify Animation

Modify Cylinder (dialog box)
Modify Sphere (dialog box)

Modify Surface & Color

Position Palette

Asymetrix 3D F/X User Manual
Chapter 1, "The basics"






